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Chapter 1. Working with Infoprint transform programs

Infoprint provides transform programs for the following data streams:
* Printer control language (PCL) data stream

* PostScript data stream

* Portable document format (PDF) data stream

+ Tag image file form (TIFF) data stream

¢ Joint photographic experts group (JPEG) data stream
* Graphic interchange format (GIF) data stream

e ditroff data stream

¢ Double-byte ASCII and EUC data streams

* line-data data stream

e SAP data

The transforms convert the incoming data stream into the Advanced Function
Presentation (AFP) format.

When a job in any of these formats is submitted to print on a PSF physical printer,
Infoprint automatically invokes the appropriate transform. You can also run the
transforms from the AIX command line without printing the generated output. You
may find this useful if you intend to print the job later. Jobs print more quickly if
they have already been transformed.

Most transforms have flags or option keywords that you can use to specify
processing information. For a list of the flags or options and values for each
transform, refer to Infoprint Manager: Reference or to the transforms’ man pages.
Configuration files, environment variables, and user-exit programs allow you to
specify processing information for Infoprint to use when it invokes the transform
automatically. You can also use configuration files and environment variables
instead of typing flags on the command line whenever you run a transform.

Customizing the PCL, PostScript, and PDF transforms

You can customize the transforms for PCL, PostScript, and PDF data by specifying
values in the transform configuration files. shows the default configuration
files that Infoprint provides. You can either modify these files or create your own.

Table 1. Default PCL, Postscript, and PDF transform configuration files

Data Stream | Transform Configuration File Daemon Configuration File
PCL pcl2afp Ipsflpcl2afp/pcl2afp.cfg Ipsflpcl2afp/pcl2afpd.cfg
PostScript ps2afp Ipsflps2afp/ps2afp.cfg Ipsf/ps2afp/ps2afpd.cfg
PDF pdf2afp Ipsflps2afp/ps2afp.cfg Ipsflps2afp/ps2afpd.cfg

Notice that the PostScript and PDF transforms use the same default configuration
files.

© Copyright IBM Corp. 1998, 2002 3
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Sample configuration file

shows an example of a configuration file for the PostScript and PDF
transforms. The configuration file for the PCL transform is similar.

# ps2afp configuration file

# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
#H##########HHH A HH A A A H A A A A A A A A A A A

port = 8251 # -P which TCP/IP port to use
server = 127.0.0.1 # -S which server to connect with
ps_max_memory = 14000K # -M maximum amount of memory that

# PostScript uses; the 'K' is ignored
ps_job_timeout = 20 # -j maximum number of minutes

# to process PostScript job
ps_server_timeout = 20 # -s maximum number of minutes

# server waits between jobs
ps_width = 8.5i # -w width of generated image
ps_length = 11i # -1 length of generated image
ps_x_offset = 0i # -X left and right margins
ps_y_offset = 01 # -y top and bottom margins
ps_resolution = 600 # -r resolution of printer
ps_output_type = I01_G4 # -a type of AFP image to generate

Figure 1. Sample PostScript or PDF configuration file

The configuration file uses keyword equivalents of the transform flags. Refer to
Infoprint Manager: Reference for the keywords and values that you can specify in the
configuration file.

Daemon configuration files

The PCL, PostScript, and PDF transforms all require a daemon to be running
before you can use them. The pcl2afpd daemon manages the PCL interpreter
portion of the pcl2afp transform. The ps2afpd daemon manages the PostScript
interpreter portion of the ps2afp and pdf2afp transforms. For more information
about these daemons, refer to Infoprint Manager: Reference.

Each daemon, like the corresponding transform, uses a configuration file. The
daemon configuration file can contain the same keywords as the transform
configuration file, except server, plus some keywords that control the operation of
the daemon. Refer to Infoprint Manager: Reference for the daemon keywords.

Infoprint Manager for AIX: Procedures



Hierarchy of transform options

Infoprint assigns a hierarchy to its use of flags and configuration-file information
when it runs the PCL, PostScript, or PDF transform program. The following lists

the order in which Infoprint uses flags and information specified in configuration
files:

1. Any values you specify on the command line, including values in the
configuration file you specify with the -C flag.

Infoprint commands process flags from left to right. If you enter the same flag
more than once, Infoprint uses the last occurrence of the flag to determine the
value to use. For example, if you specify the following command:

ps2afp -Cconfig.file -r240 -r300 myfile.ps

The ps2afp command transforms the file using 300-pel resolution. Infoprint
ignores the resolution value specified in the configuration file config.file and
the first -r240 flag and value.

2. Values specified in thepcl2afp.cfg orps2afp.cfg configuration file in the current
directory, if one exists and if you issue the transform command directly.
Infoprint ignores values in the current directory if you invoke the transform
command indirectly by submitting a job to print.

3. Values specified in thepcl2afp.cfg or ps2afp.cfg configuration file in your home
directory, if one exists.

4. Values specified in the default transform command configuration file named in
[Table 1 on page 3

5. Values specified in a customized configuration file identified with the -C flag of
thepcl2afpd orps2afpd command when the transform daemon started.

6. Values specified in the default transform daemon configuration file named in
[Table 1 on page 3]

7. Default values that are built into Infoprint. These are the same as the transform
defaults except that the default PostScript or PDF output type is an IM1
uncompressed image.

Customizing the TIFF, JPEG, and GIF transforms
You can customize the transforms for TIFE, JPEG, and GIF data by:

* Specifying values in the transform configuration files

* Setting the transform environment variables

shows the default configuration files that Infoprint provides. You can either
modify these files or create your own.

Table 2. Default TIFF, JPEG, and GIF transform configuration files

Data Stream Transform Configuration Files

TIFF tiff2afp lust/lpp/psfltiff2afp/tiff2afp.cfg
lust/lpp/pstitiff2afp/tiff2afp.3160cfg
lust/lpp/pstitiff2afp/tiff2afp.3900cfg

JPEG jpeg2afp lust/lpp/psfljpegafp/jpegafp.cfg
lusr/lpp/pstljpeg2afp/jpeg2afp.3160cfg
lusr/lpp/pstljpegafp/jpeg2afp.3900cfg

GIF gif2afp lusr/lpp/psf/gif2afp/gif2afp.cfg
lust/lpp/pst/gif2afp/gif2afp.3160cfg
lusr/lpp/pst/gif2afp/gif2afp.3900cfg

Chapter 1. Working with Infoprint transform programs 5
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Infoprint uses the .3160cfg and .3900cfg configuration files to transform documents
that have been submitted to print on an IBM Infoprint 60 printer or IBM Infoprint
4000 laser printer respectively.

Sample configuration file

shows an example of a configuration file for the TIFF transform. The
configuration files for the JPEG and GIF transforms are similar.

a=iocal0
choice=full
cmp=g4
ms=5120
msf=0.01
nosniff=yes
noterm=yes
v=yes
pagetype=page
r=600

x=0

y=0

Figure 2. Sample TIFF configuration file

The configuration file uses options in the same format as the transform options
that you specify on the command line, except that command line options begin
with a dash (-). Refer to Infoprint Manager: Reference for the options and values that
you can specify in the configuration file.

Transform environment variables

Many of the TIFF, JPEG, and GIF transform options have equivalent environment
variables. Environment variables have the following format:

transform_option

wheretransform is the name of the transform command in upper case and option is
the command line option without the initial dash (-). For example, the
environment variable that corresponds to the —scale option of the jpeg2afp
transform is JPEG2AFP_scale. Refer to Infoprint Manager: Reference for the options
and values that you can specify as environment variables.

Hierarchy of transform options

Infoprint assigns a hierarchy to its use of options and configuration-file
information when it runs the TIFF, JPEG, or GIF transform program. The following
lists the order in which Infoprint uses command-line options and information
specified in configuration files:

1. Any values you specify on the command line, including values in the
configuration files you specify with the -C option.

Infoprint commands process options from left to right. If you enter the same
option more than once, Infoprint uses the last occurrence of the flag to
determine the value to use. For example, if you specify the following
command:

tiff2afp -Cconfig.file -r240 -r300 myfile.tif

Infoprint Manager for AIX: Procedures
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the tiff2afp command transforms the file using 300-pel resolution. Infoprint
ignores the resolution value specified in the configuration file config.file and
the first -r240 flag and value.

Values specified in the default transform command configuration file named in
[Table 2 on page 5|

Transform environment variables that you set with the export command, if you
issue the transform command directly. Infoprint ignores these environment
variables if you invoke the transform command indirectly by submitting a job
to print.

Transform environment variables in the .profile file in your home directory.
Transform environment variables in the /etc/environment file.

Default values that are built into Infoprint. These are the same as the transform
defaults.

Working with the transform for line data

Infoprint Manager includes a line-data transform program that transforms line data
into the Advanced Function Presentation (AFP) data stream. Converting the line
data allows you to print it on high-speed AFP printer devices.

About line data

Read through the following topics to become familiar with line-data terms.

Note: The line2afp command and its keywords are a subset of the AFP

Conversion and Indexing Facility (ACIF) acif command. Throughout this
chapter references are made to ACIF because the line2afp command is
linked to the acif command. When you use this transform and if errors
occur, you may receive some error messages that make reference to ACIE.

What Is line data?

Line data is simply unformatted data — that is, data with few or no embedded

control characters to create font changes, page breaks, and so on. The line data is

typically created by an application program. For example, an application might

produce a bank statement that has line data indicating an account’s daily balance.

The Infoprint line-data transform lets you format the following kinds of data with

a page definition and form definition for printing on Infoprint-managed printer

devices:

S/370 line-mode data. This type of line data was originally designed for a 1403
printer, is typically generated on a S/370 host processor, and is usually EBCDIC
characters with embedded control characters (carriage control, table reference

characters, and so on). This type of line data can have double-byte code points
and Shift In/Shift Out controls.

Mixed-mode data is S/370 line-mode data embedded with certain AFP
structured fields (for example, Include Page Segment).

Single-byte ASCII data with no embedded control characters except for newlines.

Single-byte ASCII data that contains ANSI carriage-control characters,
table-reference characters, or both.

Single-byte ASCII data that contains carriage returns and form feed controls if
you specify the asciinp or asciinpe user-exit program.

When you transform the line-data job, you must specify a page definition and a
form definition.
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Notes:

1. You cannot use the line-data transform when printing files containing
Proprinter ASCIL

2. When the line2afp command processes any unrecognized or unsupported
keyword, line2afp issues a message, ignores the keyword, and continues
processing any remaining keywords. The line2afp command then stops
processing.

3. Infoprint also lets you transform and print DBCS ASCII data without a page
definition. See Infoprint Manager: Reference or the db2afp man page.

ANSI and machine carriage controls

In many environments (including IBM mainframes and most minicomputers),
printable data normally contains a carriage control character. The carriage control
character acts as a vertical tab command to position the paper at the start of a new
page, at a specified line on the page, or to control skipping to the next line. The
characters can be one of two types: ANSI carriage control or machine carriage
control.

ANSI carriage control characters: The most universal carriage control is ANSI,
which consists of a single character that is a prefix for the print line. The standard
ANSI characters are:

ANSI Action
space Single space the line and print

0 Double space the line and print

- Triple space the line and print

+ Do not space the line and print

1 Skip to channel 1 (the top of the form, by convention)

2-9 Skip to a hardware-defined position on the page
A,B,C Defined by a vertical tab record or forms control buffer (FCB)

Note that all ANSI control characters perform the required spacing before the line
prints. Using line2afp command keywords and values, ANSI controls may be
encoded in EBCDIC (cctype=a) or in ASCII (cctype=z).

Machine carriage control characters: Machine carriage controls were originally
the actual hardware control commands for IBM printers and are often used on
non-IBM systems. Machine controls are literal values, not symbols. They are not
represented as characters in any encoding, and therefore, machine controls cannot
be translated. Typical machine controls are:

Machine
Action
X'09'  Print the line and single space
X'11'"  Print the line and double space
X'19'  Print the line and triple space
X'01'  Print the line (do not space)
X'0B' Space one line immediately (do not print)
X'89'  Print the line, then skip to channel 1 (top of form, by convention)
X'8B' Skip to channel 1 immediately (do not print)

Note that machine controls print before performing any required spacing. There
are many more machine control commands than ANSI. Carriage controls may be
present in a file or not, but every record in the file must contain a carriage control
if the controls are to be used. If the file contains carriage controls, but the line2afp
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command keyword and value cc=no is specified, the carriage controls are treated
as printing characters. If no carriage controls are specified, the file prints as though
it were single spaced.

Variable-length and fixed-length files
The line-data transform program needs to know two things about a file in order to
transform it:

* The length of each print record
* The kind of carriage control used

Some files contain information in each record that describes the record length;
these are called variable-length files. Other files require an external definition of
length; these are called fixed-length files.

For variable- and fixed-length files using length prefixes, MO:DCA-P structured
fields are treated as a special case. All such structured fields are self-identifying
and contain their own length. They need not contain a length prefix to be correctly
interpreted and are processed correctly if there is a length prefix.

Variable-length files: Variable-length files may use a length prefix, which means
they contain a prefix that identifies the length of the record in the file. Each record
contains a field that gives the length of the record. If the record contains a length,
that length must be a prefix for each record and it must be a 16-bit binary number
that includes the length of the 2-byte length prefix. Use the fileformat=record
keyword and value to identify files with length prefixes.

Variable-length files may use a separator or delimiter to indicate the end of a
record, instead of using a length prefix. All of the bytes up to, but not including,
the delimiter are considered part of the record. For AIX, the delimiter is X'0A". If
the file uses EBCDIC encoding, the newline character is X'25'. Use the
fileformat=stream keyword and value to designate files that use newlines to
indicate record boundaries.

Infoprint reads the first six bytes and tests for all ASCII characters (code points
from X'00' to X'7F'") to determine if a file is encoded in ASCII or EBCDIC. If no
non-ASCII characters are found, line-data transform program assumes the file uses
the ASCII newline character, X'0A'. Otherwise, the transform assumes the file uses
the EBCDIC newline character, X'25'. Because an input file can misguide the
line-data transform, a set of rules has been established to determine how the
transform processes the file. The following combinations are possible:

Data Type Newline Character
All EBCDIC EBCDIC X"25'

All EBCDIC ASCII X'0A" (Note)
All ASCII EBCDIC X"25' (Note)
All ASCII ASCII X'0A'

Note: These combinations are possible only if a file contains a prefix with a string
that indicates a different code set than actually exists.

* For EBCDIC data with ASCII newlines, use X'0320202020200A".
e For ASCII data with EBCDIC newlines, use X'03404040404025'.

Fixed-length files: Fixed-length files contain records that are all the same length.
No other separators, prefixes, or self-identifying information exists that indicates
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the record length. You must know the record length and use the
fileformat=record,nnn keyword and value, where nnn represents the length of each
record.

How the imageout keyword affects processing

The line-data transform converts image formats (IM1) in the input file, in overlays,
and in page segments to uncompressed IOCA format, if line2afp imageout=ioca
keyword and value is specified (the default). An uncompressed IOCA image may
use a significantly higher number of bytes than an IM1 image and may take more
processing time to convert, especially for shaded or patterned areas. Although
IOCA is the MO:DCA-P standard for image data, and some data stream receivers
may require it, all products may not accept IOCA data. All software products from
the IBM Printing Systems Company do, however, accept IOCA data as well as IM1
image data.

IBM recommends that you specify imageout=asis, unless you have a specific
requirement for IOCA images.

Customizing the line data transform

Infoprint provides several sample programming exits to assist you in customizing
the line-data transform. Use of the programming exits is optional. You specify the
names of the exit programs with the inpexit, outexit, and resexit keywords. Each
of these keywords is described in Infoprint Manager: Reference or the line2afp man

page.

Infoprint provides the following sample exits:
lust/lpp/psf/acif/apkinp.c

Input record exit
lust/lpp/psf/acif/apkout.c

Output record exit
lusr/lpp/psf/acif/apkres.c

Resource exit

In addition, Infoprint provides the following user input record exits to translate
line-data data streams:

lust/lpp/psf/acif/apka2e.c
Converts the ASCII stream data into the EBCDIC stream data.

lusr/lpp/psf/acif/asciinp.c
Converts unformatted ASCII data that contains carriage returns and form feeds
into a record format that contains ANSI carriage control characters. This exit
encodes the ANSI carriage control character in byte 0 of every record.

lusr/lpp/psf/acif/asciinpe.c
Converts unformatted ASCII data into a record format as does asciinp.c and
then converts the ASCII stream data into EBCDIC stream data.

The C language header file for all line-data transform exit programs is also
provided:
lust/lpp/psf/acif/apkexits.h

along with the build rules for the line-data transform user exits:
lusr/lpp/pst/acif/Makefile

10  Infoprint Manager for AIX: Procedures



Using the PDF Parallel RIP

With service release PTF U474310, Infoprint Manager for AIX Version 3 Release 2
provides the PDF Parallel RIP to improve the speed of PDF transforms for
mostcolor jobs. It divides a PDF input file into separate pages and distributes these
pages to several RIPs running in parallel. Then, it combines the resulting AFP data
stream into a printable document. If you define two RIPs on the same Infoprint
AIX server for a PDF input file with pages of a uniform complexity, the Parallel
PDF RIP client can render this file into AFP in half the time of the standard PDF
transform. While the greatest performance improvements occur for jobs printing on
the Infoprint Color 130 Plus printer, you can use the Parallel PDF RIP client on any
printers that produce AFP data.

Installing the PDF Parallel RIP client

The Parallel PDF RIP client (pdfprs) is installed with service release PTF U474310
and replaces the standard pdf2afp client on your system.

The pdfprs component consists of the following:
¢ the pdfprs executable in the /ust/lpp/psf/bin directory
e the pdf2afp configuration file in the /ust/lpp/psf/ps2afp directory.

The Parallel PDF RIP client is best used on an AIX server or servers, which may
have from four to 16 processors. IBM recommends you set up a configuration to
allow for system memory use like that displayed in

Table 3. Processors required to use the Parallel PDF RIP client

Processors Allocated Function Performed

1 network traffic, I/O processes, and general system
overhead.

1 pdfprs client as defined in [‘Sample configuration file foy
[the pdfprs client” on page 13

1 This first RIP transforms PDF into PostScript data.

Note that this must be a color RIP, even if you are using
the client to transform black-and-white jobs on an
Infoprint 4000 printer.

Each RIP is likely to use an entire processor to RIP the
PDF files.

lton For each additional daemon RIP as defined inl“RIH
[Daemon configuration files” on page 14

Note that the most basic configuration (the pdfprs client and two additional RIPs)
requires a minimum of four processors. Please ensure that your configuration can
support this feature before installing it and submitting jobs through the Infoprint

Manager pdpr print command.

You must create the first RIP to transform PDF input data to PostScript data, then
use at least a two-RIP configuration on your Infoprint AIX server to transform the
PDF into AFP data. To demonstrate how this support can be expanded by adding
RIPs, this example creates a three-RIP configuration, with the first RIP
transforming PDF input data into PostScript data. Note that these RIPs still use the
PostScript daemon (ps2afpd), just like the standard PDF transform.
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From an AIX window, complete the following procedure:

1. Create a directory for the PDF Parallel RIP client to distinguish it from the
standard PDF data stream transform:

mkdir /var/psf/pdf2afp;chmod 777 /var/psf/pdf2afp
2. Create working directories for each of the new PDF RIPS:
mkdir /var/psf/pdf2afp/1;chmod 777 /var/psf/pdf2afp/1
mkdir /var/psf/pdf2afp/2;chmod 777 /var/psf/pdf2afp/2
mkdir /var/psf/pdf2afp/3;chmod 777 /var/psf/pdf2afp/3
mkdir /var/psf/pdf2afp/4;chmod 777 /var/psf/pdf2afp/4
3. Install new configuration files for each of these RIPS:
* [var/psf/pdf2afp/8261.cfg
e [var/pst/pdf2afp/8262.cfg
* [var/pst/pdf2afp/8263.cfg
* [var/psf/pdf2afp/8264.cfg

Note that for each new configuration file, you must change the port,
work_directory, and log_file values. These three parameters are highlighted in
[Figure 4 on page 15| so you can see the directory structure recommended for
this configuration.

4. From either the command line or the ps2afpd.cfg file, start daemons for each
configuration file:

ps2afpd -C /var/psf/pdf2afp/8261.cfg
ps2afpd -C /var/psf/pdf2afp/8262.cfg
ps2afpd -C /var/psf/pdf2afp/8263.cfg
ps2afpd -C /var/psf/pdf2afp/8264.cfg

Note:
In the path where the working directories reside, you can create a startcfg
script similar to the following to perform this task:
#1/bin/sh
cd /var/psf/ps2afp
if [$# -gt 0 ]
then
for i in $*
do
[usr/1pp/psf/bin/ps2afpd -C 826%i.cfg
done
else
for i in1234
do
Jusr/1pp/psf/bin/ps2afpd -C 826%i.cfg
done
i
5. To ensure that the pdfprs command is linked to the pdf2afp command, you
must enter the following commands:

a. Access the correct directory by specifying: cd /usr/1pp/psf/bin

b. Create the necessary logical link to submit jobs to the PDF parallel RIP by
specifying: 1n -sf pdfprs pdf2afp

Note: If you need to restore the old pdf2afp client, you can specify the
following from an AIX command line: Tn -sf ps2afp pdf2afp.

This configuration will automatically invoke four RIPs and generally run faster
than the standard PDF transform.
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Customizing the PDF Parallel transform

You can customize the transforms for PDF data by specifying values in the
transform configuration files. shows the default configuration files that
Infoprint provides. You can either modify these files or create your own.

Table 4. Default parallel PDF transform configuration files

Data
Stream Transform | Configuration File Daemon Configuration Files
PDF pdf2afp lusr/lpp/psflps2afp/pdf2afp.cfg Ivar/psf/pdf2afp/8261.cfg

The pdfprs configuration file. Ivar/psf/pdf2afp/8262.cfg
Ivar/psf/pdf2afp/8263.cfg
Ivar/psf/pdf2afp/8264.cfg

Note: This represents the
3-RIP configuration of our
example, with the first RIP
serving as the PDF to
PostScript RIP.

mpl nfiguration file for the pdfprs client
igure 3 on page 14 shows an example of a configuration file for the PDF parallel

transform client. Note the three parameters that have been highlighted to show
values you want to specify exactly as shown to enhance the performance of the
parallel PDF RIP.
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# pdf2afp.cfg configuration file

# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
ifgdddgaddsadddgadddaaddadddadgdaaddaaddgaddadsdpaddsaagdaadatadad

width = 8.5i # -w width of generated image
length = 11i # -1 length of generated image
x_offset = 0i # -x left and right margins
y_offset = 0i # -y top and bottom margins
resolution = 600 # -r resolution of printer
output_type = FS45 # type of AFP image to generate
job_timeout = 120 # maximum number of minutes to process a job
numInputBuffers=48 # set input buffers to improve performance
numOutputBuffers=66 # set output buffers to improve performance
pragma=outputThread=yes +# specify for FS45 (color) RIP
number_of_rips = 3 # number of rips to use for processing
[pdf] # location of PDF -> PS conversion rip
port = 8261
server = serverl
[rip1] # Tocation of this rip
port = 8262
server = serverl
[rip2] # location of this rip
port = 8263
server = serverl
[rip3] # Tocation of this rip
port = 8264

server = serverl

Figure 3. Sample PDF parallel transform (pdf2afp.cfg) configuration file

This sample configuration file uses keyword equivalents of the transform flags.
Refer to Infoprint Manager: Reference for the keywords and values that you can
specify in the configuration file.

Note: For this sample pdf2afp.cfg configuration to work correctly, you must have
a configuration with a minimum of four processors dedicated to this task.

RIP Daemon configuration files

The PDF parallel transform requires that at least three daemons be running to
manage the PostScript interpreter portion of the pdf2afp transform. To simplify
your configuration, IBM recommends naming these daemons after the ports that
they are running on. For this document, the configuration example begun in
will use the names 8261.cfg, 8262.cfg, 8263.cfg, and 8264.cfg. For more
information about this daemon, refer to Infoprint Manager: Reference.

The daemon, like the corresponding transform, uses configuration files. The
daemon configuration files reside in the /var/psf/ directory. It is recommended that
you create a /pdf2afp subdirectory where all support related to the Parallel PDF
RIP client (pdfprs) can reside.
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shows an example of a configuration file for the PDF parallel transform
client that RIPs a color (FS45) file.

# 8264.cfg configuration file

# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
#H##AH R A AR R R R R R R A SRR F AR AR F AR AF R S R S A

port = 8264 # which TCP/IP port to use
work_directory = /var/psf/pdf2afp/4
directory to put work files in
log_files = /var/psf/pdf2afp/4/ps2afpd.log
where to write log messages

notify = root # notify if problems are encountered
mail_command = /usr/bin/mail
# program used to send notifications

ps_program = /usr/1pp/psf/bin/ps2afpi

# name of the PostScript interpreter program
ps_init_file = /usr/1pp/psf/bin/ps2afpe.ps

# name of the PostScript interpreter

# initialization file
ps_files path = /usr/1pp/psf/ps2afp :\
Jusr/1pp/psf/config :
Jusr/1pp/psf
# path to searhc for jobInit files

ps_max_memory = 32000K  # maximum amount of memory that

# PostScript uses; the 'K' is ignored

ps_job_timeout = 9999 # maximum number of minutes

# to process PostScript job

# maximum number of minutes

server waits between jobs
ps_font_map_files = /usr/1pp/psf/ps/psfonts.map :\

/var/psf/psfonts/user.map

# list of font mapping files

width of generated image

length of generated image

left and right margins

top and bottom margins

resolution of target printer

type of output to generate

ps_server_timeout = 180

H=

ps_width = 8.5i
ps_length = 11i
ps_x_offset = 0i
ps_y offset = 01
ps_resolution = 600

#
#
#
#
#
ps_output_type = FS45 #

pragma = resources=none 3\
printerSpeed=130 3\
TinkBandWidth=6000000 ;\
resourceNameFilename=../.resNames;

Figure 4. Sample PDF parallel transform (8264.cfg) configuration file for color

If you are defining and configuring daemon RIPs across several AIX servers, you
must define the resources in the daemon RIP configuration file as shown in the
highlighted section of This step ensures that NFS can find all the
resources and concatenate the result into a single file. You only need to specify the
resourceNameFilename= value on the pragma parameter this way if you are using
inline resources and the FS45 IOCA color format.

These daemon configuration files can contain many of the same keywords as the
transform configuration file, except server, plus some keywords that control the
operation of the daemon. Refer to Infoprint Manager: Reference or man pages for the
daemon keywords.
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# 8264.cfg configuration file

# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
ifgdddgaddsadddgadddaaddadddadgdaaddaaddgaddadsdpaddsaagdaadatadad

port = 8264 # which TCP/IP port to use
work_directory = /var/psf/pdf2afp/4
directory to put work files in
log_files = /var/psf/pdf2afp/4/ps2afpd.log
where to write log messages
notify = root # notify if problems are encountered
mail_command = /usr/bin/mail
# program used to send notifications
ps_program = /usr/1pp/psf/bin/ps2afpi
# name of the PostScript interpreter program
ps_init_file = /usr/1pp/psf/bin/ps2afpe.ps
# name of the PostScript interpreter

# initialization file
ps_files_path = /usr/1pp/psf/ps2afp :\
Jusr/1pp/psf/config :
Jusr/1pp/psf
# path to searhc for jobInit files

ps_max_memory = 32000K  # maximum amount of memory that
# PostScript uses; the 'K' is ignored
ps_job_timeout = 9999 # maximum number of minutes
# to process PostScript job
# maximum number of minutes
# server waits between jobs
ps_font map files = /usr/1pp/psf/ps/psfonts.map :\
/var/psf/psfonts/user.map
# list of font mapping files

ps_server_timeout = 180

ps_resolution = 600
ps_output_type = I101_G4

resolution of target printer
type of output to generate

ps_width = 8.5i # width of generated image
ps_length = 11i # length of generated image
ps_x_offset = 0i # left and right margins
ps_y_offset = 0i # top and bottom margins
= #
#

Figure 5. Sample PDF parallel transform (8264.cfg) configuration file for black and white

Configuring for a dual engine halftone printer

If you have either an Infoprint 4000 Advanced Function Duplex Printing System —
Models ID5/1ID6 or an Infoprint 4000 High Resolution Duplex Printing System,
you can use the pdfprs client to drive a dual-engine configuration with customized
halftone support for each engine. Note that while the pdfprs client can RIP both
the color and the black-and-white (monochrome) PDF files, these printers only
print black-and-white output. In addition, these printers do not provide as
extensive a performance benefit as that you will see when printing color PDF files.
Note that if you do print color PDF files and then would want to switch to
black-and-white PDF files, you must stop the RIPs and change the configuration
files.

For this support, you must configure and start an even number of RIPs. The first
RIP must be customized to use the first print engine’s halftone configuration, and
the second RIP must be customized to use the second print engine’s halftone
configuration. This pattern must be repeated for each RIP that is configured.
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In addition, each RIP must be configured to use the desired halftone configuration
at the daemon configuration level. For example, if you are using two Infoprint
4000 printers, all the even-numbered RIPs should match the halftone configuration
specified on printerl, while all the odd-numbered pages should match the halftone
configuration specified on printer2.|Figure 5 on page 16 provides an example of a
monochrome RIP daemon configuration file, with the variables changed from the
Color daemon configuration file in bold—face type.

Hierarchy of transform options

Infoprint assigns a hierarchy to its use of flags and configuration-file information
when it runs the PDF transform program. The following lists the order in which
Infoprint uses flags and information specified in configuration files:

1. Any values you specify on the command line, including values in the
configuration file you specify with the -C flag.

Infoprint commands process flags from left to right. If you enter the same flag
more than once, Infoprint uses the last occurrence of the flag to determine the
value to use. For example, if you specify the following command:

pdfprs -C8263.cfg -r240 -r300 myfile.ps

The pdfprs command transforms the file using 300-pel resolution. Infoprint
ignores the resolution value specified in the configuration file 8263.cfg and the
first -r240 flag and value.

2. Values specified in the default transform command configuration file named in
[Table 4 on page 13|

3. Values specified in a customized configuration file identified with the -C flag of
the ps2afpd command when the transform daemon started.

4. Values specified in the default transform daemon configuration file named in
the /ust/lpp/psf/ps2afpd.cfg file.

5. Default values that are built into Infoprint. These are the same as the transform
defaults, except that the default PDF output type is an IM1 uncompressed
image.

Troubleshooting the parallel PDF RIP client

There are certain factors that can enhance the performance of your pdfprs client.
The following section provides some recommendations.

Defining RIPs on an Infoprint AIX server
The more RIPs you define, the greater the performance improvement.
However, because a single RIP uses an entire CPU, you should never start
more RIPs than your Infoprint Server can support. The pdfprs client
generally uses one processor, so be sure that your configuration can
support the number of RIPs that you define and start. For guidelines see
[Table 3 on page 11} For more information about defining RIPs across AIX
servers, see [15]

Specifying an uneven number of RIPs
If you have PDF files that have simple text data on the front page and
more complex image data on the back page consistently throughout the
job, a two-RIP configuration will not result in enhanced performance. Since
the second RIP always gets the more complex pages, the job will take the
same time to RIP as if a single RIP were used, while the first RIP remains
idle. Use an uneven number of RIPs to distribute the pages in the job more
evenly.

Using —p or —g options from the command line
While you can specify a page subset for a particular job by using the —p or
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the —g flags on the pdfprs command, IBM recommends that you avoid
these flags. If Infoprint has to determine a subset of the pages in the job, it
slows down processing and reduces the benefit of having parallel RIPs.

Working with the Infoprint PPML transform program

18

Infoprint Manager for AIX Version 4.1 provides a transform program to convert
Personalized Print Markup Language (PPML) data streams into the Advanced
Function Presentation (AFP) format that has been tailored for an IBM Infoprint
Color 130 Plus printer. PPML is an emerging XML-based print data stream that is
divided into subsets. Infoprint Manager for AIX supports the Graphic Arts
Conformance Subset for processing objects within the data stream that can consist
of PostScript, PDF, TIFF, and JPEG objects. Sample files that demonstrate the power
of this transform are provided in the default directory of /ust/lpp/psf/ppml2afp
with the names samplePS.ppml, samplePDEppml, sampleJPEG.ppml, and
sampleTIFE.ppml.

Users can submit PPML jobs to Infoprint through the following methods:
* Hot folder interfaces from PC or Macintosh systems.
* Use of the pdpr command from the AIX command line.

* Use of the standard AIX print commands (enq, lp, qprt) from an AIX command
line.

* Use of the Iprafp command from other UNIX systems.
Note: Infoprint does not support the —odatatype=ppml option.

For more information about how to submit PPML jobs to Infoprint Manager, refer
to Infoprint Manager: Reference.

When a PPML print job is submitted to print on a PSF physical printer, Infoprint
automatically invokes the transform. You can also run the transforms from the AIX
command line without printing the generated output. You may find this useful if
you intend to print the job later. Jobs print more quickly if they have already been
transformed.

The PPML transform has options that you can use to specify processing
information. For a list of the options or options and values for each transform,
refer to Infoprint Manager: Reference. Configuration files, environment variables, and
user-exit programs allow you to specify processing information for Infoprint to use
when it invokes the transform automatically. You can also use configuration files
and environment variables instead of typing options on the command line
whenever you run a transform.

Customizing the PPML transform

You can customize the transform for PPML data by specifying values in the
transform configuration files. [Table 1 on page 3 shows the default configuration
files that Infoprint provides. You can either modify these files or create your own.

Table 5. Default PPML transform configuration file

Data Stream Transform Configuration File

PPML ppml2afp /pst/ppml2afp/ppml2afp.cfg
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Sample PPML configuration file
shows an example of a configuration file for the PPML transform.
# ppml2afp configuration file

# KEYWORD EQUIVALENT ppml2afp option PURPOSE
iz tdddddazsaddddddssssdddddassddddddaadadddaddasdaddddddaaadddddgaaadddddsad

ppml_server_port = 8251 # -P port number of the server
# running the PPML2AF transform
ppml_server _name = 127.0.0.1 # -S  which server to connect with

ppml_work_directory = /usr/1pp/psf/ppmi2afp # -d  where PPML2AFP can store files

ppml_resolution = 600 # -r resolution of printer

Figure 6. Sample PPML configuration file

The configuration file uses keyword equivalents of the transform options. Refer to
Infoprint Manager: Reference for the keywords and values that you can specify in the
configuration file.

Hierarchy of PPML transform options

Infoprint assigns a hierarchy to its use of options and configuration-file
information when it runs the PPML transform program. The following lists the
order in which Infoprint uses options and information specified in configuration
files:

1. Any values you specify on the command line, including values in the
configuration file you specify with the -C option.

Infoprint commands process options from left to right. If you enter the same
option more than once, Infoprint uses the last occurrence of the option to
determine the value to use. For example, if you specify the following
command:

ppml2afp -Cconfig.file -r240 -r300 myfile.ps

The ppml2afp command transforms the file using 300-pel resolution. Infoprint
ignores the resolution value specified in the configuration file config.file and
the first -r240 option and value.

2. Values are specified in the default transform command configuration file, which
is lusr/lpp/psf/ppml2afp/ppml2afp.cfg. Infoprint ignores values in the default
transform command configuration file if you invoke the transform command
indirectly by submitting a job to print.”

3. Default values that are built into Infoprint. These are the same as the transform
defaults.
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Chapter 2. Configuring data stream transform sequences

Infoprint Manager allows you to create a sequence for transforming print data
before the system sends it to a printer. This provides users with a feature similar to
the configurable transform sequences that you could create in PSF/2 using the
XFMFLTR utility.

You can create a transform sequence through the Infoprint Manager
Administration GUI (for more specific information refer to the online help topic in
the Infoprint Administration GUI titled Server and transform tasks). The transform
sequence can be used for any print data processing, such as storing and
forwarding print data, removing PostScript controls from a print file before
sending it to an actual destination for printing, or viewing a file prior to printing
it.

Creating a transform object

To define a data stream transform object from the Infoprint Manager
Administration GUI that takes an AFP input file and copies it to a file location on
the hard drive without printing the output, use the following procedure:

1. Start the Infoprint Manager Administration GUL
2. Click the Server menu, and select Transform » Create.

3. In the Create Transform dialog;, fill in the fields as shown in
These values create a transform that copies AFP input data to an \afp
folder on a specific drive.

Note: Command attributes are provided so you can see how this transform
could be created from the command line.
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Create Transform

* Enter the name ofthe transform you want to create.

Marne

Serer

Format of output file
Description

Transform options

Hoy to process johs

Document farmats allowed

_o |

|z ave2afp
fiz57a63 =l
[MODCAP =l

ITal-:es an .afp file and stores it in a directory without printing it

copy "% elafpi%n.atp

& Transform only

™ Transform and print

Fossible values Yalues
metacode & mudca_p
m Add ==
passthru

| =
pc Femme
pf =

Cancel |

Help |

Figure 7. Create Transform dialog: Define a transform that copies an AFP file to a directory without printing
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4. Click OK.

Infoprint Manager saves the transform under the name you provided in the
Name field so that you can see its values by selecting Transform » Properties

from the Servers menu.

In the Transform options field, you can use a series of substitution variables to
provide special options for the transform sequences. Infoprint Manager
substitutes various strings for these variables when it generates the actual
command to execute. These substitution variables are described in .

Table 6. Transform substitution variables

Transform options Substitution Variables

Meaning

Y%i

The name of the input file to transform.

%0 The name of the file in which to store the
output of the transform.
Note: If this is a non-terminating
transform, data must be stored in the file
named by %o.

%e

The name of the file in which to store any
transform information or error messages.
If anything is written to this file, it is
logged in the Infoprint Manager server
log.
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Table 6. Transform substitution variables (continued)

Transform options Substitution Variables | Meaning

%j The name of the original print file, minus
the path (from the document-file-name
attribute).

Note: This should only be used to
construct another name, such as a
temporary file.

Y%n The name of the original print file, minus
the path and minus the extension (from
the document-file-name attribute).

Note: This should only be used to
construct another name, such as a
temporary file

%d A text string that represents the document
format of the input file. This value may
be:

e ASCII for ASCII line data.

e AFPDS for Advanced Function
Presentation data

* PCL for Printer Control Language data
* PS for PostScript data

%p The value of the destination-pass-through
attribute.

%q The actual destination (printer) that
performs the transform.

Yot The job-identifer.

Defining a transform sequence

To associate a data stream transform sequence with an actual destination from the
Infoprint Manager Administration GUI, use the following procedure:

1. Select the printer that you want to send the job to.

2. Click Printer » Properties to open the Printer Properties notebook for the
selected printer.

3. In the Printer Properties notebook, click the Configuration tab.

The data stream transforms that this printer can use are listed in the
Transforms to use field.

Note: If you can’t see the Transforms to use field, click Show more.

4. Use the Add and Remove buttons to specify the transforms in the sequence
that they should be run in the Values field.

For example, you might want to create a two-step transform sequence that first
runs the postscriptxform transform and then saves a copy of the generated
AFP data in c:\afp \*.afp. To accomplish this task, the Values field would
contain the following:
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mapping postscripttdform
pastscripttdarm saveZafp
: afp

Figure 8. Printer Properties notebook: Transforms to use

where postscriptxform is a transform object with the following values:

Create Transform

js57963
moocep

postscript

Figure 9. Create Transform dialog: Create a transform that converts PostScript data into AFP

5. You could also create a one-step transform sequence that sends output to a
customized program (residing on the D drive in the tools\my_ps_filer folder)
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that removes PostScript controls from a file to simplify printing at a particular
destination. If this transform were named ps2remy, it might contain the
following values:

Create Transform

js57963 [z
postschpt [z

dtoolstmy_ps_filter.exe "%i" "%o"

postscript

Figure 10. Create Transform dialog: Create a transform that removes the PostScript controls from a file

6. When you have entered the transforms in the correct sequence, click Apply to
associate this transform sequence with the selected printer.

If you prefer to use the command line, you can use the following Infoprint
commands from an MS/DOS window with transform objects:

* pdcreate
* pddelete
e pdset

e pdls

For more information about the attributes in creating transform sequences, refer to

the Attributes for Transforms topic in Chapter 7. Infoprint Object Attributes of
the Infoprint Manager: Reference or to the appropriate man pages.
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Using the netware print program
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From a Command Prompt window on an Infoprint Manager for Windows NT or
Windows 2000 server, you can submit Netware Version 4 Release 1 jobs to an
Infoprint Manager printer. The command removes the Netware-generated
Postscript header and submits the job for printing by using the JobName and
JobOwner parameter values from the original header.

To submit a Netware-generated job, type the following in a Command Prompt
window, substituting the italicized terms with the appropriate values as described
below.

netwareinput_name output_file_name log_dest_name

input_file
The fully-qualified name of the file from Netware 4.1 with a Postscript
header.

output_file
The fully-qualified name of the file from Netware 4.1 without the
Postscript header (after the transform has run).

log_dest_name
The name of the Infoprint Manager logical destination that the job is
submitted to after the Postscript header has been removed.

The following example submits a PostScript file from Netware (%i) to be
transformed into file without the PostScript header (%0), which is then submitted

to a logical destination called happyprinterl.

netware %i %0 happyprinterl
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Chapter 3. Understanding transforms and the configurable
transform subsystem

Transforms

Transforms are Infoprint objects (like queues and destinations) that you create and
configure in Infoprint Manager. Transforms receive data in a particular format or
formats, process the data in some way, and output the changed data. When you
create a transform, you have complete control over what data format or formats it
operates on and what type of processing it does. The processing that the transform
performs can be anything from simply copying the data to a different place on
disk, to filtering the data stream that the transform receives (for example, to
remove a particular PostScript order), to transforming the data to a completely
different format (for example, converting PCL to AFP).

When you create a transform, you specify several things, including:
* Input data format

The data stream that is sent to the transform. The input data format is what the
transform uses to determine whether or not it has any work to do. If you send a
PostScript job through a transform that has its input data stream set only to
PCL, the job will bypass the transform without being changed at all. You can set
the transform to accept multiple input data formats.

e Transform options

The program or command that actually does the work of the transform; what
happens during the processing stage. The transform options can be system
commands (such as copy), programs provided with Infoprint Manager (such as
ps2afp), or your own custom transform programs (for example, mypclfixup).

When you create a transform, you specify the complete command line needed to
invoke this program or command. Within this command line, you can also
specify various substitution variables, place holders which Infoprint Manager
replaces with a value when Infoprint Manager runs the transform. For example,
if you include %1 in the line, Infoprint Manager will replace it with the name of
the file that the transform receives; if you include %o, it will be replaced with the
name of the file that the transform puts the changed data into.

* Output data format

The data stream that results from the transform. You can only specify one output
data format.

In addition, you can specify whether or not you want the file that the transform
produces to be printed. If the transform doesn’t submit the file to be printed (for
example, if the transform completes its processing and saves the file to a different
location), it is called a terminating transform.

Transform sequences

Transforms do not do anything by themselves. They remain inactive until you
associate them with an actual destination as a transform sequence. A transform
sequence is an attribute of an actual destination that contains an ordered list of
transforms. Every job that is submitted to that actual destination is sent through
that list of transforms in the order specified before it is printed.

© Copyright IBM Corp. 1998, 2002 27



28

Note: If you include a terminating transform in a transform sequence, it must be
the last transform in the sequence.

Transform sequence example

You want to define an actual destination that will copy AFP versions of all print
jobs sent to it into a directory on your Infoprint Manager server system. This
directory is used as an archive of AFP versions of print jobs that may need to be
viewed later.

To accomplish this, you use the Infoprint Manager Administration GUI to create
these three transforms:

1. tranps

You set the input data format to PostScript, the Transform options to use
ps2afp, and the output data format to MODCA-P (Mixed Object Document
Content Architecture).

2. transpcl

You set the input data format to PCL, the Transform options to use pc12afp,
and the output data format to MODCA-P.

3. saveafp

You set the input data format to AFP, the Transform options to issue a copy
command, and the output data format to MODCA-P. In addition, you make
this a terminating transform by selecting Transform only in the Create
Transform dialog.

Then, create an actual destination that you want to perform the transform
sequence. When the Printer Creation wizard asks if you want to change the
configuration for the printer, select yes, then click the Configuration tab to define
the transform sequence as follows:

1. transps
2. transpcl
3. saveafp

Note: If you already have the destination created, open the properties notebook for
that actual destination and click the Configuration tab to define the
transform sequence.

Now, when you send a job to this actual destination, the following sequence of
actions occurs:

1. transps checks to see if the incoming data is PostScript. If it is
PostScript,transps transforms the data into AFP using ps2afp. If it is not
PostScript, transps does nothing.

2. transpcl checks to see if the incoming data is PCL. If it is PCL, transpcl
transforms it to AFP using pc12afp. If it is not PCL, transpcl does nothing.

3. saveafp copies the AFP file produced by either of the above steps into a
specific directory.

4. Since saveafp is a terminating transform, the job is not printed but is marked
complete at this point.
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Netware.exe

Netware.exe is one of the transform programs that is included with Infoprint
Manager. This program extracts the user ID and job information from the header of
PostScript print jobs that are submitted from a Netware server, then strips that
header off the job and creates an new header that prints correctly from Infoprint
Manager. Netware.exe is a terminating transform, but not because it stores its
output in another file. It is a terminating transform because the last step of the
program is to issue a pdpr command, which submits the job to a logical
destination to be printed.

Note to PSF for OS/2 users: Netware.exe provides the same function that was
available through netware.cmd in PSF for OS/2.
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Chapter 4. Printing PCL or PostScript to PSF destinations:
Specifying which paper bin to use

In general, when you submit a print job through a PCL or PostScript driver, you
can use the printer options to specify which input paper bin you want the printer
to use. For example, if you know that white 8.5 x 11 inch paper is always loaded
in bin one and letterhead is always in bin two, you can select bin one when you
want to print a draft and bin two when you're ready to print a real letter.

When you send PCL or PostScript print jobs to a PSF Destination in Infoprint
Manager, the data stream is transformed into Advanced Function Presentation
(AFP) before it is printed. By default, most PCL jobs that are transformed use
paper bin one, regardless of the bin you specify. Transformed PostScript jobs
default to letter-sized paper if no other options are specified, and look for a bin
that contains that size paper; they either print on paper from the first bin that
contains the right size or fail because they don’t find the right paper.

If you want the transform program to check for your bin selection and include it in
the AFP data that is sent to the printer, you must specify mappings between the
PCL and PostScript bins and the AFP bins. The transform will use your mappings
to convert the bin number it finds in the PCL or PostScript into an AFP bin
number. You can configure Infoprint Manager so that you can specify up to 20
different input paper bins. For information about how to figure out which PCL and
PostScript bins map to which AFP bins, refer to [“Determining bin mappings”}

To set up bin mapping, refer to [‘Editing configuration files” on page 36}

Determining bin mappings

PCL printing
When you submit a print job through a PCL print driver and select a paper bin to
print from, the driver generates a bin number and puts it into the data stream.
Unfortunately, different drivers generate different bin numbers for the same bin.
For example, one driver might make "Tray 1” equal to bin 4 and "Auxiliary tray”
equal to bin 2, while another driver makes "Tray 1" equal to bin 1 and "Auxiliary
tray” equal to bin 8. To add more difficulty, the generated PCL bin numbers can
range from 0 to 59. While most drivers use low numbers (0 through 10), keep in
mind the other possibilities.

During the transformation from PCL to AFP, Infoprint Manager takes the bin
number that the driver generated and compares it to the bin mappings you set.
The pcl2afp transform inserts the AFP bin number that you assigned and sends the
job to the destination you requested. The printer prints the job on paper from the
bin you chose. As a result, it is essential that all of the users who submit jobs to a
given Infoprint Manager printer use the same driver. If they don’t, the mappings
you set up will not work correctly for them.

The first challenge for you in setting up the mappings is determining what bin
number the PCL driver places in the data stream. For various IBM printers, the
drivers actually generate the same bin numbers. If you are using the PCL5e driver
for an IBM Network Printer 12, Network Printer 17, Network Printer 24, Infoprint
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20, Infoprint 21, Infoprint 32, or Infoprint 40, the numbers listed in are
placed in the data stream.

Table 7. IBM PCL5e bin numbers

Tray (what you select in Device Settings) | PCL bin number (what the driver puts in
data stream)

Automatically Select 0

Tray 1

Manual feed paper

Manual feed envelope

Auxiliary tray

Tray 2

Envelope feeder or Envelope tray

Tray 3

Tray 4

O |0 [ I[N |G || W|N|~—

Tray 5 or 2000 sheet input tray

If you are using a different driver, the documentation that came with your printer
may provide these numbers ; look for a section on the PCL driver. Alternatively, if
you are able to capture the PCL data that is sent to a specific bin in your printer,
you can look for the bin number in the data stream. In some cases, however, it
might be just as easy to use trial and error to determine the correct mappings.
Again, keep in mind that PCL bin numbers can range from 0 to 59.

The second challenge is in determining the AFP bin numbers that correspond to
your printer. AFP bin numbers range from 1 to 255, and are not standard from
printer to printer. Some printers have hard-coded bin numbers: each bin on the
printer actually has a number written on it. In other cases, the AFP bin numbers
are more difficult to discover. In fact, the numbering scheme for some printers
changes completely when you add one of the optional paper bins, and still other
printers allow you to change the bin numbers yourself. As a result, it is difficult to
predict exactly what the AFP bin numbers for your printers are. However, there are
some guidelines that you can use.

* Most AFP paper bins use numbers 1 through 10, with 1 being the biggest,
topmost, or bottommost bin.

* Envelope feeders/bins start at number 65 and can go up to 69.

¢ The manual feed tray is usually number 100.

If you are printing to IBM printers, the best place to find the default numbering
schemes for each printer is the IPDS and SCS Technical Reference and the IPDS
Handbook for printers that use the AFCCU, both of which are available from the IBM
Printing Systems website at http://www.ibm.com/printers. (Select Support on the
left-hand navigation bar, then look under Online Service and Support, find the
Manuals and Publications link. The IPDS and SCS Technical Reference is located
under Distributed Printers- Network Printer Technical References, and the IPDS
Handbook for printers that use the AFCCU is under Print on Demand and
Production Printers- IPDS Technical References.

If you find the AFP bin numbers for your printer in this documentation, be aware
that the number is written in hexadecimal notation. You must convert the number
to decimal before you put it in the mapping file. In addition, the numbers that are
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listed are the machine numbers, not the numbers the software requires. After you
convert the number to decimal, add 1 to it to get the number that you should put
in the mapping file.

Given this information, the best way to determine the correct AFP bin numbers is
to start with these guidelines and use the trial and error method until you have the
mappings set correctly.

For example, if you have a printer with three paper bins and a manual feed bin,
you could do the following.

1. On your Infoprint Manager Windows client system, install the PCL driver that
you plan to use.

2. Create a printer that uses the driver you just installed and has a PSF printer
as its target destination.

3. From the Windows Client, click the Start button and select
Settings—>Printers to open the Printers window.

4. Right-click the printer you just created and select Properties from the pop-up
menu.

5. Click the Device Settings tab to show the printer options that are available for
this driver. For example, some drivers show a list of "paper trays” and allow
you to select a paper size for each one.

6. Make sure all of the paper trays you plan to use are activated and have the
correct size paper selected.

7. Click OK to close the dialog and make the settings take effect.

8. Follow the appropriate procedure below: [“Editing configuration files” on|
Pag
When you have to enter PCL and AFP bin numbers, start with the guidelines
above and create some logical mappings, such as the ones shown in table

for an Infoprint 20.

Table 8. Sample mapping table for an Infoprint 20

Tray selection PCL bin number AFP bin number
Tray 1 1 1
Tray 2 5 2
Tray 3 7 3
Manual feed tray 2 100
Envelope tray 1 6 60
Envelope tray 2 4 61

Complete the procedure.

9. Load each paper bin (including the manual feed bin) with a different kind,
color, or specially marked paper.

10. Submit a test job to each bin and see which paper it is printed on. Keep track

of your results and use them to change the mappings to meet your

configuration.

11. Once you have the mappings worked out correctly, tell your operators the

following information:

¢ What options to set in the device settings.

* What kind of paper is in each bin.

* How to print to each bin.
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PostScript printing

PostScript drivers use different methods to determine what paper bin to print a job
on. Some drivers allow you to select which paper tray you want the paper to come
from. When you submit a job, the driver sends a number to the printer to ask for
the corresponding tray. Other drivers allow you to select different paper options
(such as size, color, or weight). When you submit a print job, these options are sent
with the print job and are used to determine which paper bin to use (paper size is
the only option that you have to set for this function to work).

When you configure Infoprint Manager correctly, it will work with either type of
driver. There are three steps involved in performing this configuration:

1. [“Gathering paper tray information”|

2. [“Identifying paper trays to Infoprint Manager” on page 35|

3. [‘Testing tray mappings” on page 36|

Gathering paper tray information
The first step in configuring Infoprint Manager is to figure out :

* How many paper trays does your printer have?
* What is the AFP bin number for each tray?

Guidelines for figuring out the bin numbers are provided below.
* What kind of paper will you be loading into each tray?

At a minimum, you should know what size paper will go in each tray. If you
need to, you can also specify a color or weight of the paper.

Use this chart to record your data.

Table 9. Paper tray chart

AFP bin number (in decimal Paper tray on printer Paper loaded
notation)
100 Manual feed tray

There is trial and error work involved in figuring out the correct bin numbers. AFP
bin numbers range from 1 to 255, and are not standard from printer to printer.
Some printers have hard-coded bin numbers; each bin on the printer actually has a
number written on it. In other cases, the AFP bin numbers are more difficult to
discover. In fact, the numbering scheme for some printers changes completely
when you add one of the optional paper bins. Still other printers allow you to
change the bin numbers yourself. As a result, it is nearly impossible to predict
exactly what the AFP bin numbers for your printers are. However, there are some
guidelines that you can use.

* Most AFP paper bins use numbers 1 through 10, with 1 being the biggest,
topmost, or bottommost bin.
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* Envelope feeders/bins start at number 65 and can go up to 69.
* The manual feed tray is usually number 100.

If you are printing to IBM printers, the best place to find the default numbering
schemes for each printer is the IPDS and SCS Technical Reference and the IPDS
Handbook for printers that use the AFCCU, both of which are available from the IBM
Printing Systems website at http:/ /www.ibm.com/printers. (Select Support on the
left-hand navigation bar, then look under Online Service and Support, find the
Manuals and Publications link. The IPDS and SCS Technical Reference is located
under Distributed Printers- Network Printer Technical References, and the IPDS
Handbook for printers that use the AFCCU is under Print on Demand and
Production Printers- IPDS Technical References.

Important: If you find the AFP bin numbers for your printer in this
documentation, be aware that the number is written in hexadecimal
notation. You must convert the number to decimal before you put it in
the mapping file. In addition, the numbers that are listed are the
machine numbers, not the numbers the software requires (they’re the
IPDS bin numbers, not the AFP bin numbers). After you convert the
number to decimal, add 1 to it to get the number that you should put
in the mapping file.

Identifying paper trays to Infoprint Manager
Once you have the chart filled in with your first attempt at mappings, you can
move to the second step: identifying all of the bins to Infoprint Manager.

By default, Infoprint Manager assumes that all PostScript printers have only one
paper tray. When you identify the trays, you let Infoprint Manager know how
many there really are. Then, when you submit a job, you can choose any one of
them.

You identify the paper bins to Infoprint Manager either in the configuration file or
in the transform you create. In this step, you will determine the syntax that you
will be able to use in either place. The general syntax of the identification
statement is:

inputX=(size,type=xxx,weight=xxx,color=xxx),inputX=(size,
type=xxx,weight=xxx,color=xxx)

Where the following conditions apply:

* Each inputX corresponds to a different paper tray. You should have as many
inputX entries as you have paper trays. Separate them with commas, no spaces.

* The X in each inputX is replaced with the AFP bin number from

for each tray.

* Size is the only required paper attribute. Replace the word size with the size of
the paper that will be in the tray, such as letter, legal, 8.5ix11i, or A4.

¢ Other paper attributes can be specified or left out entirely.

All of the following are valid identification statements:
inputl=(Tletter),input2=(legal),input100=(letter)
inputl=(8.5ix111,color=bhlue),input2=(8.5ix11i,color=yellow),

input3=(11ix17i),input100=(8.5i1x111)
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inputl=(A4,color=white),input2=(A4,color=blue),input3=(A4,color=yellow),
input65=(C5),input100=(A4,type=Tetterhead)

Write out your identification statement before moving on to the next step.

Testing tray mappings
Once you have your identification statement created, you can test your mappings
to make sure they are correct. The following procedure explains one way to verify
the mappings.
1. On your Infoprint Manager Windows client system, install the PostScript
driver that corresponds to your printer.

2. Create a printer that uses the driver you just installed and has a PSF printer
as its target destination.

3. Click the Windows Start button and select Settings—>Printers to open the
Printers window.

4. Right-click the printer you just created and select Properties from the pop-up
menu.

5. Click the Device Settings tab to show the trays and options that are available.

6. If your driver lists the paper trays that are available, activate them and select
paper sizes for each one. Set the options to match your identification
statement.

7. Click OK to close the dialog and make the settings take effect.

8. Refer to[“Editing configuration files”so you can use the same mappings for all
of your printers.

9. Follow the appropriate procedure.

When you have to change the configuration file or enter the command that
your transform will use, replace the inputX=... statement with your
identification statement from [“Identifying paper trays to Infoprint Manager”|
and complete the procedure.

10. Load each paper bin (including the manual feed bin) with a different kind,
color, or specially marked paper.

11. Test your settings by submitting print jobs to each bin of the Windows
gateway printer and making sure that it prints on the correct paper. If a job
does not print on the correct paper, adjust your AFP bin numbers and input
numbers as necessary.

12. Once you have the mappings worked out correctly, tell your operators the
following information:

* What options to set in the device settings.
* What kind of paper is in each bin.

* How to print to each bin.

Editing configuration files

36

There are five configuration files that come with the Infoprint Manager PCL to
AFP and PostScript to AFP transforms. For the PCL transform, they are: pcl2afp.cfg
and pcl2afpd.cfg. For the PostScript transform they are:ps2afp.cfg, ps2afpd.cfg
(used with Infoprint 3000 and Infoprint 4000 printers), and 3160d.cfg (used with all
other IPDS printers). You will only need to edit one of these files based on the data
stream that your driver produces, the printer you send your jobs to, and on the
following considerations.

 Edit pcl2afpd.cfg, ps2afpd.cfg, or 3160d.cfg if you want everyone to use the
same mappings. This method is recommended.
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 Edit pcl2afp.cfg or ps2afp.cfg if different people have to use different mappings.

Follow these steps to edit the appropriate file.

1. On the system that your Infoprint Manager server is installed on, locate the file.
It should be in the /usr/lpp/pst/pcl2afp or the /usr/lpp/pst/ps2afp directory.

2. Open the file in a text editor, such as dtpad, vi, or pico.

At the bottom of the file, you will see blocks of instructions and sample
commands.

3. Modify the file according to the instructions in the file.
Choose one of the options and uncomment that line, then enter your mapping
numbers. If you are using the ps2afp transform, replace the inputX=... portion
of the device_controls line with your identification statement from [‘Identifying]
[paper trays to Infoprint Manager” on page 35,

4. Save the file.

Note: It is recommended that you save a copy of your changes in a directory
outside of the /usr/lpp/psf path so that you have a copy in case you
ever have to re-install or apply service to Infoprint Manager.

5. Close the file.
6. Restart the configuration daemon (for example, for PCL, specify ps2afpd -C

/usr/1pp/psf/bin/ps2afpd at the AIX command line) to have the new settings
take effect.

7. Tell your users what kind of paper is in each bin and how to print to each of
them.

Creating a transform with bin mappings

You can use the Infoprint Manager transforms to process print jobs with different
options, including which paper bins to use. First, you create a transform using the
Infoprint Manager Administration GUI, specifying an input data stream and an
output datastream. Then, you associate it with one or more printers. When you
send a print job to that printer, your transform checks to see if the file is the
datastream that needs to be transformed. If it does, the transform converts the file
as you specified; if it is not, the transform passes the file to the logical destination.
As a result, if you don’t want to use the same bin mappings for all of your
printers, you can create several different transforms, all with different mappings.
Then, associate each transform with whichever printer or printers you want.

Note: If you will be sending both PCL and PostScript jobs to the same printer, you
can create two transform objects (one that accepts PCL and one that accepts
PostScript) and associate them both with that printer.

Follow these steps to create a transform that maps PCL or PostScript bins to AFP
bins.

1. In the Infoprint Manager Administration GU]I, click the Server menu and
select Transform —> Create.

2. In the Create transform dialog, fill in the fields:
* Name: Type a name for the transform.
* Server: Choose the correct Infoprint Manager server.
* Format of output file: Select MODCA-P.

* Description: Type a description that will help you remember which printer
uses this transform.
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10.
11.

* Transform options: The command line that will execute when the transform
runs.

If this transform accepts PCL, type:

pcl2afp -o "%o" "%i" —device
'plex,inputX=(pcl_bin=Z),inputX=(pcl_bin=2)"

Replace the Xs with the number of the AFP bin (on the printer) and Zs with
the number of the PCL bin. You can specify up to 20 mappings.

If this transform accepts PostScript, type:

ps2afp -o "%o" "%i" —device
'plex,inputX=(size,type=xxx,color=xxx,weight=nnn),
inputX=(size,type=xxx,color=xxx,weight=nnn)'

Replace the inputX=... portion of the command with your identification
statement from [“Identifying paper trays to Infoprint Manager” on page 35,
Replace size with a paper size such as letter, legal, A4, or the dimensions of
the paper in inches (8.5i1x111), millimeters (216mx279m), or points
(612px792p) and the Xs with the number of the AFP bin (on the printer).
Size is the only required value; the others you can either fill in or delete.

* Select Transform and print.

* Document formats allowed: The data stream that your transform accepts.
Select PCL or PostScript and add it to the allowed values.

* Click OK.

Select the printer that you want to associate this transform with and open its
properties notebook.

Click the Configuration tab.
Find the Transforms to use field.

Select the transform you just created in the Possible values box and add it to
the Values box.

Click Apply.

Click the Document tab.

Find the Formats allowed section.and look in the Values box. Make sure that
modca-p and either pcl or PostScript are listed.

Click OK.

Tell your users what kind of paper is in each bin and how to print to each of
them.
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Chapter 5. Submitting PSF printer input to a PCL or PPDS

printer

In addition to AFP printing, Infoprint Manager allows you to submit PSF printer
input data to PCL and PPDS printers as well.

When you use the Create Printer wizard in the Infoprint Manager Administration
GUI to create a printer object that will send jobs to a PCL or PPDS printer, you
must specify the path for the command in the Printer command field. For
example, by default the Ipr command is located at /usr/bin/lIpr. Because Infoprint
Manager does not search the PATH environment variable for the command, you
must either add that directory to the PATH for that system or specify the entire
path of the command, as in the following example:

/usr/bin/1pr -P printername -S servername

If you need to specify a file name in the command in a location other than at the
end of the command, you must include the text-string -IPMF- in the command
string. The temporary file name used to store either the PCL or PPDS data
generated by Infoprint Manager is substituted into the command wherever the
-IPMEF- text-string is located.

Note: The dashes (-) on either side of the -IPMF- text-string are part of the syntax
and cannot be omitted.

You can only specify one -IPMEF- text-string in a print command, as in the example
below:

/usr/bin/copyit -IPMF- -b /tmp

where copyit represents a user-written application for moving either the PCL or
PPDS file that Infoprint Manager generated to the specified directory (in this case,
/tmp), and giving it a unique name.

Setting up PCL tray mappings

Follow these steps to map the input trays requested in the AFP data stream to the
input trays on your PCL printer:

1. Determine the AFP bin number and PCL bin number for each input tray.
Table 10| shows the default bin numbers associated with some standard names
for input trays.

Table 10. Default bin mappings

Input tray name AFP bin number PCL bin number
alternate 3 5
bottom 2 4
envelope 65 6
manual 100 2
top 1 1
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If these mappings are not appropriate for your printer, reverse the process
described in [‘Determining bin mappings” on page 31} In this case, the AFP bin
number is the bin number in the data stream and the PCL bin number is the
bin number used by the printer.

2. Open the Infoprint Manager Administration GUI.
3. Click the printer that you want to set up trays on.

4. From the Media/Bins/Trays tab of the Actual Destination Properties notebook,
in the Media ready table, select Add to define a new tray or Modify to change
an existing one. You can define up to 15 trays.

5. Complete the following fields:

Input bin number
This field specifies the AFP bin number.

Media ready
This field shows the medium loaded in the input tray. The drop-down
list allows you to select from all media supported by the printer.

Input tray name
This field shows the name associated with the input tray. Standard
names for PCL input trays are:
alternate
envelope
lower
manual

upper
Formerly, these were the only names allowed. You can now use any
name you like, subject to these restrictions:

* Manual trays must have the string manual somewhere in the name,
in any combination of upper and lower case, for example,
transparentMANUALa4. You can define multiple manual trays.

* Envelope trays must have the string envelope somewhere in the
name, in any combination of upper and lower case, for example,
NumberlOEnvelope. You can define multiple envelope trays.

Tray number
This field specifies the PCL bin number.

Duplex
This field specifies whether two-sided printing is possible from this
input tray.
6. Click OK.

To make your changes take effect, you must now stop and restart PSF, the printer,
or both. Follow the steps corresponding to your job submission method.

* If you use PSF Direct to submit jobs:
1. On your host system, stop PSF.

2. Restart your host PSE. The changes you made are registered when the host
PSF restarts.

 If you use DPF to submit jobs:
1. On your host system, stop PSF.

2. In the Infoprint Manager GUI, click the printer to select it, then choose
Printer » Stop.
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Note: If you don’t see Stop on the Printer menu, use Add/Remove Menu
Items to add it.

Open the Management Console and click the DPF Host Receivers item in the
left pane.

Click the DPF Host Receiver that feeds this printer to select it.
Click Actions» Obtain Printer Characteristics.

Go back to the Infoprint Manager GUI and start the printer again.
Restart the host PSE.

 If you use any other method to submit jobs:

1.

In the Infoprint Manager GUI, click the printer to select it, then choose
Printer » Stop.

Note: If you don’t see Stop on the Printer menu, use Add/Remove Menu
Items to add it.

In the Stop command dialog, select Shut down and click OK.
Select Printer » Enable to restart the printer.
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Chapter 6. Working with fonts

This chapter describes the fonts required for printing different data formats. It also
describes what you must do so that Infoprint can use them.

Font substitution on the InfoColor 70

If any fonts are missing from a PostScript job submitted to the InfoColor 70, the
printer automatically substitutes Helvetica.

Fonts for printing transformed PostScript and PDF data

The Infoprint PostScript transform program uses Type 1 outline fonts when
transforming PostScript and PDF files. Infoprint includes the IBM Type 1 outline
fonts and these fonts are installed in subdirectories of the /ust/lpp/psf/ps/fonts
directory during installation. If you have other Type 1 outline fonts, you can also
use them with the transform program.

Note: When Infoprint runs the PostScript transform program during job
submission, it can search other directories for fonts.

Font-mapping files
A font-mapping file identifies the file names of the Type 1 outline fonts on the AIX
system. The Infoprint PostScript transform program requires at least one
font-mapping file. Infoprint installs the default font-mapping file, psfonts.map in
the /usr/lpp/psf/ps directory during installation. If you have other Type 1 outline
fonts installed on your system, you can create additional font-mapping files to
define their names.

PostScript font-mapping file considerations
When you create your own font-mapping files, consider that:

* You can create more than one font-mapping file.

* At least one font-mapping file must contain the Courier font. The PostScript
transform program substitutes Courier for any missing fonts.

Creating a PostScript font-mapping file

Use the Infoprint mkfntmap command to create a font-mapping file for use with
the Infoprint PostScript transform program. You specify one or more input files
containing Type 1 outline fonts and a name for the font-mapping file.

For example, to use the input file FontFile and create a font-mapping file named
font.map, enter:

mkfntmap FontFile > font.map

Using font-mapping files with the ps2afp or the pdf2afp

command
By default, Infoprint uses the psfonts.map font-mapping file when you issue the

ps2afp or the pdf2afp command; you do not have to specify the name of the
default font-mapping file with the command.

To use font-mapping files that you have created when you issue the ps2afp or the
pdf2afp command, you must do one of the following:
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* Enter the path and name of the font-mapping file as the value of the
ps_font_map_files keyword in the transform daemon configuration file. For
performance reasons, this is the recommended method. You can specify more
than one font-mapping file, if necessary. Separate the font-mapping files with
colons.

For example, to specify the font-mapping files fontl.map and font2.map, enter
the following:

ps_font map_files=/path/fontl.map:/path/font2.map

* Enter the path and name of the font-mapping file as the value of the
ps_font_map_files transform command configuration file. Use the same syntax
as described for entering the value in the transform daemon configuration file.
Using this method can result in significant performance degradation.

* Specify the font-mapping file, including its path name, from the command line
using the -F flag of the ps2afp or the pdf2afp command. You can specify
multiple files using multiple -F flags; Infoprint concatenates them from
left-to-right (first entered to last entered) in that order.

For example:
ps2afp -F/path/font.map

This method can also result in degraded performance.

Note: If you use the ps2afp -F or the pdf2afp -F command flag or the
ps_font_map_files keyword in the transform command configuration file to
specify a font-mapping file, and the value is different than that specified in
the transform daemon configuration file, the transform daemon restarts the
PostScript interpreter so that the new value for the font-mapping file takes
effect. However, restarting the PostScript interpreter decreases performance.

Specifying font substitution through initialization files

You can issue specific PostScript commands to specify whether printers substitute
fonts for those defined in job tickets that are neither inline with the job nor
resident on the printer. To perform this task, modify the UserInit file that is located
in the /var/psf/ps2afp

To ensure that fonts not inline with the job or resident on your printer substitute
Courier fonts to allow the job to print, specify the following in the UserInit file:
%!

turnFontSubstitutionOn

To ensure that fonts not inline with the job or resident on your printer do not
print, specify the following in the UserInit file:
%!

turnFontSubstitutionOff

Note: For your convenience, IBM has provided a sample Userlnit file in the
Ivar/psf/ps2afp directory (used by the IBM Infoprint 4000 PostScript
transform) and in the /var/psf/ps2afp2 directory (used by the IBM Infoprint
60 PostScript transform): UserInit.turnFontSubstitutionOn.sample.

You can use the desktop Text Editor to rename and use this Userlnit file at
your installation.
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Adding non-IBM fonts to AIX for a PostScript job

If your Infoprint system receives a PostScript job from a personal computer system,
the fonts required for that job might not reside on the AIX system. An Infoprint
Submit operator might find that either:

* Fonts are not available on AIX

 Fonts are not in the .pfa or .pfb format required for PostScript fonts

If either of these conditions occur, the AIX administrator must make these fonts
available before printing the PostScript job.

To simplify the process of moving fonts from a personal computer system to AIX,
fonts can be sent inline in a PostScript job and captured on AIX by using the
FontSave utility.

Note: Before activating the FontSave utility, ensure that you have the correct
licensing to add inline fonts from customer jobs onto the MPC. IBM
provides this utility, but is not responsible for verifying that you are
authorized to use the fonts a customer may provide inline through a print

job.
Activating the FontSave utility

You can perform this task by using the following procedure. These directions
presume that you have not modified the default file names used by the PostScript
transform. If your AIX system controls both the IBM Infoprint 4000 and the IBM
Infoprint 60, two separate PostScript transforms are controlled by two separate
configuration files: ps2afpd.cfg for the Infoprint 4000 and 3160d.cfg for the
Infoprint 60.

If you have already edited either of these configuration files, these commands
might differ. If your installation contains both transforms, ensure that you make
the changes for both configuration files.

1. Ensure that the PostScript transform daemons are running prior to starting the
Infoprint software.

If these daemons are not running, open an AIX window and enter:
ps2afpd -C /usr/1pp/psf/ps2afp/daemon

where daemon refers to either the ps2afpd.cfg or the 3160d.cfg file.

2. Edit the /usr/lpp/psf/ps2afp/daemon configuration file by adding the following
line at the end of the file:
input_exit = /usr/1pp/psf/bin/fontsave

3. Change the line that describes where the font maps reside from

ps_font map _files = /usr/1pp/psf/ps/psfonts.map :\
/var/psf/psfonts/user.map

to

#ps_font_map_files = /usr/1pp/psf/ps/psfonts.map :\

# /var/psf/psfonts/user.map

ps_font_map_files = /usr/1pp/psf/ps/psfonts.map :\
/var/psf/psfonts/user.map :\
/var/psf/workd/FontSave.map

where workd represents the PostScript transform’s work directory. If you are

printing to an Infoprint 4000, the directory defaults to ps2afp, and if you are
printing to an Infoprint 60, the directory defaults to ps2afp2.
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Note: By commenting out the original lines (#), you retain the ability to turn
off the FontSave utility as described in [‘Deactivating the FontSave|
jutility” on page 47}
4. From the AIX-command line, verify these changes by using the cd command
to access the changed files and using the view command to verify the
changes.

The PostScript transform program detects these changes automatically after
they have been saved.

5. Access the working directory that the PostScript transform uses by entering:
cd /var/psf/workd

From the AIX command line, create the initial font save font mapping file by
entering the following commands in sequence:
touch FontSave.map
chown daemon.printq FontSave.map

6. Test this function by preflighting a PostScript job from the Infoprint Submit
Advanced options window using the command:

-a NONE

7. Access the work directory for the PostScript transform, where the saved fonts
should exist:

cd /var/psf/workd

8. Enter an Is command to ensure that the FontSave directory and the following
files exist:
e FontSave.wrk
* FontSave.map
e FontSave.bak

Note that the FontSave.bak might not be present if only one PostScript job
has been preflighted through the transform when you view this display.

9. If this directory and these files are present, view the FontSave.map file, which
displays the fonts that have been saved as Adobe Type I fonts that can be
used by the PostScript transform.

For example, to map the Macintosh font Garamond-Light, the FontSave.map
file would display the following line:

font Garamond-Light /var/psf/workd/FontSave/Garamond-Light

where Garamond-Light is the Type I font saved by the FontSave utility that
will be used whenever the PostScript job calls for the Garamond-Light font.

If this directory and these files are not present, ensure that you have made the
changes to both the ps2afpd.cfg or the 3160d.cfg files. Also, check the
PostScript job that you submitted from Infoprint Submit to ensure that it
contained inline fonts.

10. To verify that the PostScript fonts now reside on your AIX system, preflight
another PostScript job from Infoprint Submit that references the fonts that had
been inline. If the PostScript interpreter can find and load these fonts
successfully (without font substitution messages displaying on the Infoprint
Submit shared ticket directory or in the ps2afpd.log file), the process works
correctly.

Note: You should never modify either the FontSave.wrk or the FontSave.bak files

because it can affect the path to the Adobe Type I fonts that now reside on
AIX.
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Deactivating the FontSave utility
Because the FontSave utility can degrade performance when running large

PostScript jobs, you might want to deactivate it after saving the most commonly
used inline fonts.

To deactivate the FontSave utility so that new inline fonts are not saved, but the
fonts you have already saved as Adobe Type I are still used, do the following:

1. From the desktop Text Editor, search the /usr/lpp/psf/workd directory for the
daemon file, where daemon refers to either the ps2afpd.cfg file or the 3160d.cfg
file.

2. From within the daemon file, disable the input exit by placing a # in front of the
following line:

input_exit = /usr/lpp/psf/bin/fontsave

The PostScript transform automatically detects these changes after they have
been saved to the file.

To deactivate the FontSave utility so that inline fonts are not saved and previously
saved inline fonts are no longer used, remove the input exit and change the
following lines in both the ps2afpd.cfg file and the 3160d.cfg file:

ps_font_map_files = /usr/1pp/psf/ps/psfonts.map :\
/var/psf/psfonts/user.map
# /var/psf/ps2afp/FontSave.map

You can always reactivate the FontSave utility by changing these files back.

Note: Always verify your changes by preflighting a PostScript job from the
Infoprint Submit system (use the -a NONE option when printing). If the job
runs with the fonts expected, you know that the changes were saved
successfully.

Transforming pfb fonts to pfa fonts for use with Adobe
Acrobat Distiller

The following procedure allows you to transform a binary PostScript font (one
with a .pfb final qualifier) into an ASCII PostScript font (one with a .pfa final
qualifier) for use with the Adobe Acrobat Distiller. While the Adobe PostScript RIP
(ps2afp) can run with both binary and ASCII fonts, the Adobe Acrobat Distiller
requires ASCII fonts. You can perform this task from Infoprint Manager and
transform any valid Type 1 PostScript font file.

1. Move to the directory where the .pfb font resides by specifying:

cd /usr/1pp/psf/fonts/apl

where /usr/lpp/psf/fonts/apl represents the directory where your fonts are stored.

2. Use the makepfa utility to transform a binary font (such as APLB.PFB) into an
ASCII font (such as CourierAPL2-Bold) by specifying:

makepfa /usr/1pp/psf/ps/fonts/ap1/APLB.PFB
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3. When you receive an AIX command-line prompt, view the directory contents to
see the file that you just created by specifying:

Ts -al
The system should return a display similar to the following;:

-r--r--r-- 1 root printq 50318 Jul 29 20:13 APL.PFB

-rw-r--r-- 1 root system 95602 Jul 31 13:45 CourierAPL2-Bold

Note: If you attempt to transform a font file that is not Type 1 PostScript format,
you will receive the following message:

0423-026 mkfntmap: The file /t is not a valid Type 1 PostScript
font file and has been ignored.

Fonts for printing ditroff data
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This section describes the files that Infoprint provides for printing ditroff files on
AFP printer devices and the directories in which they reside.

AFP code pages for AFP fonts

Infoprint supplies the following three code pages for use with the AFP fonts for
ditroff. These code pages map the existing characters in troff files to their
corresponding AFP characters in the AFP character sets.
T1001038

Adobe Symbols (ASCII)
T1001108

ditroff Base Compatibility
T1001109

ditroff Specials Compatibility

When you install Infoprint, both the 240-pel and 300-pel code page files are
automatically installed in the /usr/lpp/psf/fontlib directory.

Note: If you transform a file for printing that requires fonts on a font cartridge
and the printer device does not have the font cartridge installed that
supports the fonts specified in the /usr/lib/font/devhplj directory, your file
may not print correctly. Refer to your printer documentation to install
bit-mapped fonts into the /usr/lib/font/devhplj directory.

AFP characters mapped to ditroff characters

Infoprint supplies AFP character sets in raster format. The character sets, which
map to corresponding ditroff fonts, are listed in the devafp.fontmap file located in
the /usr/lib/font/devafp directory. The character sets themselves are installed in the
lusr/lpp/psf/fontlib directory.

Infoprint supplies AFP character sets for the following troff type families: B, BI, C,
CB, CI, CBI, H, HB, HI, HBL, [, R, SG, and SS.

The following character list provides a mapping from the ditroff names of
characters to the IBM graphics character identifier. The “IBM Graphic Character
Identifier” column can be used to view the printed character as printed in a code
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page table. The “ditroff Name of Character” column can be used to print any of

these characters by typing it into a text file as a special character that is processed

by troff.

Mapping for code pages T1001038, T1001108, and T1001109
Table 11. Mapping for code pages T1001038, T1001108, and T1001109

IBM Graphic Character

Identifier ditroff Name of Character | Character Description
GA010000 *a alpha
GA020000 *A capital Alpha
GB010000 *b beta

GB020000 *B capital Beta
GD010000 *d delta
GD020000 *D capital Delta
GE010000 *e epsilon
GE020000 *E capital Epsilon
GE310000 *y eta

GE320000 *Y capital Eta
GF010000 *f phi

GF020000 *F capital Phi
GG010000 *g gamma
GG020000 *G capital Gamma
GHO010000 *X chi

GH020000 *X capital Chi
GI1010000 *i iota

GI1020000 *1 capital Iota
GK010000 *k kappa
GK020000 *K capital Kappa
GL010000 *1 lambda
GL020000 *L capital Lambda
GM010000 *m mu

GM020000 *M capital Mu
GN010000 *n nu

GNO020000 *N capital Nu
G0O010000 *o omicron
G0020000 *O capital Omicron
G0O310000 *w omega
G0320000 *W capital Omega
GP010000 *p pi

GP020000 *P capital Pi
GP610000 *q psi

GP620000 *Q capital Psi
GR010000 *r rho

Chapter 6. Working with fonts

49



50

Table 11. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character

Identifier ditroff Name of Character | Character Description
GR020000 *R capital Rho
GS010000 *s sigma
GS020000 *S capital Sigma
GS610000 ts terminal sigma
GT010000 *t tau
GT020000 *T capital Tau
GT610002 *h theta
GT620000 *H capital Theta
GU010000 *u upsilon
GU020000 *U capital Upsilon
GX010000 *c xi

GX020000 *C capital Xi
GZ010000 *z zeta
GZ020000 *Z capital Zeta
LA010000 a a

LA020000 A A

LB010000 b b

LB020000 B B

LC010000 C c

L.C020000 C C

LD010000 d d

LD020000 D D

LE010000 e e

LE020000 E E

LF010000 f f

LF020000 F F

LF510000 ff ff ligature
LF530000 fi fi ligature
LF550000 fl fl ligature
LF570000 Fi ffi ligature
LF590000 F1 ffl ligature
LG010000 g g

LG020000 G G

LH010000 h h

LH020000 H H

L1010000 i i

L1020000 I I

LJ010000 j j

LJ020000 J J
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Table 11. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character

Identifier ditroff Name of Character | Character Description
LK010000 k k
LK020000 K K
LL010000 1 1
LL020000 L L
LM010000 m m
LM020000 M M
LN010000 n n
LN020000 N N
LO010000 o o
L0O020000 (0] (@)
LP010000 p P
LP020000 P P
LQ010000 q q
LQ020000 Q Q
LR010000 r r
LR020000 R R
LS010000 s

LS020000 S S
LT010000 t t
LT020000 T T
LU010000 u u
LU020000 U U
LV010000 v v
LV020000 A\ \%
LW010000 w w
LW020000 W W
LX010000 X X
LX020000 X X
LY010000 y y
LY020000 Y Y
LZ010000 z z
LZ020000 V4 Z
ND010000 1 one
ND020000 2 two
ND030000 3 three
ND040000 4 four
ND050000 5 five
ND060000 6 six
ND070000 7 seven
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Table 11. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier

ditroff Name of Character

Character Description

ND080000 8 eight

ND090000 9 nine

ND100000 0 Zero

NF010000 12 1/2

NF040000 14 1/4

NF050000 34 3/4

NF180000 18 1/8

NF190000 38 3/8

NF200000 58 5/8

SA000000 \- minus

SA000000 mi minus

SA010000 + plus sign

SA010000 pl math plus

SA020000 +- plus or minus
SA030000 < less than sign
SA040000 = equal sign
SA040000 eq equal sign
SA050000 > greater than sign
SA060000 di divide sign
SA070000 mu multiplication sign
SA160000 ap approximates
SA240000 ib improper subset
SA270000 ip improper superset
SA380000 ca intersection
SA390000 cu union

SA400000 sb subset

SA410000 sp superset

SA450000 if infinity

SA470000 pt proportional to symbol
SA480000 == identity

SA490000 pd partial differential symbol
SA510000 is integral symbol
SA520000 <= less than or equal
SA530000 >= greater than or equal
SA540000 = not equal

SA670000 mo element of
SA700000 ~= approximately equal
SA800000 st square root
SA870000 es empty set
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Table 11. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier

ditroff Name of Character

Character Description

SC030000 $ dollar sign

S5C040000 ct cent sign

SD110000 ! acute accent

SD110000 aa acute accent

SD130000 ) grave accent

SD130000 ga grave accent

SD150000 A circumflex accent
SD190000 ~ tilde accent

SD410000 cd cedilla accent

SF640000 br box rule

SA860000 m root extender

SV300600 ul underrule

SV300200 ru rule

SG050000 1c left ceiling

SG060000 1f left floor

SG070000 rc right ceiling

SG080000 rf right floor

$G090000 1t upper left curly bracket
SG100000 1k left middle curly bracket
SG110000 1b lower left curly bracket
SG120000 rt upper right curly bracket
SG130000 rk right middle curly bracket
SG140000 b lower right curly bracket
SG170000 bv vertical bold

SL030000 gr gradient

SM010000 # number sign

SM020000 % percent sign

SM030000 & ampersand

SM040000 * asterisk

SM 040002 ** math star

SM050000 @ at

SM060000 [ left bracket

SM070000 \ backslash

SM070000 \e backslash

SM080000 ] right bracket

SM110000 { left brace

SM130000 or or bar

SM130000 | or bar

SM140000 } right brace
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Table 11. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character

Identifier ditroff Name of Character | Character Description

SM190000 de degree

SM240000 sc section

SM300000 <- left arrow

SM310000 -> right arrow

SM320000 ua up arrow

SM330000 da down arrow

SM340000 dg dagger

SM350000 dd double dagger

SM450000 sq open square

SM470000 bx solid square, histogram,
square bullet, filled box

SM520000 co copyright

SM530000 rg registered

SM540000 tm trade mark

SM570000 bu bullet

SM590000 rh right hand

SM630000 1h left hand

SM660000 no logical not

SM750000 ci circle

SM900000 em em dash

SP020000 ! exclamation point

SP040000 " double quote

SP050000 fm foot mark (minutes symbol)

SP060000 ( left paren

SP070000 ) right paren

SP080000 , comma

SP090000 \_ underscore

SP090000 _ underscore

SP100000 hy hyphen

SP110000 period

SP120000 / slash

SP120001 sl fraction

SP130000 colon

SP140000 ; semicolon

SP150000 ? question mark

SP190000 \* open quote

SP200000 \’ close quote

$S000000 bs smiley face

S$S680000 - dash, minus sign (en dash)
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Table 11. Mapping for code pages T1001038, T1001108, and T1001109 (continued)

IBM Graphic Character
Identifier

ditroff Name of Character

Character Description

$5680000

en

dash, minus sign (en dash)

Special symbols added for code page T1001038

The following non-standard special symbols were added:

Table 12. Special symbols added for code page T1001038

IBM Graphic Character
Identifier

ditroff Name of Character

Character Description

SA370000 tf therefore, math and proof
symbols

$5020000 ht heart

$5030000 dm diamond

$5040000 cl club

$5050000 sd spade

Special symbols added for code page T1001108

The following non-standard special symbols were added:

Table 13. Special symbols added for code page T1001108

IBM Graphic Character

Identifier ditroff Name of Character | Character Description
SM?790000 hs house character
ND011000 sl One superscript
ND021000 s2 Two superscript
ND031000 s3 Three superscript
ND041000 s4 Four superscript
ND051000 s5 Five superscript
ND061000 s6 Six superscript
ND071000 s7 Seven superscript
ND081000 s8 Eight superscript
ND091000 s9 Nine superscript
ND101000 s0 Zero superscript

Special symbol added for code page T1001109

The following non-standard special symbol was added:

Table 14. Special symbol added for code page T1001109

IBM Graphic Character
Identifier

ditroff Name of Character

Character Description

SV300400

ol

overrule
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Adding other troff fonts

Infoprint provides AFP fonts that map to existing troff fonts in the Courier,
Helvetica, and Times type families and AFP fonts for special characters. The
font-mapping table contained in the devafp.fontmap file maps the AFP fonts to the
corresponding troff fonts.

If you want to add troff fonts or special characters, contact your IBM Printing
Systems representative.

ditroff font files

Infoprint installs other files for ditroff in the /ust/lib/font/devafp directory,
including the following:

devafp.fontmap
File that maps ditroff fonts to AFP fonts.

*.d2afp
Special versions of the ditroff font descriptions. The d2afp command uses
these files.

DESC (no extension)
troff device description, ASCII version.

DESC.out
troff device description, binary version.

*.out troff font descriptions, binary version.

Fonts for printing DBCS ASCII and EUC data

56

In ideographic languages, like Japanese, Chinese, and Korean, there are thousands
of characters. A single byte of information cannot represent all of these characters
because a single byte only accommodates 256 characters. Therefore, at least one
more byte of information is required.

For DBCS ASCII files, each ideographic character is exactly two bytes. For
Extended UNIX Code (EUC) files, each ideographic character may be two, three, or
four bytes, depending on the EUC implementation and language. Single-byte
ASCII characters may be mixed in with DBCS ASCII and EUC characters.

Infoprint supports printing DBCS ASCII and EUC files in the following formats:

¢ DBCS ASCII files in the Japanese and Traditional Chinese languages, which can
contain formatting controls for the IBM 5577 or 5587 printers.

* EUC files in the Japanese, Traditional Chinese, and Korean languages. EUC files
cannot contain any formatting control characters.

Fonts required to print a double-byte transformed file

You can use the db2afp transform command to transform input files that use the
following code pages:

* Japanese PC (code page IBM-932)

* Japanese EUC (code page IBM-euc]P)

¢ Traditional Chinese PC (code page IBM-938)

* Traditional Chinese EUC (code page IBM-eucTW)

* Korean EUC (code page IBM-ecuKR)
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The transformed files contain font references to the double-byte character set. You
set the character set, code page, you want by setting the PSFDBLANG
environment variable.

After you have used the db2afp command to transform DBCS ASCII and EUC files
into AFP data stream files, you must have access to DBCS fonts when you print
the transformed files. The DBCS fonts for Japanese, Traditional Chinese, and
Korean are not part of Infoprint but are available for the MVS, VM, and AIX
operating systems as separately orderable licensed programs.

Installing DBCS fonts on AIX

To make the fonts available on your system and to Infoprint, once you have the
licensed programs, you must do one of the following:

* Use the AIX licensed programs to install the fonts onto your AIX system.

* Use the AIX licensed programs to install the fonts onto a AIX system other than
yours and use the Network File System (NFS) mount command to mount the
AIX file system onto your AIX system.

* Use the NFS mount command to mount the MVS or VM minidisk to your AIX
system.

Setting up font resources for DBCS ASCII and EUC printing

To print the transformed files that contain font references to the double-byte
character set, you must make the double-byte fonts known to Infoprint through
one of the following methods:

* Create a resource-context object that identifies the location of the double-byte
fonts and associate the resource-context object with a default-document object
and an Infoprint logical printer. Using this method makes the fonts known to
Infoprint for any job submitted to the logical printer associated with the
default-document object.

* Add the directories to the search path for physical printers using the Infoprint
Manager Administration GUI Printer Properties notebook. In the AFP Resources
tab, enter the directory path in the Location of fonts field. Using this method
makes the fonts known to Infoprint for any job processed by those physical
printers.

* Set and export the PSFPATH environment variable to your environment by
entering the following command:
export PSFPATH=$PSFPATH:pathl:path2:pathN

Using this method makes the fonts known to Infoprint for all print jobs
submitted from the AIXwindows or High Function Terminal session in which
the PSFPATH environment variable was set.

* Set and export the PSFPATH environment variable in your .profile file (Korn
and Bourne shells) or .cshrc file (C shells) by adding the following line to the
file:
export PSFPATH=$PSFPATH:pathl:path2:pathN

Using this method makes the fonts known to Infoprint for any job you submit.

* Set the PSFPATH environment variable in the /etc/environment file by adding
the following line to the file:

PSFPATH=pathl:path2:pathN
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Using this method makes the fonts known to Infoprint for all users on the
system.

Fonts for printing line data

When you specify a coded font name with the chars keyword of the line2afp
command or with the chars document attribute, the font name is limited to four
characters, excluding the two-character prefix.

provides a list of the IBM Expanded Core Fonts for use with unformatted
ASCII input data. Because these fonts have eight-character names, the table also
provides a list of six-character short names. Infoprint stores these coded fonts in
the /ust/lpp/psf/reslib directory. There are symbolic links of the eight-character
names that correspond to the six-character names. You may use these short names,
without the X0 prefix, to satisfy the four-character limitation for specifying font
names with the chars keyword of the line2afp command.

For the names of other coded fonts, refer to IBM AFP Fonts: Font Summary.

Table 15. Font mapping table for use with the chars keyword

Linked Short Name

Type Family Point Size | Coded Font Name (for chars keyword)
Courier 7 | X0423072 X04272
Courier 8 | X0423082 X04282
Courier 10 | X0423002 X04202
Courier 12 | X04230B2 X042B2
Courier 14 | X04230D2 X042D2
Courier 20| X04230J2 X042j2
Helvetica 6 | X0H23062 X0H262
Helvetica 7| X0H23072 X0H272
Helvetica 8 | X0H23082 X0H282
Helvetica 9 | X0H23092 X0H292
Helvetica 10 | X0H23002 X0H202
Helvetica 11 | X0OH230A2 XO0H2A2
Helvetica 12 | X0H230B2 X0H2B2
Helvetica 14 | X0H230D2 X0H2D2
Helvetica 16 | XOH230F2 X0H2F2
Helvetica 18 | X0H230H2 X0H2H2
Helvetica 20| X0H230J2 X0H2J2
Helvetica 24 | X0H230N2 X0H2N2
Helvetica 30| X0H230T2 X0H2T2
Helvetica 36 | X0H230Z2 X0H2Z2
Times New Roman 6 | XON23062 XO0N262
Times New Roman 7 | XON23072 X0N272
Times New Roman 8 | XON23082 XO0N282
Times New Roman 9 | XON23092 X0N292
Times New Roman 10 | XON23002 XO0N202
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Table 15. Font mapping table for use with the chars keyword (continued)

Linked Short Name
Type Family Point Size | Coded Font Name (for chars keyword)
Times New Roman 11 | XON230A2 XO0N2A2
Times New Roman 12 | XON230B2 XO0N2B2
Times New Roman 14 | XON230D2 X0N2D2
Times New Roman 16 | XON230F2 XON2F2
Times New Roman 18 | XON230H2 XO0N2H2
Times New Roman 20| X0N230J2 XO0N2J2
Times New Roman 24 | XON230N2 XO0N2N2
Times New Roman 30| XO0N230T2 XO0N2T2
Times New Roman 36 | XON230Z2 XO0N2Z2

Installing the Japanese PostScript font feature

You can install Japanese PostScript fonts on your Infoprint Manager server to print
documents requiring these specialized fonts.

To enable your Infoprint Manager server to support Japanese PostScript fonts, use
the Infoprint installer located on the Infoprint Manager CD-ROM. You will be
prompted to supply your customer ID as well as the access key located on the
invoice that was shipped with your CD.

Obtaining the Japanese PostScript fonts on your Windows
workstation

These instructions presume that you have already installed Infoprint Select on your

Windows NT workstation. Use this procedure to obtain access to the Japanese

PostScript fonts that reside on your Infoprint AIX server for printing from the

Infoprint Select client on your Windows workstation.

1. From the IBM Printing Systems Japanese home page on the web
(http://www-6.ibm.com/jp/printer/), select the Workgroup printer driver
download page.

2. From the Workgroup printer driver download page, download the appropriate
Japanese PostScript system driver.

Select the PostScript driver that corresponds to your Windows client system.
For example, you should select the driver for either the Windows 98, Windows
NT, or Windows 2000 system.

3. Once the file has been downloaded to your hard drive, open a DOS window
and begin the install process.

4. During installation of the driver, select the Infoprint 70 PS option.

The current version of this driver supports the five Morisawa fonts from
Infoprint AIX Japanese PostScript font feature.

Note: The Japanese Infoprint 70 PostScript driver is not owned by Infoprint

Manager for AIX and may be modified in a manner that could alter or
remove support for this capability.
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Chapter 7. Using global resource identifiers

Infoprint can identify the fonts required for a job, access AFP font files that are
installed on or NFS-mounted to the RS/6000, and download the appropriate fonts
to an Infoprint-managed printer device. However, some Infoprint printers can use
fonts that are resident in the printer, saving the time it takes to download these
fonts. Because the font files on the RS/6000 do not share the same names as the
printer-resident fonts, Infoprint uses global resource identifiers (GRIDs) to map the
RS/6000-resident fonts to the printer-resident fonts. Use the information in this
chapter to work with GRIDs.

How can you use GRIDs?

GRID files contain pre-assigned mappings that you can modify to map
RS/6000-resident font file names to printer-resident font identifiers. These
pre-assigned mappings include both single-byte character set (SBCS) and
double-byte characters set (DBCS) outline fonts.

If you have a printer that supports outline fonts, you can use the GRID files to
map raster character-set names to outline font global identifiers.

A third use of GRID files is to support Mixed Object Document Content
Architecture for Presentation (MO:DCA-P) files that specify fonts using GRIDs
rather than character-set names. You can customize the GRID files to define which
fonts Infoprint uses when the data stream of the job specifies GRIDs.

Note: If a data stream specifies only GRID parts instead of specific names, then the
fgid.grd table is used to find the name of the font to download or the
outline font to activate. In this case, the data stream must specify a specific
width value.

What GRID files ship with Infoprint?

Infoprint ships four GRID files that you can customize for use with the types of
printer devices that you use and the types of jobs that you print. These files are
charset.grd.sample, codepage.grd.sample, cpgid.grd.sample, and fgid.grd.sample,
and they are installed in the /ust/lpp/psf/grd directory.

Note: You can either shut down and restart the Infoprint server (pdserver process)
or shut down and restart all your printers to ensure that .grd file changes
are applied.

The following describes each file:

charset.grd.sample
Specifies which printer-resident fonts are activated for the character-set names
found within the data stream of the job.

This file maps the font character-set name to a:

* Font global identifier (fgid)

* Graphic character set global identifier (gcsgid)

* Font width

* Vertical size value

* Set of font attributes (bold, italic, and doublewide)
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shows an example of the format of a line in the character set sample
file.

# FCS name -> fgid gcsgid width vsize attr #
R e R L L #
COLOOGSC 398 - 96 120 - # GOTHIC CONDENSED 1

Figure 11. Sample file for a character set

codepage.grd.sample
Specifies which printer-resident fonts are activated for the code page names
found within the data stream of the job.

This file maps a code page to the:
* Code page global identifier (cpgid)
* Graphic character set global identifier (gcsgid)

shows an example of the format of a line in the code page sample
file.

# code page name -> cpgid gcsgid #
e #
T1000038 38 123 # US-ASCII Character Set 1

Figure 12. Sample file for a code page

fgid.grd.sample
Specifies which font character set Infoprint should download when
substituting for a global resource identifier that it finds in the data stream of
the job.

This file maps the following to a font character set (FCS) name:
* A font global identifier (fgid)

* A graphic character set global identifier (gcsgid)

* A font width

* A vertical size value

shows an example of the format of a line in the font global identifier
sample file.

# fgid gcsgid width  vsize -> FCS name #
e L L L P #
3 0 144 240  COEODE1O # DELEGATE 12 POINT 1

Figure 13. Sample file for a global identifier
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cpgid.grd.sample
Specifies which code page Infoprint should download when substituting for a
global resource identifier that it finds in the data stream of the job.

This file maps a code page global identifier and a graphic character set global
identifier to a code page name. shows an example of the format of a
line in the code page identifier sample file.

# cpgid gcsgid -> code page name #
T et e L EEE P #
29 0 T1V10871 # OLD ICELANDIC 1

Figure 14. Sample file for a code page identifier

For a detailed explanation of how the different types of identifiers combine to
produce fonts, see AFP Fonts: Font Summary

If you have a job that specifies a font that is not resident on your printer, you can
use the GRID files to map the missing font to one with the same point size that
does reside on your printer. To understand what fonts your printer device has,
consult both your printer documentation and Advanced Function Presentation: Printer
Information.

Where does Infoprint search for GRID files?

Infoprint searches the following directories, in the order shown, for GRID files:

1. An internal list that matches the charset.grd.sample file.

2. [usr/lpp/pst/grd

3. [var/pst/printername, where PrinterName is the name of a valid Infoprint
physical printer.

Note: When the same mapping is found in one of these files, Infoprint uses the
last one (/var/psf/ PrinterName).

When you install Infoprint, sample GRID files are installed in the /usr/lpp/psf/grd
directory. You can maintain a central location for new or modified GRID files for
specific printers by storing files in the /var/psf/PrinterName directory.

If you are mapping raster fonts to outline fonts, you can map multiple names to
the same GRID part so that different sized fonts can apply to your print job.

Notes:

1. The new or modified GRID files you create have the same names as the sample
files except that you delete .sample from each file name.

2. After creating or modifying GRID files, you must shut down and restart the
Infoprint physical printer represented by PrinterName for the changes in the file
to take effect.

Understanding the general syntax rules and allowable values for GRID
files

To tailor the Infoprint-supplied GRID files for your own system needs, you need to
understand the general syntax rules for the four GRID files and the allowable
values for the fields within the files.
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Syntax rules applying to all types of GRID files

The GRID files are simple ASCII text files that you can modify through any
standard AIX text editor. The following rules apply to all of the GRID files:

e Each line in the file cannot contain more than 255 characters
* Separate fields within a line with one or more delimiters (spaces)

* A pound sign (#) indicates the start of comments, which causes Infoprint to
ignore the remainder of that line

* A dash, —, indicates the absence of a particular value, for which Infoprint
substitutes a zero (0)

* An asterisk, * , indicates that a wildcard value (any numeric decimal) is
accepted.

* Infoprint ignores blank lines and extraneous fields

Allowable values for the charset.grd file

You can specify the following values for fields in the GRID file for a character set
for a font:
fgid

Identifies the character set identifier for the font. Specify a numeric value from

1 to 65534 or enter a dash, —, if you want to disable the mapping of this
character set to GRID values.

gesgid
Identifies a global identifier for the font. Specify a numeric value from 0 to
65534 or enter a dash, —, to specify no gesgid. If you specify an asterisk,
Infoprint issues an error message.

width
Identifies the width specified in the character set. Specify a numeric value from
0 to 32767 or enter a dash, —, to specify no width. If you specify an asterisk,
Infoprint issues an error message.

vertical_size
Identifies the vertical size specified in the character set. Specify a numeric
value from 0 to 32767 or enter a dash, —, to specify no vertical size. If you
specify an asterisk, Infoprint issues an error message.

attribute_field
Indicates the attributes of the character set. Specify a lowercase b (bold), i
(italic), d (doublewide), or enter a dash, —, to specify no attribute.

Allowable values for the codepage.grd file

You can specify the following values for fields in the GRID file for a code page for
a font:

cpgid
Identifies the code page identifier for the font. Specify a numeric value from 1
to 65534 or enter a dash, —, if you want to disable the mapping of this
character set to GRID values.

gesgid
Identifies a global identifier for the code page. Specify a numeric value from 0
to 65534 or enter a dash, —, to specify no gesgid. If you specify an asterisk,
Infoprint issues an error message.
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Allowable values for the fgid.grd file

You can specify the following values for fields in the GRID file for a font global
identifier:

fgid
Identifies the global identifier for the font. Specify a numeric value from 1 to
65534.0r enter an asterisk, * , to indicate a wildcard value. If you specify a
dash, Infoprint issues an error message.

gesgid
Identifies the global identifier for the font. Specify a numeric value from 0 to
65534 or enter an asterisk, * , to indicate a wildcard value. If you specify a
dash, Infoprint issues an error message.

width
Identifies the number of characters per horizontal inch. Specify a numeric
value from 1 to 32767 or enter an asterisk, * , to indicate a wildcard value. If
you specify a dash, Infoprint issues an error message.

vertical_size
Identifies the vertical size of the font. Specify a numeric value from 1 to 32767
or enter an asterisk, * , to indicate a wildcard value. If you specify a dash,
Infoprint issues an error message.

Allowable values for the cpgid.grd file

You can specify the following values for fields in the GRID file for a code page
global identifier:

cpgid
Identifies code page identifier for the font. Specify a numeric value from 1 to
65534.

gesgid
Identifies the global identifier for the font. Specify a numeric value from 0 to
65534 or enter an asterisk, * , to indicate a wildcard value. If you specify a
dash, Infoprint issues an error message.

Modifying GRID files

The following section describes the two ways you can modify GRID files to
support the printer devices and types of jobs in your production printing
environment.

Note: If you are using Infoprint to print from the IBM 6400 Line Matrix printer in
either native or 4234 emulation mode, you must modify both the
charset.64xx.grd and the codepage.64xx.grd files as described in |”Modifvina
the charset and codepage GRID files”|and [“Modifying the FGID and CPGID|
GRID files” on page 67}

Modifying the charset and codepage GRID files

You can avoid having Infoprint download fonts by adding font entries that map
the font character set or code page that is most referenced in jobs to a global
identifier for a resident font.

For example, if many of your jobs specify the Prestige 10-point font, which is

character set COSOPR10, and that font is not resident on your IBM 3812 printer
diskette, you can map the Prestige 10-point font to a similar font that does reside
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on your IBM 3812 printer diskette. In the following procedure, you map the Gothic
10-point font, character set CODOGT10, that is a printer-resident font to the Prestige
10-point font.

Perform the following steps:

1.

6.

From the AIX command line, change to the /var/psf/PrinterName directory,
where PrinterName is the name of the Infoprint physical printer representing
the 3812 printer device.

Create the charset.grd file from the charset.grd.sample file. Enter the command:
cp /usr/1pp/psf/grd/charset.grd.sample charset.grd

Using an AIX editor, such as vi, edit the charset.grd file you just created and
copy the following line for the Gothic 10-point printer-resident font:

CODOGT10 40 - 144 240 # GOTHIC TEXT 10

Change the first entry in the copied line, in the FCS name column, to the
character set identifier of the Prestige 10-point font that you want to map to the
Gothic 10-point font. You can change the comment at the end of the copied line
to identify the mapping change you are making.

COSOPR1O 40 - 144 240 # PRESTIGE 10 mapped to GOTHIC TEXT 10

Search the remainder of the charset.grd file to ensure that it contains no other
COSOPR10 entries. A later entry of the same character set would replace the
entry you just made.

Save your changes and close the file.

If you print many jobs that specify the personal computer ASCII codepage for
Iceland, T1000861, but that codepage is not resident on your printer diskette, you
can map codepage T1000861 to a similar codepage that does reside on your printer
diskette, the personal computer multilingual codepage for ASCII data, T1000850.

Perform the following steps:

1.

From the AIX command line, change to the /var/psf/PrinterName directory,
where PrinterName is the name of the Infoprint physical printer representing
the printer device.

Create the codepage.grd file from the codepage.grd.sample file. Enter the
command:

cp /usr/1pp/psf/grd/codepage.grd.sample codepage.grd

Using an AIX editor, such as vi, edit the codepage.grd file you just created and
copy the following line for the personal computer multilingual codepage for
ASCII data:

T1000850 850 980 # PC MULTILINGUAL

Change the first entry in the copied line, in the code page name column, to the
codepage identifier of the personal computer ASCII codepage for Iceland font
that you want to map to the multilingual codepage. You can change the
comment at the end of the copied line to identify the mapping change you are
making.

T1000860 850 980 # ICELAND MAPPED TO MULTILINGUAL

Search the remainder of the codepage.grd file to ensure that it contains no
other T1000860 entries. A later entry of the same character set would replace
the entry you just made.

Save your changes and close the file.
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Modifying the FGID and CPGID GRID files

You can add new entries to map your GRID data to the resident fonts in your
printer by modifying either the fgid.grd.sample file or the cpgid.grd.sample file. If
you have a printer that does not support the outline font technology (such as the
IBM 3835 Advanced Function Printer), IBM recommends that you map all the
CZnnnn entries to raster font character-set names. If you do not create this
mapping, Infoprint issues an error message and does not print the job.

For example, if you wanted to map the Times New Roman Latin 1 character set to
the raster version, you would perform the following:

1. From the AIX command line, change to the /var/psf/PrinterName directory,
where PrinterName is the name of the Infoprint physical printer representing
the printer device.

2. Create the fgid.grd file from the fgid.grd.sample file. Enter the command:
cp /usr/1pp/psf/grd/fgid.grd.sample fgid.grd
3. Using an AIX editor, edit the file that you just created and copy the following
line:
2308 2039 = x  CZN200 # Times New Roman Latinl
4. Change the entry in the FCS name column to CON20000.
2308 2039 * +  CON20000 # Raster version of TNR Latin 1
5. Save your changes and close the file.

After this substitution, Infoprint prints jobs that specify the font character-set name
CZN200 and that processed on the physical printer for which you made the change
using the raster version of the font. The CZN200 character set now maps to:

* An FGID of 2308

* A GCSGID of 2039

* A vertical size of 65535

¢ A width of 0

Note: For more information about the different values available for font character
sets and code pages, see "IBM Font Interchange Information” in IBM Data
Stream and Object Architectures Mixed Object Document Content Architecture
Reference.

Because the IBM 3835 Advanced Function Printer does not support any resident
outline fonts, the fgid.grd.sample file maps the FGID and the GCSGID back to
the CON20000 character set. Then, Infoprint searches the resource library search path
to locate the CON20000 character for downloading with the job.

To modify the cpgid file so that the personal computer ASCII codepage for Iceland
maps to the multilingual codepage for ASCII data as described in [“Modifying the

Icharset and codepage GRID files” on page 65} perform the following steps:

1. From the AIX command line, change to the /var/psf/PrinterName directory,
where PrinterName is the name of the Infoprint physical printer representing
the printer device.

2. Create the cpgid.grd file from the cpgid.grd.sample file. Enter the command:
cp /usr/1pp/psf/grd/cpgid.grd.sample cpgid.grd

3. Using an AIX editor, such as vi, edit the cpgid.grd file you just created and
copy the following line for the personal computer multilingual codepage for
ASCII data:

850 980 T1000850 # PC MULTILINGUAL
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4. Change the first entry in the copied line, in the cpgid column, to the codepage
identifier of the personal computer ASCII codepage for Iceland font that you
want to map to the multilingual codepage. You can change the comment at the
end of the copied line to identify the mapping change you are making.

861 980 T1000850 # ICELAND MAPPED TO MULTILINGUAL

5. Search the remainder of the cpgid.grd file to ensure that it contains no other
861 entries. A later entry of the same character set would replace the entry you
just made.

6. Save your changes and close the file.

Verifying the GRID files

During physical printer initialization, Infoprint examines the contents of the GRID
files. If Infoprint detects any syntax errors, it reports an error condition and fails to
enable the physical printer. To correct these errors, you must edit the failing GRID
files. For information on what files, lines, or fields are in error, you must access the
GRID error.log file for the physical printer that is located in /var/psf/PrinterName.

Preventing Infoprint from using GRID files

68

If you have obtained a 300-pel printer but print 240-pel jobs, the printer-resident
fonts may have different line spacings and endings in the printed output. For some
types of billing statements, these line endings are inappropriate. You can solve this
problem by preventing Infoprint from using the GRID files. This prevents the use
of the printer-resident fonts. Perform the following procedure:

1. Using the AIX mv command, rename your customized GRID files. For example,
if you are in the /var/psf/PrinterName directory and you want to rename the
charset.grd to charset.grd.bak, enter:

mv charset.grd charset.grd.bak

2. Copy the /usr/lpp/pst/grd/charset.grd.sample file to charset.grd in the
Ivar/psf/PrinterName directory.

3. Using an AIX editor, such as vi, edit the copied charset.grd file and place a
dash (-) in the fgid column.

4. Copy the /usr/lpp/psf/grd/codepage.grd.sample file to codepage.grd in the
[var/psf/PrinterName directory.

5. Edit the copied codepage.grd file and place a dash (-) in the cpgid column.
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Chapter 8. Configuring and using cut-sheet emulation

To enable cut-sheet emulation, ensure that your printer has a microcode level of at
least 9.216, then ensure that the appropriate personnel perform the following tasks
at your installation on the systems specified:

1. At the Infoprint AIX server, the print administrator for your installation must
disable the physical printer that you intend to run in cut sheet emulation mode.

2. At the printer console, an operator must set the printer to cut-sheet emulation
mode.

3. The operator must then restart the printer.

4. At the Infoprint AIX server, the print administrator must create a logical printer
for the physical printer.

5. The print administrator must ensure that both the logical and physical printer
has been enabled.

To submit a job, see "Using Cut Sheet Emulation.”

Using cut sheet emulation

Job submitters must specify a form definition that will print using cut sheet
emulation through the following application programming interfaces:

+ [Using Infoprint Submit]

+ |Using the PSF Physical Printer Properties notebook]

* [Using the pdpr command|

Before using any of these interfaces, ensure that you are aware of this support’s
[Defaults and limitations of cut sheet emulation support

Using Infoprint Submit

From the Layout tab of the Infoprint Submit Job Ticket window, you can leave the
Use form definition field blank to get the default form definition on the Infoprint
AIX server, or specify a specific form definition.

By using the default form definition, cut sheet emulation will be invoked.

Note: Infoprint Submit is part of the Print-on-Demand feature that is a separately
orderable feature.

Using the PSF physical printer properties notebook

1. From the Infoprint Administration servername window, use the middle mouse
button to drag the printer notebook action icon onto the Actual Destination
(printer) that you want to use for cut-sheet emulation.

2. From the View and Change PSF Physical Printer Properties window, select the
Customization tab.

3. Specify the form definition of choice in the form definition field.
4. Click OK or Apply to ensure that this form definition is applied.
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Using the pdpr command

The form-definition document, default document, or actual destination attributes
on the pdpr command also change the form definition on a printer.

For specific examples of how to modify these values on the printer, refer to the
IBM Infoprint Manager: Reference.

Defaults and limitations of cut sheet emulation support

When a form definition is explicitly named, any attribute found in both the form
definition and either the Infoprint Manager graphical user interface or the pdpr
command reverts to the value specified in the form definition.

Note that corresponding values specified on the printer-pass-through (or
destination-pass-through) attribute override the values specified in either the PSF
Resource tab of the PSF printer notebook or the form-definition document, default
document, or actual destination attribute.

If you use a form definition that contains a medium map using N_UP commands,
the printer will go out of cut sheet emulation mode while processing that N_UP
command. If the N_UP processing ends, the printer will return to cut sheet
emulation mode. This scenario can occur when printing a large image in the
middle of a job.
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Chapter 9. Generating and submitting color mapping table
source and output files

A color mapping table is a printer resource object that defines a translation from
certain MO:DCA structured fields to new color structured fields used by newer
printers. Color mapping tables are used to provide highlight color attachments to
black-and-white printers, such as using the IBM Infoprint 4005 attachment with the
IBM Infoprint 4000 printer. You can also use a color mapping table to map
highlight colors (such as blue) into richer colors (IBM blue) on a color printer like
the IBM Infoprint Color 130 Plus printer. To apply color to black and white
documents, you must use the following procedure to create Color Mapping Table
Source (.src) and Output Files. Refer to "Chapter 4. Infoprint Administrative
Utilities” in Infoprint Manager: Reference for information about the ecmt Utility or to
the appropriate man page.

You can define translations from non-color fields to color, old color fields to new
color fields, and from new color fields to different new color fields. Therefore, you
can use existing applications and documents with new color fields without having
to change the documents or applications. Also, you can use various color
mappings with a single document to print the document using color in different
ways without changing the original document.

The cmt.cfg file should be available in the usr/lpp/psf/config directory and the cmt
file should be available in the /ust/lpp/psf/bin directory on your Infoprint AIX
server. Using the AFP architectural reference cited in the procedure below, you can
apply color to existing black and white documents. Note that a sample color
mapping table that uses the cmt.cfg file is provided in
lust/lpp/psf/config/cmtsampl.

The cmt utility allows you to create color mappings in a variety of different color
modes that are defined through the ColorSpace parameter. For example, the
Highlight value can be used when printing to an IBM Infoprint 4000 printer with
an Infoprint Highlight Color Model HC2 Post-Processor (HCPP). For more
information on the HCPP, see the IBM Infoprint Hi-Lite Color Printer: Library
Catalog at the URL http://www.printers.ibm.com/R5PSC.NSF/Web/hilitem.

| Parts of a color mapping table

I A color mapping table consists of a base part, a set of source groups, and a set of
[ target groups. The base part identifies the color mapping table with a type of
[ either reset or normal.

The simplest possible color mapping table is a reset color mapping table, which
tells the printer to do no transformations on the color information found in the
document. A reset color mapping table has no source or target groups; all other
color mapping tables have at least one source and one target group.

Using source groups

Each source group has an identification (ID) number, which is used to match the
source group with a corresponding target group. You may have unique ID
numbers; however, if you create the color mapping table without the emt Utility
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and want to map several source groups to a single target group, you can use the
same ID number on multiple source groups. Valid ID values are 1-127.

Note: The cmt Utility generates pairs of sources and targets, then assigns
increasing, sequential IDs to each pair. For more information about the cmt
Utility, refer to "Chapter 4. Infoprint Administrative Utilities” in Infoprint
Manager: Reference.

Each source group must be classified as one of the following color spaces:

Highlight color
Highlight color is used when your existing documents describe color in
terms of the percent to be covered and the percent to be shaded for a color
number. The colors are device dependent. For example, you may have a
printer that allows the use of three colors for highlighting. You could
specify percent coverage and percent shading for colors 1, 2, or 3. Your
printer setup would determine the actual colors.

Standard Object Content Architecture (OCA)
Standard OCA uses defined combinations of red, green, and blue to create:
blue, red, pink, magenta, green, turquoise/cyan, and yellow. Standard
OCA also defines several defaults such as white on a black medium, black
on a white medium, and the same color as the medium. The medium
could be, for example, paper or a display.

GOCA pattern fill
GOCA pattern fill defines patterns for filling areas that you may want to
map to colors with a color mapping table.

For detailed explanations about these color spaces, refer to Mixed Object Document
Content Architecture Reference.

You can use a color mapping table to pick specific object types to map, such as:
* Object area

* IM image data

* PTOCA data

* Page presentation space

* GOCA data

* Opverlay presentation space

¢ BCOCA data

* JOCA data (bi-level, FS10)

* All PTOCA, GOCA, BCOCA, IOCA, FS10, and IM object data
* All objects, object areas, and presentation spaces

After you pick the color spaces and object types you want to map, you can specify
exact values for the fields you want to map.

Using target groups

If you create the color mapping table without the emt Utility, you must specify a
target group ID number to match the source groups for a target. Valid ID values
are 1-127.
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Note: The cmt Utility generates pairs of sources and targets, then assigns
increasing, sequential IDs to each pair. For more information about the cmt
Utility, refer to "Chapter 4. Infoprint Administrative Utilities” in Infoprint
Manager: Reference.

Each target group must be classified as a color space, which is the kind of color
you want as output. The color spaces defined in the matching source groups are
transformed to this color space. The color mapping table allows RGB CMYK,
highlight, and CIELAB, but your actual hardware determines your available
choices. For example, if your printer supports only highlight color, then your target
group must use highlight color.

You can specify exact values for output colors. For example, if your printer
supports three highlight colors, you can specify colors 1, 3, or 3 with coverage and
shading percentages that are supported by your printer.

Other publications that have helpful references regarding color devices include:

* Infoprint 4005 Hi-Lite Color Application Design Reference, available from your IBM
marketing representative.

e Infoprint Hi-Lite Color Introduction and Planning Guide for 4005.

Creating a color mapping table

In the procedure described below, we create a color mapping table to print an
Advanced Function Presentation (AFP) file that contains pie charts in the color
green.

For our AFP files, this pie chart appears as a series of horizontal lines. By accessing
the chapter on "Graphic primitives and attributes” in the Graphics Objects Content
Architecture for Advanced Function Presentation Reference manual, we can see that
these horizontal lines are created by a Pattern Output Primitive with a hexadecimal
value of '0B'(11).

To turn these horizontal lines into a shade of green when using a ColorSpace
source group of GOCA to map to a target group value of RGB, ensure that you
specify a low value for red (12), a high value for green (252), and a value under 50
for blue (42) to provide a clear contrast.

You must perform the following tasks from the AIX command line:
1. From the usr/lpp/psf/config directory, specify:
cp cmt.cfg piel.cfg

This copies the Color Mapping Table configuration file into a file you can
customize for your own purposes (in this case, piel.cfg)

2. Specify vi piel.cfg.
This allows you to edit the configuration file and insert the applicable values to

create the appropriate color mapping (whether GOCA to RGB or OCA to
CIELAB) table. See the sample cmt.cfg configuration file below:

# Required, starts a Color Mapping Definition.
# One definition for each Source to Target mapping.

# BeginSourceDef:
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# Required, starts the Source Parameters

# ColorSpace:
# Required, values= OCA | Highlight | GOCA

# ColorValue:
# Required, values depend on Color Space

# ObjectType:

# Optional, values= ObjArea | ImageData | PTOCData |
# GOCAData | BCOCAData | A110CA | Page | Overlay |

# ObjsAll

# default= 0bjsAll

#
# PercentShading:

# Optional, only valid for SourceColorSapce: Highlight,
# values= 0 .. 100, 255 (all percentages),

# default= 100

#

#

PercentCoverage:

Optional, only valid for SourceColorSpace: Highlight,
values= 0 .. 100, 255 (all percentages),

default= 100

S S F I I H

EndSourceDef:

#
#
# Required, ends the Source Parameters
#

EndSourceDef:

# BeginTargetDef:
# Required, starts the Target Parameters

# ColorSpace:
# Required, values= RGB | CMYK | Highlight | CIELAB

# ColorValue:
# Required, values depend on Color Space

ColorValue: 12 252 42

# PercentShading:
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# Optional, only valid for TargetColorSpace: Highlight,

# values= 0 .. 100, default= 100
2y gy
# PercentShading:

# oo e
# PercentCoverage:

# Optional, only valid for TargetColorSpace: Highlight,

# values= 0 .. 100, default= 100
2y
# PercentCoverage:

F o m e

# EndTargetDef:
# Required, ends the Target Parameters

# EndMappingDef:

Once you have finished editing the piel.cfg file, save the file.

To generate the Color Mapping Table source (.src) file that will be used when
you submit the job for printing, run the emt Utility as the input file (-i flag):

cmt -i piel.cfg -o piel.out
This command produces a piel.out output file.

To verify your color mapping values, respecify the emt Utility, using the newly
created piel.out as the input file and piel.src as the output file:

cmt -i piel.out -0 piel.src

Before you attempt to use this color mapping table to submit a job to Infoprint
Manager, verify that the source file contains the intended values. In this case,
the piel.src file should resemble the following, where the source definition
represents the input file (in this case AFP) that you are converting to the target
definition (an RGB color value of green):

BeginMappingDef:

BeginSourceDef:

ColorSpace: GOCA

ColorValue: 11

ObjectType: GOCADATA
EndSourceDef:

BeginTargetDef:

ColorSpace: RGB
ColorValue: 12 252 42
EndTargetDef:

EndMappingDef:

Once you have verified the contents of the source file, see [“Submitting c0101|
[mapping table source and output files with Infoprint Manager” on page 76|
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Submitting color mapping table source and output files with Infoprint

Manager

To submit a job using the color mapping tables for spot color, you must ensure
that you also specify a resource-context attribute so that the server knows the
location of the color mapping table. Once you have configured a Color Mapping
Table, you must have defined a logical destination (named prtl for this example)
to which you can send the job. You can submit jobs through either of the following
methods.

Submitting jobs through the AIX command line

Once the logical destination has been defined, you can submit a job to an Infoprint
Manager printer by specifying the following from the command line:

Command Values Meaning
pdpr -d prtl Print Command with logical destination
name.
-x job-name=gocajob Name of the AFP file you submit for
printing.
-x resource-context=/usr/1pp/psf/cmt/ Explicit path name where the AFP file

(in this case reportl), resides on your
Infoprint AIX server.

-x color-mapping-table=piel.out Color Mapping Table that you created in
‘Creating a color mapping table” onf

page 73| for printing this file.

/usr/1pp/psf/cmt/goca.afp Explicit pathname where the input file
resides.

Setting the Color Mapping Table with the Infoprint Manager
Administration GUI

You can submit a job with a Color Mapping Table through the Infoprint Manager
Administration GUI This method is valuable if you are using the same color
mapping table for a long run of print jobs. If you must switch between Color
Mapping Tables, it might be easier to specify the mapping table from the command
line (as shown above).

1. From the Infoprint Administration Servers main window, enable the
appropriate actual destination (in this case, NewP, as shown below) by
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right-clicking the actual destination and then selecting Enable.

-_;,__' Infoprint Manager Administration Servers perfaix
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B Fileoong poBic
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Frinter Status

2. Ensure that the Color mapping table (piel.out) has been specified on the AFP
Color tab of the Printer Properties notebook and that the Location of resources

(/usr/1pp/psf/cmt/) has been specified on the AFP Resources tab, as shown

below:

SF TCP/IP Printer Properties HewP

m This notebook shows properties for the selected actual destination.

Find criteria Field to find

Configuration | Tuning | Job | Document | Capahility | Customize  AFP Resources

These properties determine which AFF resources are used by the actual destination.

Farm definition

Mediurm overlay

Lacation of farm definitions

Location of averlays

Lacation of fonts

Location of page segments

Location of presentation ohject cantainers

Lacation of resources

F1a10111

fustippipsfiemnt

Find |

General | Status | Wedia@insTrays | Notification | Load Balancing | outnit | annearance | AudlianiSenarator Sheets | Srmp
AFF Color | ASCIVEBCDIC | Line Data

Showe (855 |

Ok | Apply |

Cancel

Help |
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3. Submit your job to Infoprint Manager, using either the command line or the
Infoprint Select client.
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Chapter 10. Configuring for interoperability on an Infoprint
AIX server

By performing the following set of procedures on both an Infoprint AIX server and
an Infoprint Windows NT or Windows 2000 workstation, you can configure
Infoprint Manager to support interoperability between Infoprint AIX servers and
Infoprint Windows NT or Windows 2000 servers.

When configuring Infoprint Manager servers to support interoperability, ensure
that the following two rules are followed:

1. Each Infoprint Manager server must be accessible by all other Infoprint
Manager servers using the same IP address.

For example, if Serverl is an Infoprint Manager AIX server with an IP address
of 9.99.155.122, then all other Infoprint Manager servers (whether Windows
NT, Windows 2000, or AIX servers) must use 9.99.155.122 to access Serverl.

2. The IP address for each Infoprint Manager server must be the address that is
identified for the first (or primary) network card that is defined to that server.

3. All printer objects (whether logical destination, actual destination, or queue)
must have unique names if they are used by interoperating Infoprint servers.

If the printer objects do not possess unique names, you may have trouble
viewing them through the Infoprint Manager GUI from a non-namespace
server.

Please note that the Infoprint Manager LPD service for Windows NT and the
multiserver setup cannot be run together, because the multiserver setup requires
that Windows NT Services for UNIX be installed on your server. Windows NT
Services for UNIX uses Microsoft Window’s TCP/IP printing service, which is an
LPD service. Because the Windows LPD and Infoprint LPD services both use the
same port, only one LPD service can be run at a time. LPD service for AIX can still
be used however, by submitting jobs with the Ipr command to actual destinations
on the AIX server. The Ipr command can also still be used as before with Windows
printer destinations (just not Infoprint Manager printers).

Setting up the Infoprint AIX server for interoperability

Perform the following procedures on your Infoprint AIX server to prepare for
interoperability with an Infoprint Windows NT or Windows 2000 server. The
following presumes that you have installed Infoprint Manager for AIX Version 4
Release 1 on your AIX server and have logged onto the server as root.

Starting NFS and connecting the AIX secondary server

1. Open a dtterm window and type: /etc/rc.nfs to either start the NFS daemon
or ensure that it has been started.

2. Open a dtterm window, type smit. The following screen displays.
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Figure 15. Main SMIT Panel

3. From this panel, specify the Infoprint Printing System-->Infoprint
Utilities-->Configure Secondary Servers (NFS)-->Link from Primary Server to
Secondary Server path.

4. Specify both the host name and the IP address of the Infoprint Windows server
with which you intend to interoperate for the Secondary Server Host Name
and the Secondary Server IP Address fields respectively. For example, wservl
and 9.99.193.120 represent the Infoprint Windows server in the pop-up panel
displayed below:
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Figure 16. Link from Primary to Secondary Server Panel

You should specify no for the Is /ipdata used for job ticketing? field, unless
you are using this AIX Infoprint Manager server with AIX Fast Connect to
allow for file sharing with an Infoprint Submit Windows client for preflighting
jobs and saving RIPed files.

You should also allow the Retain secondary server previously defined? field to
default to yes if you have more than one Infoprint server functioning as a
secondary server.

5. Once verified, click OK, and then click Done.
6. Return to the first SMIT panel displayed in step 2.

Adding users to and modifying permissions for FST security

groups

1.

Set up the FST Security groups on your AIX server by taking the Infoprint
Printing System-->Security-->Groups-->Show Group path. From the Single
Select List pop-up dialog, you should see the following three groups:
acl_admin, admin, and oper.

Once you have verified the existence of these two groups, you should ensure
that users in the admin group can issue all the Infoprint pd* commands. From
SMIT, take the Infoprint Printing System-->Security-->Access
Control-->Access Control for Operations-->Show Access Control List path.

From the Single Select List pop-up dialog, highlight each command and
ensure that GROUP:admin: r-- displays for each command.

If a particular pd command does not show admin group read authority, use the
SMIT Infoprint Printing System-->Security-->Access Control-->Access Control
for Operations-->Change Access Control List path to specify GROUP:admin in
the Users or Groups field of the Change Access Control List panel for that pd
command. Note that the admin group requires only read authority for each pd
command.

Note that you may have to perform the preceding task only if migrating from
an Infoprint Manager 3.1 system or earlier. If you have installed Infoprint
Manager 3.2 on a "clean” machine, the admin group will have read authority
for all pd commands by default.

Once complete, return to the first SMIT panel displayed in step 2.

Take the Infoprint Printing System-->Security-->Groups-->Add Users to a
Group path. Then specify acl_admin for the Group Name field. Enter the name
of the Windows administrative user you normally log in to the Infoprint
Manager for Windows server machine as for the User or Users to Add field.
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For the remainder of this procedure we will refer to this Windows
administrative user as ipmwinadmin*. Note that ipmwinadmin must be followed
by an asterisk () to account for the fully-qualified host name. (For example,
ipmwinadmin@ipmwinservermachine.boulder.ibm.com.)

From the Add Users to a Group panel, specify admin for the Group Name
field. Enter the name of the Windows administrative user you normally log in
to the Infoprint Manager for Windows server machine as for the User or Users
to Add field. Note that you do not have to perform this step for the oper
group.

Once complete, click OK to ensure the changes take effect and return to the
first SMIT panel displayed in step 2.

Now you can proceed to either[“Setting up the idwinadmin id on an NT domain|

controller”] or |“Setting up the idwinadmin id on a Windows 2000 domain|

controller”} depending upon the base operating system of your Windows server.

Setting up the idwinadmin id on an NT domain controller

On the Windows NT domain controller server for the domain where your servers
reside, perform this task to ensure that the Infoprint Manager Windows servers can
access the namespace.

1.

6.
7.

Log on to the Primary Domain Controller for the domain that your Infoprint
Manager servers operate in as a domain administrator.

From the Start menu, access the Programs-->Administrative Tools-->User
Manager for Domains path.

From the User Manager for Domains window, access the User menu and
choose New User.

In the user name field enter ipwinadmin and in the password field type a
password value.

IBM recommends that you select Password never expires so you don’t have to
change the password and update all of your servers on a regular basis.

Click on the Groups button and make sure that ipwinadmin is a member of the
Domain Admin group and that its primary group is set to Domain Admin.

Click OK.
Click Add.

Setting up the idwinadmin id on a Windows 2000 domain
controller

On the Windows 2000 domain controller server for the domain where your servers
reside, you must perform this task to ensure that the Infoprint Manager Windows
servers can access the namespace.

1.

Log on to the Primary Domain Controller for the domain that your Infoprint
Manager servers operate in as a domain administrator.

From the Start menu, access the Programs-->Administrative
Tools-->Computer Management path.

From the Computer Management window, click the plus (+) sign next to the
Local Users and Groups list.

Click the Users folder and choose New User from the Action pull down
menu at the top.

In the User name field type ipwinadmin. In the Password and Confirm
Password fields type a password value.
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IBM recommends that you select Password never expires so you don’t have
to change the password and update all of your servers on a regular basis.

Click the Create button and close the dialog (it will be prompting you to add
another user’s information).

From the User window, open the ipwinadmin that you just finished creating
by double-clicking on the list item.

Click on the Member Of tab, click Add, then double-click Administrators.
Click OK.
Click OK a second time to finish.

Creating the ’'ntuser’ ID on the Infoprint AIX server

The following procedure creates the example ntuser ID that the Infoprint Windows
NT or Windows 2000 server will use to share and manage namespace directories
and files that reside on the Infoprint AIX server.

1.
2. On the Add a User panel, specify ntuser as the User NAME field value,

Specify SMIT and take the Security & Users-->Users-->Add a User path.

specify printq for the Primary GROUP field, printq,system as the Group SET
field, and /home/ntuser for the HOME directory field.

Change the File Creation UMASK field value to 003

Ensure the Login AUTHENTICATING Grammar field is either blank or
specifies compat (if SMIT will not process the command without an entry in this
field).

Ensure the Password REGISTRY field value specifies files
and take the default for all other fields.

3. Click OK to save the changes and exit the SMIT interface.
4. Login to the server as root and set the initial password.

5. Login as ntuser with the initial password, then change the password to ntuser.

Ensuring correct AlX file permissions for interoperability
1.
2,
3.

NN W W

4.

root
root
root
root
root

Log on to the server as root.

From a dtterm window, type cd /var/pddir/default_cell.

Ensure that all the files residing in this directory have the correct permissions
to be read by the Infoprint Windows server by typing chmod -R 774 * .

Ensure that all the files residing in this directory belong to the correct group by
typing chgrp -R printqg * .

If these last two steps have been performed correctly, entering an 1s -1 at the
command line should display the following permissions and group values:

printq 512 acl
printq 512 printers
printq 512 queues
printq 512 servers
printq 4 version

Complete your preparations on the Infoprint AIX server by logging in as
ntuser and specifying a password of ntuser. Remember this password, as you
will need it later in this procedure.

Once you have completed these steps, the Infoprint AIX server is ready for
interoperability.
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Configure Windows NT servers for interoperability

Some print environments require more than one Infoprint Manager server to
handle their print management. If you are adding one or more Infoprint Manager
for Windows NT and Windows 2000 servers to your print environment, this topic
will tell you what you need to do to make those servers work with the Infoprint
Manager AIX Version 3.2 server.

Notes:

1. In an interoperating environment that includes an AIX server and NT servers,
the namespace will reside on the AIX server.

2. You can only install one Infoprint Manager server on a given Windows NT or
Windows 2000 workstation or server.

3. If your users will be submitting jobs directly to actual destinations, the actual
destination and the associated queue and logical destination must be on the
same server.

4. Once you have your multi-server system running, if one of your NT servers
shuts down or is restarted, that Infoprint Manager server will not restart
automatically when the system restarts. You must open the Management
Console for that server and start it manually.

5. The following instructions refer specifically to Windows NT systems.

Setting up interoperating Windows NT servers

The Windows administrator should use the following procedure on the Infoprint
Windows NT or Windows 2000 server to configure for communication with the
Infoprint AIX server. For a detailed description of the Windows NT Domain
configuration process, refer to "Setting up a print environment with multiple
Windows NT /2000 servers” on the web at

ftp://ftp.software.ibm.com/printers/specs/multint.pdf.

1. Install all of the Infoprint Manager for NT servers as described in Getting
Started. When you are finished, your servers will all be operating
independently.

2. On each system that an Infoprint Manager server runs on, open the Infoprint
Manager Management Console and click File --> Stop Server.

Installing MS Services for UNIX on the Infoprint Windows servers
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You must perform the following task on each Windows NT or Windows 2000
server:

1. Using the CD-ROM, install Microsoft Windows NT Services for UNIX from the
"Add-on Pack for MicroSoft Windows NT Workstation and Server 4.0" at
Version 1.0 or higher.

2. Reboot each Infoprint Windows NT or Windows 2000 server.

Setting up the common account for Infoprint Windows servers
on an NT domain controller

On the Windows NT domain controller server for the domain where your servers
reside, you must create the domain account that all the Infoprint Windows NT or
Windows 2000 servers will run under. Perform this task to ensure that the
Windows servers can access the namespace.
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6.
7.

Log on to the Primary Domain Controller for the domain that your Infoprint
Manager servers operate in as a domain administrator.

From the Start menu, access the Programs-->Administrative Tools-->User
Manager for Domains path.

From the User Manager for Domains window, access the User menu and
choose New User.

In the user name field enter ntuser and in the password field type the ntuser
password from step 4 of the [Ensuring Correct AIX File Permissions for]
[Interoperability| procedure.

IBM recommends that you select Password never expires so you don’t have to
change the password and update all of your servers on a regular basis.

Click on the Groups button and make sure that ntuser is a member of the
Domain Admin group and that its primary group is set to Domain Admin.

Click OK.
Click Add.

Setting up the common account for Infoprint Windows servers
on a 2000 domain controller

On the Windows 2000 domain controller server for the domain where your servers
reside, you must create the domain account that all the Infoprint Windows NT or
Windows 2000 servers will run under. Perform this task to ensure that the
Infoprint Manager Windows servers can access the namespace.

1

1.

9.
0.

Log on to the Primary Domain Controller for the domain that your Infoprint
Manager servers operate in as a domain administrator.

From the Start menu, access the Programs-->Administrative
Tools-->Computer Management path.

From the Computer Management window, click the plus (+) sign next to the
Local Users and Groups list.

Click the Users folder and choose New User from the Action pull down
menu at the top.

In the User name field type ntuser. In the Password and Confirm Password
fields type the ntuser password from step 4 of the [Ensuring Correct AIX File]
[Permissions for Interoperability| procedure.

IBM recommends that you select Password never expires so you don’t have
to change the password and update all of your servers on a regular basis.

Click the Create button and close the dialog (it will be prompting you to add
another user’s information).

From the User window, open the ntuser that you just finished creating by
double-clicking on the list item.

Click on the Member Of tab, click Add, then double-click Administrators.
Click OK.
Click OK a second time to finish.

Grant appropriate user rights to the domain user on all
Infoprint Manager Windows NT servers

To ensure that the Windows NT Infoprint Manager servers can run as a Windows
service using the domain userid ntuser, you must ensure that this userid has the
proper level of authority on each Windows NT Infoprint Manager server system.

1.

Log on to the Infoprint Windows NT or Windows 2000 servers as ipmwinadmin
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2. Use the local User Manager to give the domain user (ntuser) that you created
in step 4 the following user rights on that system:

a. Act as part of the operating system
b. Create permanent shared objects
c. Log on as a service
Note:
Click the Advanced User Rights check box to see these rights.

d. Repeat this process on all of the Infoprint Manager Windows NT or
Windows 2000 servers.

Grant appropriate user rights to the domain user on all
Infoprint Manager Windows 2000 servers

To ensure that the Windows 2000 Infoprint Manager servers can run as a Windows
service using the domain userid ntuser, you must ensure that this userid has the
proper level of authority on each Windows 2000 Infoprint Manager server system.

1. Log on to one of the systems as a user who is a member of the Domain
Administrators group.

2. Click the Windows Start button and select Settings --> Control Panel.
3. In the Control Panel window, double-click the Administrative Tools icon.

4. In the Administrative Tools window, double-click the Local Security Policy
icon.

5. In the right pane of the Local Security Settings Window, double-click Local
policies.

Eﬁ Local Security Settings

@ Security Settings
-8 Account Policies
28 Local Policies
|:| Public Kew Paolicies

,g IP Security Policies on

J dckion  Wiew J 4= =y | | > | E%
Tree I Marne | Descripkion
& Account Policies Password anc

Local Palicies
(L Public Key Policies
@ IP Security Policies on Local M., Internet Prot

Auditing, use

6. Double-click User Rights Assignment in the right pane.

J fckion  Yiew |J o -I*||>< ||§

Tree I
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-8 Account Policies
@ Local Policies

-2 Public Key Palicies
@ IP Security Policies on
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7. In the list of user rights, select Act as part of the operating system and

double click it.

E¢ Local Security Settings

J Action  Wiew |J L= -P||>< |@

Tree I

@ Security Settings
-8 Account Policies
El@ Local Policies
-8 Audit Policy
@ Iser Rights Assigr
@ Security Options
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Change the syskem time Paowier Users, Sdmini. ..

8. In the Local Security Policy Setting dialog, click Add.

Local Security Policy Setting K E3 |

_ At az part of the operating systemn

&

Azzigned To

Local Effective
Fuolicy Setting Paolicy Setting

Add...

IF domain-level policy settings are defined, they override local policy zettings.

QK Cancel
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9. In the Select Users or Groups dialog, click the arrow on the drop-down list
box and select the domain that your Infoprint Manager servers exist in.

i Select Users or Groups ﬂ

Lodk in: I@ iprm. penin. boulder. ibm. corm j
M arne | In Folder |:|
ﬂ ipserver (ipserver@ipm. penn. boulder, ibm, com) iprn.penn.boulder.ibm.comdUsers

ﬂ Ignatz P. Uzer [ipuser@ipm. penn.boulderibm.c...  ipm.penn.boulder.ibm.com/Users
ﬁ Infaprint [Infoprint@ipm. penn. boulder. ibrm. com) iprn.penn.boulder.ibm.comsU sers

ﬁi Darmain Computers iprn.penn.boulder.ibm.comsUzers

!ﬁ Domain Controllers ipm.penn.boulder.ibm. comdUzers (]

ﬂi Schema Admins iprn.penn.boulder. ibr.comdU sers

ﬁi Enterprize Adrins iprn.penn.boulder.ibm.comsUsers LI
Add Check Hames

<< Type names separated by semicolons or choose from list »>

] Cancel

P

Find and select the domain user you created, and click Add.

10. OTF command in the Select Users or Groups dialog.

11. OTF command in the Local Security Policy Setting dialog.

12. Repeat from step for two other user rights: Create permanent
shared objects and Log on as a service.

Configuring the NFS client to access the namespace

The following NFS client configuration will need to be performed on each
Infoprint Manager for Windows NT or Windows 2000 server that will access the
namespace on the AIX Infoprint Manager server machine.

1. Log on to the Windows Infoprint Manager server as the domain user ntuser
who was created in the [Setting Up the Common Account for Infoprint|
[Windows Servers on the Domain Controller| procedure above.

2. From the Start menu, access the Settings—>Control Panel path, and
double-click Client for NFS to configure the NFS client to access the
namespace.

3. Click the Authentication tab:

a. Enter ntuser in the User Name field.

b. Enter the Infoprint AIX password for ntuser (the one you set up in step 4
the [Ensuring Correct AIX File Permissions for Interoperability| procedure) in

the Password field.
c. Click the PCNFSD Server radio button and type in the name of an
Infoprint Manager AIX server.
4. Click the Filenames tab and set values as follows:

Preserve Case (no conversion) check
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Generate Unique Names for Existing Files with Mixed

Case Filenames uncheck
Match Filenames Exactly check
Match Filenames Ignoring Case uncheck

5. Click OK.

6. When you receive the pop-up dialog box that says NFS Login Successful , click
YES.

If you do not receive this message, go back to the Authentication tab and
ensure that the ID and password match those set up in the final step of the
[Ensuring Correct AIX File Permissions for Interoperability| procedure.

7. Log off the Windows Infoprint Manger server as the domain user ntuser and
log on to the Windows Infoprint Manger server as the ipmwinadmin user.

8. Repeat steps 2 through 6 from above.

Verifying access to the AIX namespace that allows
interoperability on Windows NT

From each Infoprint Windows NT, you must verify that you have access to the
namespace on the Infoprint AIX server. You can do this by mapping a network
drive (as ntuser with the ntuser password from step 4 of the [Ensuring Correct AIX|
[File Permissions for Interoperability] procedure) from the Windows NT server to

the shared namespace on the Infoprint AIX server.

1. From the Map Network Drive window, use the Path field to specify:
\\aix_servername\var\pddir\default_cell

where aix_servername is the name of the Infoprint AIX server.

2. Next, specify ntuser in the Connect as field. A dialog box will open asking for
a password associated with ntuser. Specify the ntuser password from step 4 of
the [Ensuring Correct AIX File Permissions for Interoperability| procedure in the
Password field.

3. Click OK and the NFS Client window opens.

4. Click OK again. A small notification window should appear that says NFS
Login Successful.

Since the NFS Client was set up in the section [Configuring the NFS Client to
[Access the Namespace] click OK.

5. Click Yes to accept the current login and OK to map the drive.

If the drive mapped correctly, a new window should open to the mapped
drive’s contents, and the NFS client and Map Network Drive windows should
be gone.

Verifying access to the AIX namespace that allows
interoperability on Windows 2000

From each Infoprint Windows 2000 server, you must verify that you have access to
the namespace on the Infoprint AIX server. You can do this by mapping a network
drive (as ntuser with the ntuser password from step 4 of the [Ensuring Correct AIX]
[File Permissions for Interoperability| procedure) from the Windows 2000 server to
the shared namespace on the Infoprint AIX server.

1. From the main Windows view, right click the My Network Places icon, choose
Map Network Drive. In the dialog, use the Folder field to specify:

\\aix_servername\var\pddir\default_cell
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where aix_servername is the name of the Infoprint AIX server.
Check the Reconnect at Login check box.
Click on the Connect Using Different User Name link.

A dialog box will open asking for a username and password associated with
ntuser. Specify the ntuser password from step 4 of the [Ensuring Correct AIX|
[File Permissions for Interoperability| procedure in the Password field.

Click OK and the NFS Client window opens.

Click OK again. A small notification window should appear that says NFS
Login Successful.

Since the NFS Client was set up in the section [Configuring the NFS Client to]
[Access the Namespace} click OK.

Click Yes to accept the current login and Finish to map the drive.

If the drive mapped correctly, a new window should open to the mapped
drive’s contents, and the NFS Client and Map Network Drive windows
should be gone.

Configuring the ’ntuser’ ID for interoperability on the Infoprint
Windows servers
Ensure that you complete the following procedure on all Infoprint NT servers.

Note: Once this procedure is completed, ensure that you perform all namespace

administration from the Management Console on the Infoprint Windows
server, not the Infoprint AIX server.

On all Windows NT or Windows 2000 servers, do the following:

1.
2.

10.

Log on as user ipmwinadmin .

From the Start menu, click on the Programs—>Infoprint
Manager—>Management Console path.

Stop the server by either clicking the Stop toolbar button or clicking
File—>Stop Server.

Access the Edit—>Service Account/Domain path.

Specify the NT domain name in the Domain field, the account you created
during step 4 of Setting up Interoperating Windows NT servers|in the User
account field, and the password in the Password field.

Click OK.

Note: A notification server was installed with each of your Infoprint Manager
servers. However, now that the namespace is shared, you only need to run
one of them . The notification server must be run on the namespace server.
Disable all but one of the Infoprint Manager Notification servers.

Click on the Edit—>Service Configuration path.

In the Settings group box, clear both the Run notification server on this
system and Run Infoprint Manager LPD service check boxes.

Clear the Base namespace path field and type the drive letter that you want
to use to link to the namespace followed by a colon (for example, type x:).
Use the same drive letter that you used when mapping the network drive in
step 4 of the[Setting up Interoperating Windows NT servers procedure.

In the Remote namespace folder field, enter the Universal Naming
Convention (UNC) name of the shared directory on the namespace server in
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11.
12.

13.

this format: \\namespaceserver\sharename. The sharename of the namesapce on
an AIX server is default_cell. For this example,
\\prince\var\pddir\default _cell .

Click OK.

Restart all of the Infoprint Manager NT servers by selecting File —> Start
Server on each Management Console.

Verify that all of the servers are now sharing the namespace.

* Log on to any one of the machines that holds an Infoprint Manager server,
open a command prompt.

* Start the Infoprint Manager Administration GUL
* Click on Server—>Show All Servers.

You should see a list of all of the servers that are using the namespace. If any
of them do not appear, stop the servers and check the settings that you
changed in step 7 for that server.

Verifying the authority of the ipwinadmin ID

Use the following procedure to verify that the ipwinadmin id has permission to
both modify security groups and issue all the Infoprint pd* commands.

1.

10.

11.
12.

13.

Verify that the Infoprint servers are interoperating by performing step 13 of

Configuring the ‘ntuser’ ID for Interoperability on the Infoprint Windows|

Serveré.

Ensure that you created a user named ipwinadmin in the domain in either the

“Setting up the idwinadmin id on an NT domain controller” on page 82| or the

“Setting up the idwinadmin id on a Windows 2000 domain controller” on|

page 82| procedure.

Log on to the Infoprint Windows server as user ipwinadmin.

From the Start menu, click on the Programs—>Infoprint
Manager—>Management Console path.

From the left pane, click on the Security item.
Double-click on Groups item.

From the Groups view in the right pane, highlight the acl_admin item and
choose open from the drop-down menu.

Click on the Add... button.
In the Add Member to Group dialog, type ipwinadmin=* in the field provided.

In the Groups view, you should be able to see ipwinadmin listed in the
Members column for the admin group.

From the Groups view in the right pane, highlight the admin item and choose
open from the drop-down menu.

Click on the Add... button.
In the Add Member to Group dialog, type ipwinadmin# in the field provided.

In the Groups view, you should be able to see ipwinadmin listed in the
Members column for the admin group.

Log on to the Infoprint Windows server as ipwinadmin.

You should be able to create and modify security groups and issue all the
Infoprint pd* commands.
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Chapter 11. Setting up high speed printers for spacing

In Infoprint Manager, moving from page to page in a job is called spacing:

* Forward spacing is moving to a point later in the job (such as skipping from page

10 to page 15).

* Backspacing is moving to a point earlier in the job (such as backing up from page

40 to page 20).

For spacing to work effectively on the Infoprint 2000 for AFP printing, Infoprint
3000, Infoprint 4000, and Infoprint 4100, you must first enable the printer to work
with the Simple Network Management Protocol (SNMP) and allow SNMP to
configure the printer. These settings allow you to use the Infoprint Manager GUI to
stop a printer very quickly (in ten seconds or less) when you need to, instead of
having to wait for all of the pages of a job that have been buffered to print.

Enabling SNMP on an Infoprint 2000 for AFP printing

1.

On the display/touch screen on the touch screen/printer console, open the
Printer definition pull-down menu.

Select Remote Access.
On the SNMP tab:

* Select the Enable SNMP Agent and Allow SNMP to configure the printer
check boxes.

* In the Communities list, touch the name of the community you will be using
to access the printer and verify the settings. Make sure that the community
has Write access to the printer.

Touch OK to close the window.

On the main screen of the console, make sure that the attachment type you will
be using is enabled.

If you changed the Enable SNMP Agent or the Allow SNMP to configure the
printer setting, shutdown and restart the printer to make the changes take
effect.

Disable the Infoprint Manager printer and enable it again to refresh the printer
configuration information in the server.

a. Start the Infoprint Manager Administration GUL

b. In the GUI, find the Infoprint Manager printer (actual destination) that
corresponds to this printer and select it.

c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.

Enabling SNMP on an Infoprint 3000 or an Infoprint 4000 printer that
uses the operator console

The Operator console is the standard console for the Infoprint 3000 and the
Infoprint 4000.

1.

2.
3.

On the display/touch screen on the Operator console, open the Configure
pull-down menu.

Select Remote Access.
Under Select a Remote Access, select SNMP.
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Under Enabled, select Yes.
Under Allow to Configure, select Yes.
Touch OK to close the window.

You will be prompted to restart the printer so that these settings can take effect.
Restart the printer, and wait for it to power back up before you continue.

Disable the Infoprint Manager printer and enable it again to refresh the printer
configuration information in the server.

a. Start the Infoprint Manager Administration GUL

b. In the GUI, find the Infoprint Manager printer (actual destination) that
corresponds to this printer and select it.

c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.

Enabling SNMP on a printer that uses the Enhanced Operator Console

94

The Enhanced Operator Console is the standard console for the Infoprint 4100 and
is available as an upgrade for the Infoprint 4000.

1.

On the Enhanced Operator Console, touch Printer definition at the top of the
screen.

On the left side of the screen, touch Remote Access.

In the Communities list, select the name of the community you will be using to
access the printer and verify the settings. Make sure that the community has
Write access to the printer.

Select the SNMP Agent Enabled and Allow SNMP to Configure Printer
checkboxes, so they both say Yes.

Touch OK to save the settings.

You may be prompted to restart the printer so that these settings can take
effect. Restart the printer, and wait for it to power back up before you continue.

Disable the Infoprint Manager printer and enable it again to refresh the printer
configuration information in the server.

a. Start the Infoprint Manager Administration GUL

b. In the GUI, find the Infoprint Manager printer (actual destination) that
corresponds to this printer and select it.

c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.
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Chapter 12. Using Infoprint Manager with the Infoprint Color

130 Plus

The IBM Infoprint Color 130 Plus is a high-speed, high quality, full-color digital
printer that you can submit jobs to through Infoprint Manager. This procedure
provides you with some sample scenarios of how to use the Infoprint Color 130
Plus with Infoprint Manager and with the prerequisite steps necessary for these
scenarios.

This procedure takes you through steps to submit different kinds of jobs to the
Infoprint Color 130 Plus using different methods. The following list describes these
scenarios:

* An Advanced Function Presentation” (AFP) document created in a page layout
application is submitted through Infoprint Manager for printing to the Infoprint
Color 130 Plus using the command line. Color images are transformed offline
using the AIX command line.

* A PostScript document is submitted for printing to the Infoprint Color 130 Plus
using Infoprint Submit.

* A document created in a Windows application is submitted through Infoprint
Select for printing to the Infoprint Color 130 Plus.

* A document is submitted for printing to the Infoprint Color 130 Plus using MVS
Download.

Infoprint Color 130 Plus

The Infoprint Color 130 Plus system processes and prints high quality color AFP™
output at high speeds. It also processes and prints PDF or PostScript documents
that include high resolution color images.

The Infoprint Color 130 Plus with Infoprint Manager for AIX combines job
management and page-level error recovery capabilities with the ability to print
full-color applications and documents. The Infoprint Color 130 Plus can support
applications that use data formats, such as Encapsulated PostScript (EPS), Portable
document format (PDF) , Tag image file format (TIFF), Graphic interchange format
(GIF), and Joint photographic experts group (JPEG), as resources for variable data
AFP documents. The AFP architecture allows you to use the Rasterized Image
Processor (RIP) to process these resources in the Advanced Function Common
Control Unit" (AFCCU) and save them in the printer. This capability improves
performance by eliminating the need to re-RIP these resources. It is not necessary
to convert single page PDEF, EPS, TIFF, GIF, or JPEG objects to color images prior to
sending them to the printer. These objects can be RIPped directly in the AFCCU",
increasing performance.

Setting up

The scenarios in this procedure assume that you have completed the following
tasks prior to submitting the job to the printer, if they are applicable.

* [Built a data stream|

+ |Identified the location of your AFP resources|

* |Created an Infoprint Manager actual destination|

© Copyright IBM Corp. 1998, 2002 95



96

* [Transformed color images|

Building a data stream

Build your AFP data stream by using any AFP statement generator or application.
Refer to "Understanding Form Definitions and Page Definitions” in

[Facility for 0S/390: User’s Guide| for more information about AFP architecture.

Build your PostScript data stream with any application that generates PostScript,
such as Microsoft Word with a PostScript driver. Infoprint Manager sends
PostScript data streams to be transformed and RIPped at the server.

Identifying AFP resources

There are various kinds of AFP resources, such as form definitions, page
definitions, overlays, and fonts. The newest kind of resource is the data object. Like
other resources, data object resources are files that you can include in AFP
documents. Data object resources can be EPS, PDF, and IOCA files as well as TIF,
GIF, and JPEG images via the transforms that come with Infoprint Manager. (TIF,
GIF, and JPEG images must be transformed into AFP using the appropriate
transforms before they can be considered data object resources. See

fcolor images” on page 97

In Infoprint Manager, data object resources are grouped with BCOCA and GOCA
objects, and all of those types of files are called presentation object containers. As
with other kinds of AFP resources, you must tell Infoprint Manager where your
presentation object containers are located.

You can define where your image resources are stored either from the AIX
command line using the pdset command with the resource-context-presentation-
object-container attribute or using the Infoprint Manager Administration GUIL

Follow this procedure to set the attributes using the GUL
1. Start the Infoprint Manager Administration GUIL
2. Select Options » Customize.
3. In the Customize dialog, click the Printer tab.
4

. In the Action column, find Change Tuning, Change AFP Resources, and
Change AFP Color, and select the check boxes in the Menu column next to
them.

This step adds these tasks to the Printer menu. If you want to add other tasks
to the Printer menu or to any other menu, you can do it now or you can wait
until later.

5. Click OK to apply the settings and close the dialog.

6. Select your Infoprint Color 130 printer that you create in [“Creating an actuall
[destination” on page 97

7. Select Printer » Change AFP Resources to open the Change AFP Resources
dialog.

8. In the Change AFP Resources dialog, find the Location of presentation object
containers field and type the path where your presentation object containers
are stored. If they are stored in more than one location, list all of the paths
separated with colons (:), for example:

/resources/containers:/dept123/priv-pres-obj- containers:/dept123/
public-pres-obj-containers
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9. Hill in any other fields that are appropriate. For example, if you use form
definitions, fill in the Location of form definitions field.

10. Click OK to apply the settings and close the dialog.

Creating an actual destination

The actual destination represents the physical output device. The Infoprint Color
130 Plus must be a PSF TCP/IP printer. Use the Create Printer Wizard in the
Infoprint Manager Administration GUI to create an actual destination.

Note: Because you are dedicating an Infoprint server to your Infoprint Color 130
Plus, this procedure assumes that you have either just installed Infoprint
Manager on this system or that you have created a new server on this
machine. In either case, your Infoprint server would not contain any objects
(logical destinations, queues, or actual destinations) yet. If you are planning
to use an existing Infoprint server to send jobs to your Infoprint Color 130
Plus, you should delete all of the objects that currently exist in it before you
start this procedure.

1. Start the Infoprint Manager Administration GUIL

2. Select Printer » Create » PSF » TCP/IP.

3. In the first panel of the Create Printer Wizard, do the following.
a. Type a name for the printer in the Name field.
b. Verify that the server is correct in the Server field.
c. Select InfoprintColor130Plus from the Model drop-down list.

Note: If that model is not shown, you must update Infoprint Manager to
the current service level.

d. Type the TCP/IP address and port number for the printer in the correct
fields.

e. Click Next.

4. In the second panel, type or select a name for the logical destination that will
send jobs to this printer and click Next.

5. In the third panel, type or select a name for the queue that will submit jobs to
the this destination and click Next.

6. On the rest of the panels, accept the default values that Infoprint Manager sets
for AFP color printing by clicking Next and finally Finish.

Note: Refer to the worksheets found in "Creating and managing actual
destinations” in Infoprint Manager for AIX: Getting Started when providing
the information as prompted by the wizard.

Creating and configuring a logical destination
You create and configure the logical destination when you create the actual
destination with the Create Printer wizard.

Transforming color images

Color images are transformed automatically at the server when you submit the job
to the printer. However, you can transform your images separately by running
transforms from the AIX command line without printing the generated output
prior to submitting the job. Jobs run more quickly if the images have already been
transformed.

Chapter 12. Using Infoprint Manager with the Infoprint Color 130 Plus 97



Infoprint Manager provides transform programs for most data streams, such as
GIF, PS, and PDE The transforms convert the incoming data stream into the AFP
format. For example, to transform the file mypicture to AFP using the gif2afp
transform, enter the following command:

gif2afp mypicture

For a list of the flags or options and values for each transform, refer to "Infoprint
Object Attributes” in the [[nfoprint Manager: Reference]

Note: It is especially recommended that you transform TIFF, JPEG, and GIF
images from the AIX command line.

Using and changing color and resource attributes

98

You need to decide which color and resource attributes you use or need to change
when you submit your job. The color and resource attribute-value pairs that are
specific to the Infoprint Color 130 Plus include the following:

.

« |color-profiles-supported|

* |color-bits-per-plane|

+ |color-bits-per-plane-supported|

* |color-rendering-intent|

* |color-toner-saver]

+ |color-toner-saver-supported|

* |resource-context-presentation-object-container

+ |presentation-object-container-extraction-mode|

Refer to "Infoprint Object Attributes” in the |[nfoprint Manager: Reference| for more
information on these attributes.

Using color attributes

The color attributes can be modified from the command line using the pdset
command or in the Infoprint Manager Administration GUI. Refer to "Infoprint
Object Attributes” in the [[nfoprint Manager: Reference| for the correct command
syntax when using the command line.

color-profile
Use this attribute to specify the color profile, if any, to be used by PostScript jobs.
This attribute can be equal to:

« SWOP
¢ Euroscale

°* none

The default value is none, which means that the color rendition will be dependent
on the output device.

The title of this attribute in the Infoprint Manager Administration GUI is Color
profile.

color-profiles-supported

Use this attribute to identify which color profiles can be used by the actual
destination when printing a document. This attribute can be equal to one or more
of the following:
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- SWOP
¢ Euroscale

°* none

The default values for the Infoprint Color 130 Plus are SWOP, Euroscale, and
none. For all other actual destinations the default is equal to none.

The title of this attribute in the Infoprint Manager Administration GUI is Color
profiles allowed.

color-bits-per-plane
This attribute specifies whether the transform is to produce monochrome (FS10) or
color images (FS42 or FS45). You can set this attribute equal to:

* 0-bits (monochrome FS10)
* 1-bit (color FS42)
* 8-bits (color F545)

The default for Infoprint Color 130 Plus is 8-bits. For all other actual destinations,
the default is 0-bits.

Note: If the attribute is set to 1-bit for a PostScript data stream it will fail.

The title of this attribute in the Infoprint Manager Administration GUI is Color
bits per plane.

color-bits-per-plane-supported

This attribute specifies the types of images supported on the actual destination
when printing a document. This attribute can be equal to one or more of the
following;:

* 0-bits (monochrome FS10)

* 1-bit (color FS42)

* 8-bits (color F545)

The default values for Infoprint Color 130 Plus are:
* 0-bits (monochrome FS10)

* 1-bit (color FS42)

* 8-bits (color F545)

The title of this attribute in the Infoprint Manager Administration GUI is Color
bits per plane allowed.

color-rendering-intent

While the Infoprint Color 130 Plus produces vibrant full-color images, including
images that contain gradients and shading, it is not able to reproduce every shade
of every color. The color-rendering-intent attribute determines what Infoprint
Manager does when it encounters a shade in a PostScript image that the Infoprint
Color 130 Plus cannot reproduce exactly.

There are two possible values for color-rendering-intent:

Relative
When Infoprint Manager encounters a color that Infoprint Color 130 Plus
cannot reproduce, it substitutes the closest color value that it can
reproduce.
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Perceptual
When Infoprint Manager encounters a color that Infoprint Color 130 Plus
cannot reproduce, it adjusts all of the colors in the image so that they
maintain their color relationships to each other. The result is an image that
is pleasing to the eye, but that may not look exactly like the original image.

The default value is Relative.

You can set the color rendering intent value on a print job, a default document, or on
an actual destination using either the command line or the Infoprint Manager
Administration GUL The title of this attribute in the Infoprint Manager
Administration GUI is Color rendering intent.

color-toner-saver

When cyan, magenta, and yellow are combined in a certain proportion, the result
approximates black. When the color-toner-saver attribute is set to yes, the
proportion of cyan, magenta, and yellow are reduced and substituted with black
toner, which reduces the amount of color toner used. You can enter the values:

* true or yes

* false or no
The default value is false, meaning that you do not want to use this attribute.

The title of this attribute in the Infoprint Manager Administration GUI is Color
toner saver.

color-toner-saver-supported
This attribute identifies the values that can be specified for color-toner-saver.

The title of this attribute in the Infoprint Manager Administration GUI is Color
toner saver allowed.

Using resource attributes

The resource attributes can be modified from the command line using the pdset
command or in the Infoprint Manager Administration GUI Refer to "Infoprint
Object Attributes” in the [[nfoprint Manager: Reference| for the correct command
syntax when using the command line.

resource-context-presentation-object-container

This attribute adds paths to the directory that Infoprint searches for presentation
object containers (also called data object resources), such as EPS or PDF pages, for
the actual destination.

The title of this attribute in the Infoprint Manager Administration GUI is Location
of presentation object containers.

presentation-object-container-extraction-mode
This attribute specifies the degree of optimization attempted by color transforms.
The possible values are:

* ignore (generates the document without resources by ignoring presentation
object containers)

* inline (identifies and extracts the resources within a document for use)

The default value is ignore.
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Note: Inline transforms always use an extraction mode of ignore.

The title of this attribute in the Infoprint Manager Administration GUI is
Presentation object container extraction mode.

Using the Infoprint Manager Administration GUI to change
color and resource attributes

The Infoprint Manager Administration GUI is an interface for managing Infoprint
Manager jobs, queues, logical destinations, and actual destinations, such as
printers. It runs on multiple platforms, so you can use it either from a Windows
workstation, an AIX workstation, or or directly on the AIX Infoprint Manager
server console.

From the server or from remote work stations, operators can use this interface to
monitor all jobs and printers in the system and to route jobs appropriately to
increase enterprise-wide printing productivity. With the Infoprint Manager
Administration GUI, you can change the color and resource attributes.

Starting the Infoprint Manager Administration GUI
To open the Infoprint Manager Administration GUI from the Windows desktop,
double-click any of the Infoprint Administration icons.

You can start the Infoprint Manager Administration GUI from an aixterm window.
For example, to open an advanced view, type ipguiadvadm at the AIX command
line. You can also use the basic (ipguibasicadm) view.

Changing the attributes
Now that you have opened one of the views of the Administration Infoprint GUI,
you can change the attributes in the actual destination. Follow this procedure to set
the attributes using the GUL

1. Click your Infoprint Color 130 Plus actual destination.

2. Select Options » Customize.

war  Window EelOUEN Help

[ &

Zustormize. ..

Change Connection...
aelect Filter

Figure 17. Options menu

Printer Status hile

heeds attention

3. In the Customize dialog, click the Printer tab.

4. In the Action column, find Change Tuning, Change AFP Resources, and
Change AFP Color, and select the check boxes in the Menu column next to
them.
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Figure 18. Printer menu

This step adds these tasks to the Printer menu. If you want to add other tasks
to the Printer menu or to any other menu, you can do it now or you can wait
until later.

5. Click OK to apply the settings and close the dialog.

6. Select Printer » Change AFP Resources to open the Change AFP Resources
dialog. These fields allow you to specify where resources, such as fonts and
presentation object containers, are located. Refer to[‘Identifying AFP|
[resources” on page 96

7. In the Change AFP Resources dialog, find the Location of presentation object
containers field and type the path where your presentation object containers
are stored. If they are stored in more than one location, list all of the paths
separated with colons (:), for example:

/resources/containers:/dept123/priv-pres-obj- containers:/dept123/
public-pres-obj-containers
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aublic-pres-obj-containers

Figure 19. Change AFP Resources dialog

8. Fill in any other fields that are appropriate. For example, if you use form
definitions, fill in the Location of form definitions field.
9. Click OK to apply the settings and close the dialog.
10. Select Printer » Change AFP Color to open the Change AFP Color dialog.

These fields allow you to modify the color attributes in your job. Refer to
[“Using color attributes” on page 98| for more information.

Chapter 12. Using Infoprint Manager with the Infoprint Color 130 Plus 103



Eurnscale 2

Euroscale nane
] SYWOP
Euroscale

EETEYE:

= E e

EETEYE:

Figure 20. Change AFP Color dialog

11. Click OK to apply the settings and close the dialog.

104 Infoprint Manager for AIX: Procedures



12. Select Printer » Change Tuning to open the Change Tuning dialog. These
fields allow you to modify resource attributes in your job. Refer to
[resource attributes” on page 100 for more information.

Fresentation object container extraction maode |Ign|:|re j
Maximum fonts to keep [0

Maximum overlays to keep |IZ|

b mwciveni imn mmcrnande do lenan In

Figure 21. Change Tuning dialog

13. Click OK to apply the settings and close the dialog.

Sending an AFP job to the printer using the AIX command line

In this example, you have created a document using an AFP statement generator.
This job contains color images that you decide to transform offline. You now want
to submit that document through Infoprint Manager to the Infoprint Color 130
Plus using the command line.

Setting up assumptions
This scenario assumes that you have completed the following tasks:
* [Built an AFP data stream|
+ |Identified location of AFP resources|

« |Created an actual destination for the printer|

* [Transformed color images|

See [“‘Setting up” on page 95| for more information.

Using AIX commands

On any AIX system, the Infoprint AIX client allows authorized users to use the
following Infoprint commands:

e pdls
Lists selected attribute values for a job, destination, or other Infoprint object.
* pdpr
Submits a job to a logical destination.
* pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination,
or of all jobs assigned to an actual destination.

Refer to |Infoprint Manager: Reference or the associated man pages for a complete list
of flags and attributes to use with these commands.

Submitting the job
Complete the following steps to submit the job.
1. To determine whether the logical destination IC130P-1d is ready to receive jobs,
type:
pdls -c destination -r "enabled" IC130P-1d
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You will see the following message if the logical destination is enabled:
enabled=true

2. To submit the file MyJob to the logical destination IC130P-1d and request
two-sided printing and the color-toner-saver attribute, type:

pdpr -d IC130-1d -x "sides=2 color-toner-saver=true" MyJob

Note: The page size and orientation that is specified in the job and in Infoprint
Manager must match that specified at the AFCCU. Otherwise, the job
will print on the page size and with the orientation specified at the
AFCCU.

3. To query all the jobs that you submitted to logical destination IC130P-1d, type:
pdg -d IC130P-1d

In the previous examples —d refers to the logical destination and —x refers to the
attribute string that contains the attribute-value pairs you want to include.

You can use the following attributes from the AIX command line or you can
change them in the Infoprint Manager Administration GUI:

* color-bits-per-plane

* color-bits-per-plane-supported
* color-rendering-intent

* color-toner-saver

* color-toner-saver-supported

* resource-context-presentation-object-container

Refer to[“Using and changing color and resource attributes” on page 98| for details
on when and how to use these attributes.

Sending an AFP job with color images to the printer using Infoprint
Submit

You have created an AFP document using a page layout application and are using
Infoprint Submit to send it to the Infoprint Color 130 Plus.

Setting up assumptions

This scenario assumes that you have completed the following tasks:

* [Built a data stream|

* |Created an actual destination|

¢ Installed Infoprint Submit

See |”Setting up” on page 95| for more information.

Submitting the job

When using Infoprint Submit to create the job ticket, you must consider a number
of things to prepare a job for printing. Primarily, however, during this phase of the
process, you will identify and organize the printable files and other resources that
make up the job. As you complete the job ticket, Infoprint Submit provides a
format in which you can specify the details necessary to process a job effectively.
You generate the printable files that you submit to Infoprint Manager file by file
from the application that you use for authoring.
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Note: Use the Help menu from the Job Ticket window or the Help button on the
dialogs to guide you.

Creating a new job ticket
In this example, you will create a new job ticket named MyJob. You adjust color
attributes and then submit the job.

Note: When you use Infoprint Submit to send a job to the printer, you do not need
to have previously created a form definition. If you have a form definition it
overrides the attributes you specify in Infoprint Submit.

1. Start Infoprint Submit. The Job Ticket window displays.
2. Fill in all the fields with appropriate information.

3. Insert the files into your job ticket that you want to include in the job. Click
Help » Help Topics... if you have questions.

* To insert new files into the document, click Item » Insert File on the menu
bar. The Select files dialog box displays. Select the files you want to add to
the document from the Select files dialog box and click Select.

4. Specify the layout you want in the Layout tab.

5. Select Infoprint Color 130 Plus from the Printer type drop-down list on the
Print tab.
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Figure 22. Print tab

6. Specify page alignment on the Align tab.

Note: You must specify the same page size and orientation at the AFCCU as
you do in the job, otherwise the page size and orientation specified in
the AFCCU will override that specified in the job.

7. Choose the values for the color attributes on the Look tab. You can use the
following attributes in Infoprint Submit:

e Color Profile
e Color Bits Per Plane
¢ Color Toner Saver
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Refer to [“Using and changing color and resource attributes” on page 98| for
details on when and how to use these attributes.

8. Click the Advanced tab, find RIP for, and select Infoprint Color 130 Plus
from the drop-down list.

Note: If Infoprint Color 130 Plus does not appear in the drop-down list

upgrade to the most recent service level.
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9. Save the job ticket by clicking Ticket + Save As....
10. Submit the job by clicking Ticket »+ Submit Job.

Refer to Using Infoprint Submit that is shipped with the separately orderable
feature.

Sending a job to the printer using Infoprint Select

A document created in a Windows application, such as PageMaker or
QuarkXPress, is submitted through Infoprint Select for printing to the Infoprint
Color 130 Plus.

Setting up assumptions

This scenario assumes that you have completed the following tasks:

Created an actual destination for the printer]

* Installed Infoprint Select
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¢ Cenfigured the server to use Infoprint Select

See [“Setting up” on page 95| for more information.

Submitting the job

Infoprint Select allows you to submit jobs from an IBM Operating System/2

(0S/2) or Windows workstation to a printer that is managed by Infoprint. You can
print from applications or from the MS-DOS command line. In this example you
are using a Windows application, such as PageMaker or QuarkXPress, on Windows
NT to create a document and send it to Infoprint Color 130 Plus through Infoprint
Select.

Adding a Select printer to your workstation
Before you can use Infoprint Select to submit a job to a printer, you must define

the printer on your workstation.

The instructions to define a printer on the Windows NT workstation follow. Refer
to "Using Infoprint Select to Submit a Job” in the [I[BM Infoprint Manager for AIX{
[User’s and Operator’s Guidd for information on defining printers on other platforms.

Windows NT: To define a new printer to Windows NT, follow these steps:
From the Start menu, select Settings, then Printers.

Double-click the Add Printer icon to start the Add Printer wizard.

In the first pane of the wizard, select My Computer and click Next.

In the list of available ports, select Infoprint and click Configure Port.
Fill in the Host Name and Host Port fields.

In the Print Server field, select Infoprint Manager; then click Refresh Printer
List.

o0k~ wbd =

Note: Windows NT saves your entries in the Host Name, Host Port, and
Print Server fields for future printer definitions.

7. Select your Infoprint Color 130 Plus printer from the list and click OK.
8. Click Next.
9. Click Have Disk.

10. Select the directory where Infoprint Select is installed and click OK.

11. Select the Infoprint Color 130 Plus from the printer model list and click
Next.

12. Either accept the default name for the printer or enter a name of your choice.
This name will appear under the printer icon.

13. If you want applications to use this printer as the default printer, select Yes.
Otherwise, select No.

14. Refer to the Microsoft documentation to help you select the Share or Not
Share option.

15. When you are prompted to print a test page, select No.

16. Click Finish. The printer definition is complete.

Printing from Applications

Infoprint Select allows you to print to the Infoprint Color 130 Plus just as you
would to any other Windows printer. Click File » Print. Infoprint Select works
with the print facility of each application, so printing from each program gets a
little different from here on out. A typical application may allow you to specify a
printer other than the default, the number of copies, or a range of pages.

Chapter 12. Using Infoprint Manager with the Infoprint Color 130 Plus 111


http://publibfp.boulder.ibm.com/epubs/pdf/ipro3mst.pdf
http://publibfp.boulder.ibm.com/epubs/pdf/ipro3mst.pdf

Note: The page size and orientation that is specified in the job and in Infoprint
Manager must match that specified at the AFCCU. Otherwise, the job will
print on the page size and with the orientation specified at the AFCCU.

Printing from the Command Line
Infoprint Select allows you to enter the following Infoprint commands on the DOS
command line:

e pdls
Lists selected attribute values for a job, destination, or other Infoprint object.
* pdpr
Submits a job to a logical destination.
* pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination,
or of all jobs assigned to an actual destination.

The [[nfoprint Manager: Referencd and associated man pages provide information
about Infoprint commands and attributes and show several examples of each
command that you can issue from Infoprint Select. This section contains examples
using the commands to perform some common tasks.

Querying Destination Attributes: To determine whether the logical destination
IC130P-1d is ready to receive jobs, type:

pdls -c destination -r "enabled" IC130P-1d

You will see the following message if the logical destination is enabled:
enabled=true

Submitting a Job: To submit the file MyJob to IC130P-1d and request two-sided
printing and the color-toner-saver attribute, type:

pdpr -d IC130P-1d -x "sides=2 color-toner-saver=true" MyJob

Querying Jobs: To query all the jobs that you submitted to logical destination
IC130P-1d, enter:

pdgq -d IC130P-1d

Changing color and resource attributes
Refer to[“Using and changing color and resource attributes” on page 98| for
information on changing attribute values.

Sending a job using Download for OS/390

112

You have created an AFP document using a page layout application and are using
Download for OS/390 to send it to the Infoprint Color 130 Plus.

Download for OS/390 automatically transmits data from the job entry subsystem
(JES) spool to remote systems using TCP/IP. This eliminates the need for manual
print file transfer using File Transfer Protocol. A cooperating print server running
on a remote system receives the data sets for printing with Infoprint Manager for
AIX. For most jobs, you can use the same job control language (JCL) that you
would use for non-AFP printers, changing only the MVS routing information to
direct your job to the Infoprint Color 130 Plus.
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Note: You can use IBM’s Page Printer Formatting Aid (PPFA) to create form
definitions and page definitions when creating the data stream. Refer to
http:/ /www.ibm.com/printers /R5PSC.NSF/Web /ppfa for information on
how to use PPFA.

If you are using Download for OS/390 to submit jobs to the printer, refer to "Using
JCL for Advanced Function Presentation” and "Printing Tasks and Examples” in the
|Print Services Facility for OS5/390: User’s Guide| for specific printing tasks and

examples. You can also refer to [Print Services Facility for OS/390: Download for|
05/390| for more information.
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Chapter 13. Infoprint Manager’s impositioning solution

In the printing world, impositioning consists of the arrangement of pages so they
will appear in proper sequence after press sheets are folded and bound.
Commercial printers who create signature-based documents with frequent layout
changes, while the content remains relatively static, will find value in Infoprint
Manager for AIX’s impositioning solution.

Users can take advantage of the wide-carriage web of the IBM 4100 Advanced
Function Printing System to print up to 19.5 inches across for the creation of
signature-based documents. Most importantly, this solution allows for frequent
minor adjustments to existing signature document layouts, without reRIPping the
entire job at the Infoprint AIX server. See [“Prerequisites for the Infoprinf
impositioning solution” on page 116 for a list of the prerequisites necessary to
implement this impositioning solution.

For example, if a publishing house decides to use a heavier bond of paper that
results in significant page creep, or if pages need to be rotated differently because
a different sequence of folds is required for an available postprocessor, Infoprint
Manager’s impositioning solution allows them to make changes to the layout
without having to submit and reRIP the job content. This flexibility is the result of
Infoprint Manager for AIX’s Print Optimizer.

The Infoprint Manager for AIX Print Optimizer works in the background to
maintain a database of RIPped page images. These RIPped page images contain
only the information about a page’s content and have no information about page
layout. If only the layout is modified and the page content remains unchanged,
these images do not change. The print jobs consist of signatures (a sheet with
many pages and optional marks for later folding and trimming), which will be
folded and stitch-bound into books. Print jobs can also contain content. When you
re-print a job changing only its layout, the page images stored at the printer are
used, resulting in significant network traffic reduction. If the printer has been shut
down before the job is re-printed, these RIPped page images are obtained from the
Infoprint AIX server and do not have to be reRIPped.

The Print Optimizer:
1. Uniquely identifies each page in a PostScript or PDF source file.

2. Converts the PostScript or PDF page into an Advanced Function Presentation
(AFP) resource.

3. Stores the RIPped pages as resources that are accessible by Infoprint Manager.

This topic describes how you can install and configure impositioning support in
order to submit Adobe Portable Job Ticket (*.pjtf) files to the Infoprint Manager
server so you can better manage and track print jobs containing signatures that
will be folded and stitch-bound into books. Once Infoprint Manager is configured
to support impositioning, you can create *.pjtf files using the third party ScenicSoft
Preps 4.0 impositioning product, submit those jobs using an Infoprint Manager hot
folder or other Infoprint Submission method, and use the Infoprint 4100 Advanced
Function Printing System to print out the results. Additionally, by sending only the
* pjtf files (see [“Infoprint impositioning terms” on page 117) to the server when
changes only affect the layout or page order, you should experience significant
performance benefits.

© Copyright IBM Corp. 1998, 2002 115



Note: While other software impositioning products can output *.pjtf files, the
Infoprint impositioning solution has only been tested using ScenicSoft Preps
4.0. When using Preps, ensure that the finished page size is the same page
size as the content file (see [‘Infoprint impositioning terms” on page 117)
page size. For example, if your content file is an Adobe Acrobat file (PDF
format) containing pages 6 inches by 9 inches in size, then you should set
your finished page size in Preps to 6 inches by 9 inches. Infoprint
impositioning does not support scaling and page cropping can result in
unsatisfactory print output.

Prerequisites for the Infoprint impositioning solution
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To use the Infoprint Manager Impositioning solution described in this document,
you must install the following components.

Note: If you are running DCE for Infoprint Manager on your Infoprint Manager
for AIX server, you cannot use this Impositioning solution.

* IBM Infoprint 4100 Advanced Function Printing System

Ensure that this printer contains the Version 11.2.42 or higher release of the
Advanced Function Common Control Unit (AFCCU) microcode for High End
Continuous Forms Printers. This microcode level is the first to incorporate the
new IPDS pre-RIP (RPO) command that reduces overhead before printing the
first page of a job that has been printed previously. This command is essential
for the impositioning solution because it prevents the printer from clutching
(waiting on data to finish processing in the middle a job printing) on
Impositioning jobs.

On the printer, ensure that you install and enable the Request for Price
Quotation (RPQ) 8B4053 for supporting the 54 inch paper required for this
solution. While installing this RPQ, note that it checks the memory available on
the printer and requires additional memory if the minimum amount required for
the RPQ is not available. In addition, you can order a hardware buffer unit to
reside on the floor in the paper path following engine #1 to accomodate the
larger paper size. For more information, access the "Signature Page” option from
chapter 1 of the Infoprint 4000 and Infoprint 4100 Models with Enhanced Operator
Console: Planning and Configuration Guide, G544-5798-01, or consult your Printing
Systems sales representative.

Note: To use the Impositioning solution, you must ensure that Print On Demand
(POD) mode is turned off at the IBM Infoprint 4100 Advanced Function
Printing System’s controller console.

* Infoprint Manager Version 4 Release 1 with the Print-On-Demand feature

For more information about applying service, see Infoprint Manager for AIX:
Getting Started.

* A third-party impositioning product, such as ScenicSoft Preps, to produce the
Portable Adobe Job Ticket files

When using Adobe Portable Job Ticket Format (PJTF) job tickets, the
recommended impositioning software is ScenicSoft Preps Pro (R) Version 4.0.
When using PJTF job tickets, configure Preps Pro 4.0 to place printer marks in
the job ticket rather than in a separate file. Please note that PJTF files from Preps
Pro 4.1 are not supported by Infoprint and cannot be used for this solution. You
can obtain more information about this product from the ScenicSoft web site at
http://www.scenicsoft.com/products/Preps/index.html.
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Infoprint flow for impositioning jobs

This section presumes that you have already:

1. Created the appropriate PDF and PostScript documents through a software
package like QuarkXPress.

2. Run these files though an impositioning program like ScenicSoft’s Preps to
create the Adobe Portable Job Ticket (*.pjtf) files.

Infoprint impositioning terms
Before describing the job flow and eventual output, the following impositioning
terms must be defined:

content files
One or more PDF (*.pdf) or PostScript (*.ps) files that contain the print
data from a commercial software program (such as QuarkXPress or Adobe
Photoshop) that has been submitted to the ScenicSoft Preps impositioning
software in order to create the layout files.

layout file
The Adobe Portable Job Ticket files (*.pjtf ) that are the output of the
SoftScenic Preps impositioning software. These files contain the layout
specifications in a signature format derived from the specific content files.

original job
One or more files submitted to Infoprint Manager for impositioning,
usually through a hot folder.

The original job is either:

* split into a printing job and a priming job

or

* turned into just a priming job (if prime-only=true).

priming actual destination
Indicates the print optimizer actual destination.

priming job
A job sent to the priming logical destination and subsequently processed
by the priming actual destination.

priming logical destination
Indicates the Infoprint logical destination that feeds jobs to the Print
Optimizer actual destination. This object is created by the Print Optimizer
creation wizard with the naming convention adname-1d where adname
represents the name you choose in [“Creating the priming (print optimizer
IDSS) destinations and queue” on page 129

printing actual destination
Indicates the PSF DSS actual destination that prints the job.

printing job
A job sent to the printing actual destination and subsequently processed by
the PSF DSS.

printing logical destination(s)
Indicates the logical destination or destinations that send priming jobs to
the priming logical destination and send printing jobs to the printing
actual destination.
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Impositioning job flow overview

Composition
Application

Now, you are ready to print both the content files (*.ps and *.pdf) with the layout
specification files (*.pjtf) to an Infoprint 4100 Advanced Function Printing System.
Throughout this chapter, the term original job implies both the source PostScript
or PDF files and the Adobe Portable Job Ticket file (*.pjtf) in the same job, unless
otherwise stated.

End-user

— —

% Original Job

Priming
Job

Printing
Job

Print Optimizer
DSS PSF DSS

<+
IMPOVER

Figure 25. Overview of the Infoprint job flow for impositioning jobs
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provides a high-level view of the processing flow of impositioning jobs
in an Infoprint system. Note that the original job coming from either the end user
or the composition application (such as QuarkXPress) travels through the Software
impositioning program (the unlabeled page, representing a *.pjtf file or files that
has been processed by an impositioning software program, such as Preps) before it
is placed in the hot folder on the Infoprint AIX server. Then, the printing logical
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destination picks up the original job from the hot folder. At this time, Infoprint
Manager assigns a job ID to the printing job for tracking purposes.

The printing logical destination then sends the priming job to the priming logical
destination. At this time, Infoprint Manager assigns a job ID to this priming job
(still both the PostScript or PDF source files and the Portable Adobe Job Ticket File)
for tracking purposes. This explains why there are two Infoprint Manager job IDs
that iou can track, using the tools described in |”Troubleshooting impositioning” onl

pag 8

The priming logical destination feeds the Print Optimizer queue, which funnels
jobs to the priming actual destination. Once the priming actual destination starts
processing the priming job, the printing logical destination starts processing the
printing job. As it needs AFP pages to print, the printing logical destination
queries the priming actual destination. If these pages have not finished processing
at the Print Optimizer, the printing logical destination waits for them to finish
processing.

Guidelines for submitting impositioning jobs to Infoprint
Manager

The following guidelines should be followed when creating and submitting
Impositioning jobs to Infoprint Manager.

1. If a prime-only job was used, the corresponding impositioning jobs should be
submitted through the same logical destination where the prime-only job was
submitted.

2. If you use the same actual destination for both general printing and
impositioning, use two separate logical destinations to feed it jobs.

3. If you are compelled to shut down the printing actual destination while an
impositioning job is processing, the job will not print and you will need to
place the original job in the hot folder again.

4. Specify high values for both the Release time (sec) and the Maximum

presentation object containers to keep fields as shown in

Setting the Maximum presentation object containers to keep field (or the
maximum-presentation-object-containers-to-keep attribute on the command
line) to a high value ensures that data stays at the printer for a longer period,
reducing network traffic when reprinting jobs. Please note that the size of this
attribute depends upon the size of the largest PostScript or PDF source file that
you are processing. This attribute should be set by taking the largest possible
value (32511) and subtracting it from your largest PDF or PostScript source file
For example, if your largest PDF or PostScript source file is 500 pages when
printed, you should set the Maximum presentation object containers to keep
field to 31511 (32511 — (500 x 2).

Ensure that Optimize for copies is set to no, as shown in [Figure 27 on page 122|

Impositioning jobs must be no larger than 19.5 X 53 inches for each sheet.
Do not submit multiple Adobe Portable Job Tickets within the same job.

© N o o

Because plex values (whether the job is to be printed simplex, duplex, or
tumble) are ignored within the Adobe Portable Job Tickets, you must use the
following Infoprint Manager attributes to specify these settings:

* plex
* plex-supported
* sides

* sides-supported
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The plex-supported actual destination attribute can be modified when you
define the printing actual destination in step 5 of [“Creating printing (PSF DSS)|

[destinations to use the print optimizer” on page 131]

You can specify the sides document attribute in the initial value document (ivj)
of the printing logical destination through the following procedure:

a.

From the main view of the Infoprint Manager Administration GUI, click
on the Logical Destinations icon.

From the Logical Destinations view that appears in the right pane
right-click on the printing logical destination that you defined in |”Creatina
[printing (PSF DSS) destinations to use the print optimizer” on page 131[and
select Job and Document Defaults + Modify....

From the Job and Document Defaults view, select the Document Layout
tab.

From the Document Layout tab view, you can specify duplex jobs by
defining the Sides to print field (the Sides attribute) as 2 and allowing all
other attributes to take the default, as shown in [Figure 26 on page 121}
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Job and C ment Defaults lp-impos

gli4

Figure 26. Document Layout tab view

9. Because positioning of the job on the page should be left to the Adobe Portable
Job Ticket, ensure that the following attributes are set to 0 in an Impositioning
job:

* x-image-shift (Move image right (inches or (mm) field)

* x-image-shift-back (Move image right (inches or (mm) field)
* y-image-shift (Move image down (inches or (mm) field)

* y-image-shift-back (Move image down (inches or (mm) field)
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PSF TCP/IP Printer P

,m This notebook shows properties for the selected actual destination.

Find criteria Field to find

pp—impos

_ [ |

These properties are used for performance tuning of the actual destination.

Maximum presentation object containers to keep [100

Maximum concurrent johs [a
Optimize for copies ) ¥es @ No
Release time (sec) [3333 |
Attempt to register with server Hours | O Minutes | 10
Connection timeout {sec) [20 |
Non—process runout timer {sec) [50 |
Acknowledgement interval {pages) [1o0 |
Intervention timer {(sec) EEEE] |
Public presentation object containers [ |
Reuse inline presentation object containers ) ¥es @ No
Presentation object container extraction mode | Ignore - |
Maximum fonts to keep [10 |
Maximum overlays to keep |0 |
Maximum segments to keep [o |
|

Figure 27. PSF DSS Actual Destination Properties notebook

Modifying both the content and the layout of impositioning

jobs

This job flow describes what happens when both the impositioning job’s contents
and layout specifications must be processed through Infoprint Manager. You will
use this scenario the first time a print installation submits an impositioning job to
Infoprint Manager. Please note that the first time you submit any job to the Print
Optimizer through the hot folder, you must include all the print files (either *.ps or
* pdf files) and the pjtf file required with the job.

Once it has been optimized, you need only specify the Adobe Portable Job Ticket
file (*.pjtf): the print files will be run without your having to specify them again.

Note that[Figure 28 on page 124] displays the job flow described in the following,

step-by-step sequence.

1. The original job (consisting of the *.pjtf file and the all print file(s)) is

submitted through the hot folder.

122
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The printing logical destination picks up the original job from the hot folder.

The printing logical destination sends the priming job to the Print Optimizer
through the priming logical destination.

The printing logical destination sends the printing job to the printing actual
destination that is associated with it.

Both jobs process in parallel in the priming actual destination (Print
Optimizer) and the printing actual destination .

As content pages get processed to print, the printing actual destination queries
the Print Optimizer and waits for the pages, if necessary.

Use the print-optimizer-synchronization-time-out actual destination attribute
to control the time limit allowed. In the Infoprint Manager Administration GUI,
this attribute is located on the Configuration tab of the Properties window for
the printing actual destination.

The Print Optimizer completes processing the priming job and saves all
changes in the Resources (defaults to /var/pd/servernamel/resources/) data base.

The printing actual destination finishes the printing job from the .pjtf file.
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Figure 28. Job flow for modifying both content and layout
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Modifying the layout of impositioning jobs without changing

content

A user may need to make layout changes to an impositioning job without altering
the job content created with the original job. To accomplish this task, they use the
following scenario.

Note that [Figure 29 on page 126 displays the job flow described in the following,
step-by-step sequence.

1.

The original job (consisting of the changed *pjtf file only) is placed in the hot
folder.

The printing logical destination picks up the original job from the hot folder.

The printing logical destination sends the priming job to the Print Optimizer
through the priming logical destination.

The printing logical destination sends the printing job to the printing actual
destination that is associated with it.

Both jobs process in parallel in the Print Optimizer and the printing actual
destination.

The Print Optimizer completes processing, with no changes occurring in the
Resources (defaults to /var/pd/servername/resources/) data base because no
content files were submitted with the job.

The printing actual destination gets the AFP pages from the Print Optimizer
resource data base.

The printing actual destination finishes the printing job from the .pjtf file, with
no changes to content, and no waiting for Print Optimizer resources.
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Submitting impositioning jobs for printing later (prime-only

jobs)

A user may need to RIP an impositioning job first (for example, during the first
shift), but for performance reasons hold the job and print it later (for example,
during third shift). Infoprint Manager provides a performance benefit by reducing
the time it takes the first page to print. For example, a user can submit the content
files in multiple batches at various times. Each batch of content files requires a
pjtf file that specifies the size of the pages being submitted to the Infoprint AIX
server; however, the pjtf file does not have to specify every AFP page that will be
used in the job when Infoprint Manager merges all the batches.

To submit prime-only jobs, they will use this scenario. All RIPped data is stored on
the Infoprint AIX server, but nothing is printed until later.

The following represents the job flow for a prime only job. :
1. The original job (consisting of a *.pjtf file, the content files, and a *.att file) is
placed in the hot folder.

The *.att file contains the single line prime-only=true. For more information
about using *.att files, see [“Specifying attributes for impositioning jobs” onl

2. The printing logical destination picks up the original job from the hot folder.

3. The printing logical destination sends the priming job to the Print Optimizer
through the priming logical destination, but sends nothing to the printing
actual destination because of the setting of the prime-only attribute.

4. The Print Optimizer processes the priming job.

5. Once the priming job has finished processing in the Print Optimizer, Infoprint
saves the RIPped content in the Resources (/var/pd/servername/resources/) data
base.

Later, just the pjtf file can be submitted to actually print the job without
reprocessing it in the Print Optimizer.
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Figure 30. Job flow for prime only jobs
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Configuring Infoprint Manager for impositioning

Before you can use impositioning function in Infoprint Manager, you must
complete the following configuration tasks on your Infoprint AIX server.

» |“Creating the priming (print optimizer DSS) destinations and queue”}

* |“Creating printing (PSF DSS) destinations to use the print optimizer” on|
page 131

* |“Connecting the printing logical destination to the logical destination Createdl
with the print optimizer” on page 132}

+ [“Setting up hot folders to submit impositioning jobs” on page 134

Creating the priming (print optimizer DSS) destinations and
queue

The priming (Print Optimizer DSS) actual destination processes the job layout
specifications for impositioning jobs, before a printing actual destination (PSF DSS)
sends the printing job to the Infoprint 4100 Advanced Function Printing System.
The Print Optimizer primes the server with content pages that are necessary before
a job can be processed by the printing actual destination (the PSF DSS actual
destination that prints the job).

The priming logical destination feeds jobs to the priming (Print Optimizer DSS)
actual destination. Once the priming actual destination begins processing a job,
the PSF actual destination can begin processing the job. The data is formatted into
one-page AFP resources, and the output data stored in the database and resources
directory.

This following procedure creates a priming actual destination, a priming logical
destination, and a queue. If you are using the Basic Infoprint Administration
GUI, the queue is not visible. Use the Create Other Destination Wizard in the
basic view of the Infoprint Manager Administration GUI to create an actual
destination.

Note: You can only create a single Print Optimizer actual destination on an
Infoprint AIX server.
1. Start the Infoprint Manager Administration GUL
¢ From the AIX desktop in a basic environment, you can select the arrow over
the Infoprint icon to display the IBM Infoprint pop-up, and then select the
Basic Administration GUI view.
* From the command line, enter ipguibasicadm.

2. Select Other » Create » Print Optimizer.

Note: If you do not have this option, select Options » Customize. In the
Customize dialog, click the Other tab. In the Action column, find Create
Print Optimizer and select the check box in the Menu column next to it.
This step adds this task to the Other menu. Click OK to apply the
settings and close the dialog.

3. In the first panel of the Create Other Destination Wizard (displayed below), do
the following:
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Create a new print optimizer..
|E',; Narne, Server, and Cptimize for printer are required to
I ; create a print optimizer. Values for the remaining fields
will be set by the server if not specified.

Print Optimizer

Name 'p—opt |
Server southpark -
Optimize for printer Infoprintd100—-PD1-PD2| w
Location of resources | |
Resource space threshold | |
Print Optimizer server port | |

Mext> Finish> Cancel Help

Figure 31. First dialog of the Create Print Optimizer Wizard.
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a.

Type a name for the printer in the Name field (for this example, p-opt).

b. Verify that the server is correct in the Server field.
c. Select Infoprint4100-PD1-PD2 from the Optimize for printer drop-down

list.

Note: If that model is not shown, you must update Infoprint Manager to
the current service level as described in [“Prerequisites for thel
[Infoprint impositioning solution” on page 116]

Specify a full directory path for the Location of Resources field if you want
a location other than the default (/var/pd/servername/resources/).

Click either Next or Finish.

If you click Finish, Infoprint Manager creates a Print Optimizer actual
destination, logical destination, and queue, taking all the system defaults
and enabling these Infoprint objects. If you click Next, you continue onto
the next step.

Note: Infoprint Manager creates a logical destination (in the form
adname-1d, where adname is the name you provided for the print
optimizer) and queue (in the form server_name-print-optimizer-q) for
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you. Remember the logical destination name because you will need it
when configuring the logical destination in the next section.

4. In the second panel, you can customize job and document defaults, and change
the default hot folder location, or select Next.

5. In the third panel, you can choose to change the actual destination
configuration or click Next.

6. On the final panel click Finish.

Now you have a Print Optimizer actual destination, a logical destination, and
queue which will feed jobs to it. In the next procedure, you will configure a PSF
DSS actual destination that will handle the content of the impositioning job.

Creating printing (PSF DSS) destinations to use the print

optimizer
This step is necessary to create a PSE DSS actual destination that will use the
configuration created in [“Creating the priming (print optimizer DSS) destinations]
land queue” on page 129] The printing actual destination represents the physical
output device, the Infoprint 4100 Advanced Function Printing System. The
printing logical destination that sends priming jobs to the priming logical
destination before sending printing jobs to the printing actual destination, is
created as a result of the procedure in the next section: [“Connecting the printin

logical destination to the logical destination created with the print optimizer” on|

page 132,

The Infoprint 4100 must be a PSF DSS printer, so use the Create Other Destination
Wizard in the Infoprint Manager Administration GUI to create an actual
destination.

1. Start the Infoprint Manager Administration GUL

¢ From the AIX desktop in a basic environment, you can select the arrow over
the Infoprint icon to display the IBM Infoprint pop-up, and then select the
Basic Administration GUI view.

* From the command line, enter ipguibasicadm.
2. Select Printer » Create » PSF » TCP/IP.
3. In the first panel of the Create Printer Wizard, do the following:
a. Type a name for the printer in the Name field.
b. Verify that the server is correct in the Server field.
c. Select Infoprint4100-PD1-PD2 from the Model drop-down list.

Note: If that model is not shown, you must update Infoprint Manager to
the current service level as described in |”Prerequisites for thel
[Infoprint impositioning solution” on page 116

d. Type the TCP/IP address and port number for the printer in the correct
fields.

e. Click either Next or Finish.

If you click Finish, Infoprint Manager creates a PSF TCP/IP actual
destination, logical destination, and queue, taking all the system defaults
and enabling these Infoprint objects. If you click Next, you continue onto
the next step.

Note: Infoprint Manager creates a logical destination for you, in the form
adname-1d).
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4. In the second panel, you can customize job and document defaults, and change
the default hot folder location, or select Next.

5. In the third panel, you can choose to change the actual destination
configuration or click Next.

The Plexes-supported actual destination attribute correctly defaults to tumble,
but can also be set to simplex.

6. On the final panel click Finish.

Now you have a PSF TCP/IP actual destination that you can use to print the job
output from your impositioning jobs.

Connecting the printing logical destination to the logical
destination created with the print optimizer

Now you must link your printing logical destination to the priming logical
destination created in [’Creating the priming (print optimizer DSS) destinations and|
lqueue” on page 129}

Note: Ensure that you repeat this procedure for every logical destination which
will be used to feed impositioning jobs to the printing actual destination.

1. From the Main window of the Infoprint Manager Administration Servers
basic view, highlight the Logical Destinations icon from the Destinations pane
so that all the logical destinations display in the main pane.

2. From the printing logical destination (a logical destination feeding the PSF
DSS actual destination), right-click and select the Properties option from the
drop-down menu.

Note: If the Properties option does not display, click on the Add/Remove
Menu Items option and check both the Menu and the Toolbar boxes
from the Customize dialog to add the Properties option.

3. From the Properties notebook for the logical destination, specify the name of
the logical destination that you created in [’Creating the priming (print|
[optimizer DSS) destinations and queue” on page 129in the Priming
Destination field.

Note: From the Properties Notebook window, you may need to click on the
Show more button in the lower left corner to see the Priming
destination field as displayed below:
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Figure 32. Properties notebook for the Print Optimizer’s logical destination

IBM recommends that you set the Hot folder location field to something
similar to /var/pd/hotfolder/ld_name to clearly associate the hot folder directory
with the logical destination that feeds impositioning jobs into the system. For
more information about setting up a hot folder and using it to submit jobs, see
[“Setting up hot folders to submit impositioning jobs” on page 134
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Setting up hot folders to submit impositioning jobs

The simplest way to submit jobs to Infoprint is to use a hot folder. A hot folder is a
directory that is associated with a logical destination. When you copy or move a
file to the hot folder, Infoprint automatically submits that file as a job to that
logical destination.

If you do not explicitly specify a hot folder directory, then a logical destination will
not have a hot folder (there is no default hot folder). If you explicitly specify a hot
folder directory, the server will create it for you; however, the path up through and
including the parent directory of the hot folder directory must already exist on
your Infoprint AIX server. For example, if you specify /var/pd/hotfolders/lp-impos/
as your hot folder, you must have previously created the directory /hotfolders and
its subdirectory /Ip-impos.

Note: You should make a copy of any jobs that you will be placing in a hot folder.
After you have put them in the folder, files are submitted and then deleted.

Creating a hot folder
To create a hot folder:

1. Make sure that file sharing is available on the Infoprint server system. Many
file sharing methods are available, but IBM recommends the methods shown in

[Table 14

Table 16. Recommended file sharing methods

Server Client Method Refer to

AIX AIX Network File Sharing | System Management Guide:
(NFS) Communications and Networks

AIX Windows | AIX FastConnect for System Management Guide:]
Windows Communications and Networks)|

Windows | Windows |Server Message Block | Windows help
(SMB) (standard
Windows folder
sharing)

2. Select a location on the Infoprint server system for the hot folder. If all hot
folders are subdirectories of the same directory, users can access them all with a
single connection (through a mount command or some form of file sharing) to
the parent directory.

3. If the hot folder does not exist, you may optionally create it. Be sure to give it
the appropriate universal or group write permission.

e If the hot folder already exists, or if you create it now, it will remain after
you delete the associated logical destination.

e If it does not exist and you do not create it now, it will be created
automatically in the next step and will be deleted when you delete the
associated logical destination.

4. Set the hot-folder-directory attribute for the logical destination to the full path
name of the hot folder as it is known on the server system.

You can do this either when you create a logical destination or afterwards.
Refer to|“Connecting the printing logical destination to the logical destination|
[created with the print optimizer” on page 132[or the Infoprint Manager
Administration GUI online help for instructions. Note that a hot folder can be
associated with only one logical destination; and a logical destination can be
associated with only one hot folder.
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You can do this either when you create a logical destination or afterwards.
Refer to the Infoprint Manager Administration GUI online help for instructions.
Note that a hot folder can be associated with only one logical destination; and
a logical destination can be associated with only one hot folder.

Note: Just like any other Infoprint job submission method, attribute values
specified in a default document and in default job attributes for the logical
destination are used for all jobs submitted through the hot folder, unless the
job submitter overrides them.

Accessing a hot folder

From a client system, you can access the hot folder in the same way as any shared
directory. You do not have to install any Infoprint client software. For more
information, see the references in [Table 16 on page 134}

Note: If multiple hot folders are subdirectories of the same directory, Windows
users can map a single drive to the parent directory rather than mapping a
drive for each hot folder.

Submitting impositioning jobs through a hot folder
To submit a file through a hot folder, simply copy or move it to the hot folder.

Attention: If you want to save the file, copy it. Files are deleted from the hot
folder after submission.

Staging impositioning jobs: Because it takes time to copy or move files, Infoprint
may try to submit a large job before it is completely in the hot folder. You can
prevent the submission of partial jobs by staging large jobs.

To stage a job the first time you submit it (you submit the source PDF or PS file
and a PJTF file):

1. Create a subdirectory that ends with the extension .stg and place it in your hot
folder. Infoprint ignores files and folders with this extension.

2. Copy your source PDF or PS file or files and PJTF file to the newly created
subdirectory.

3. When the copy is complete, rename the subdirectory by removing the .stg
extension.

4. Infoprint will now process the impositioning job.

To stage subsequent submissions that take advantage of stored resources (you
submit a PJTF file only):

1. Copy the PJTF file to the subdirectory within the hot folder with extension .stg.
Infoprint ignores files with this extension.

2. When the copy is complete and you are ready to submit the job, rename the
subdirectory by removing the .stg extension.

Submitting multiple-document impositioning jobs: To print multiple documents

in a single job:

1. Create a subdirectory in the hot folder called jobname.stg, where jobname is any
name you choose. The .stg extension prevents Infoprint from processing the
directory.

2. Copy the documents you want to print into the subdirectory in the same order
that you want to print them.
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Note: If you copy multiple files in a single operation, they may not be copied
in the same order that you selected them. If the print order matters, copy
the files one at a time.

When using multiple documents in an impositioning print job, your chances of
a transform timeout are reduced if the documents are in the approximate order
they are used in the job ticket. For example, ensure that a cover is placed before
the contents of a job to avoid the cover being used on the first sheet so the
transform does not have to wait for the print optimizer to RIP through the
entire book content.

Specifying attributes for impositioning jobs: By default, jobs submitted through
a hot folder use the attribute values in the default document and default job
associated with the logical destination.

To override these values the first time you submit an impositioning job (you
submit a source PDF or PS file and a PJTF file), complete the following steps:

1. Create an attributes file called jobname.att, where jobname is the same as the
subdirectory name you created with the .stg extension, and copy it into the
subdirectory.

2. Rename the subdirectory from jobname.stg to jobname. Infoprint then submits all
the files in the subdirectory as a single job.

For example, if you have specified /var/pd/hotfolders/1p-impos/ as your hot
folder, create a subdirectory named impos_job.stg. Then create an attributes
file named impos_job.att. Copy impos_job.att into the impos_job.stg
subdirectory, along with the source PDF or PS file and the PJTF file. Then
rename impos_job.stg to impos_job. The job is submitted to the Print
Optimizer.

For subsequent submissions of impositioning jobs (you submit a PJTF file),
complete the following steps to override these values:

1. Create an attributes file named filename.att, where filename is the same as the
file name of the print file.

For example, if the print file is report.pjtf, the attributes file is
report.pjtf.att. In this file, specify the attributes and values that you want.
For example, if you want to print three single-sided copies of report.pjtf,
report.pjtf.att looks like this:

copy-count = 3
sides =1

Note that this file is the same format as an attribute file specified with the -X
flag on a pdpr print command. For information about job and document
attributes, refer to Infoprint Manager: Reference.

2. Copy or move the attributes file to the hot folder. The .att file extension tells
Infoprint not to print the attributes file. You must ensure that the attributes file
is either copied or moved to the hot folder before you copy or move the print
file to the hot folder.

Note that this step is optional because you can create the attributes file within
the Hot Folder directory.

3. Copy or move the print file to the hot folder. Infoprint looks for an attributes
file with the same file name and submits the two files together.
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By default hot folder jobs are submitted with job notifications turned off. If you

want to get notifications on hot folder jobs, you must specify a notification-profile
with an explicit delivery-address in the .att file.

Managing impositioning resources

Infoprint Manager command processing for managing impositioning resources is
similar to the standard command processing, with a few exceptions. The following

topic highlights those exceptions. For a complete list of the relevant Infoprint
Manager commands and how they can be used, see Infoprint Manager: Reference.

You can use both the polist and the podelete commands to help you manage your

impositioning environment. You can use the polist command to list either

documents or resources in the Print Optimizer. For example, if you wanted to list

all the documents in the data base by size, you could specify polist —s s and
receive a display similar to the following:

PAGES

DOCUMENT NAME

PS Ad.ps
BackCover.pdf
BackCover.sep
BackCover A4.pdf
Cover.pdf
Cover_A4.pdf
Cover.sep
frontmatter.pdf
frontmatter.sep
frontmatter_A4.pdf
Appendix.pdf
Appendix_A4.pdf
Appendix.sep

Card x 60.pdf
Chapterl_llpg.pdf
Chapter2_12pg.pdf
Chapterl_llpg.sep
Chapter3_15pg.pdf
Chapterl_11pg A4.pdf
Chapter2_12pg.sep

Use the podelete command to delete documents from the Print Optimizer.

12

—_

WWNNN e

16.
153.
159.
159.
225.
237.
238.
316.
380.
388.
388.
468.
482.
676.

1269.
1393.
1743.
1766.
1770.
1875.

SIZE

POOWOUIC PR WH NONUOITOWWOoO = MNO

TRANSFORMED

11/07/01
11/14/01
11/15/01
11/15/01
11/14/01
11/15/01
11/15/01
11/14/01
11/15/01
11/15/01
11/14/01
11/15/01
11/15/01
11/15/01
11/14/01
11/14/01
11/15/01
11/14/01
11/15/01
11/15/01

17:

Note: You can use the global character, an asterisk, * , to simplify this command.

For example, podelete stux deletes all files whose names begin with the

letters STU.

Depending on the shell you are using, you may need to enter control

characters to keep the shell from interpreting the asterisk, *, before Infoprint
has a chance to operate on it. For example if you type podelete * while in a
directory containing files a, b, and ¢, it is equivalent to typing podelete a b

c. However, if the current directory is empty, the shell passes the * to the

command being run. To keep the shell from expanding the command, type

podelete \=*.

The Print Optimizer DSS does not support the following commands:
* pdpause of either the priming actual destination or the priming job.

* pdresume of either the priming actual destination or the priming job.

* pdshutdown of the priming actual destination.

* pdspace
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Troubleshooting impositioning

138

If errors should occur when you are using the Infoprint Impositioning solution,
there are standard diagnostic techniques when resolving any Infoprint printing
problems, and specific guidelines that are unique to impositioning jobs. When
looking in the different error and message logs, remember to track both the Print
Optimizer job and the printing job:

* Infoprint server error logs:

Each Infoprint server (or pdserver process) stores an error.log file in the
Ivar/pd/server_name directory. In addition to logging errors, this log maintains a
history of requests made to this server by Infoprint users, other servers, or
through the Infoprint Manager Administration GUIL

Note: Print Optimizer transform errors are logged in the server error log.

Each entry is composed of the following seven fields:

Message Severity
Specifies whether a message is of an Error (E), Warning (W), Audit (A),
Debug (D), or Informational (I) severity level.

Date Specifies the date in language-specific format; for example: (11/08/01).
Time Specifies the time in language-specific format; for example: (15:43:09).

Thread ID
Specifies the thread ID of the thread issuing the message.

This value can be useful when debugging a problem; you can search on
the unique thread ID of an operation and see all the messages that it
issued.

Target of request
Specifies the target, and sometimes the requestor, of a particular action.

Message number
Specifies the number of the Infoprint Manager message (5010-373). You
can use the pdmsg command to obtain the help-text of any message by
specifying the message number.

For example, if you specify pdmsg 5010-373, Infoprint responds with the
following display:

5010-373 The server received a signal request

from the destination :

5010-373

EXPLANATION: The server is processing the request.

This message goes to the error log only.

SYSTEM ACTION: The request is processing.

RESPONSE: No response is required to this informational message.

Message text
Specifies the text of a particular message (The server mishka completed
processing a ready for job signal request from the destination
mishka:opt-ph. )

The following provides a sample error message from the server error log file.
Please note that this message has been formatted for purposes of displaying the
contents. The actual message is on one line in the error.log file:

D 11/08/01 15:43:09 [2539 mishka,opt-ph] 5010-373 The server mishka

completed processing a ready for job signal request
from the destination mishka:opt-ph.
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* Examine the job messages

These low-level errors (such as data stream errors) are detected by the device
support system (DSS). These messages go to the message log (see the
Ivar/psflactual_destination_namel/jobmessage.log file). By default these messages
are printed at the end of the job (dss-job-message-disposition=print is
specified on your printing actual destinations), so you can examine them there.

* Examine the actual destination error logs

These logs display printer errors, and other non-job errors. You can consult the
error.log file for the actual destinations, which resides in the
Ivar/psflactual_destination_name directory.

Note: If the Print Optimizer cannot be started and therefore the podelete
command cannot be run, you must delete all the files in the Print Optimizer
resource directory and then restart it.

Specific impositioning problems
The following provides some Impositioning problems that can occur, with potential
solutions:

+ |“Job stays in hot folder and never appears in Infoprint server’}

* [“Job hangs in printing actual destination and eventually times out’}

+ |“Job prints as unexpected, cropped size” on page 140

Job stays in hot folder and never appears in Infoprint server

Has the Logical Destination’s hot-folder-directory been set correctly?
Ensure that you have specified the correct name for the hot folder in the
Hot folder location field of the printing logical destination’s Properties
notebook (see [Figure 32 on page 133).

Has the Logical Destination been enabled?

Ensure that the logical destinations you defined in [“Creating the priming|
(print optimizer DSS) destinations and queue” on page 129 and [“Creating]
printing (PSF DSS) destinations to use the print optimizer” on page 131]
have been enabled. If not (a black logical destination printer icon displayed
from the Main window of the Infoprint Manager Administration GUI),
enable the logical destination through the Infoprint Manager
Administration GUL

Has .stg file or directory been renamed?
If you are using a staging file or directory to stage large or multi-document
jobs to the hot folder (for more information, see [“Staging impositioning]
fjobs” on page 135), ensure you have renamed either the file’s or the
directory’s extension to something other than .stg so that the hot folder
will submit it to the logical destination.

Job hangs in printing actual destination and eventually times out

Is the logical destination’s priming-destination set correctly?
Ensure that you have specified the correct priming destination in the
Priming destination field of the printing logical destination’s Properties
notebook (see [Figure 32 on page 133).

Has the Print Optimizer job failed?
Check the server error log cited in|“Troubleshooting impositioning” on|
then take the appropriate recommended actions.

Chapter 13. Infoprint Manager’s impositioning solution 139



Is the Print Optimizer actual destination enabled?
Ensure that the actual destination you defined in[“Creating the priming]
[(print optimizer DSS) destinations and queue” on page 129/ has been
enabled. If not (a black actual destination printer icon displayed from the
Main window of the Infoprint Manager Administration GUI), enable the
logical destination through the Infoprint Manager Administration GUIL

Job prints as unexpected, cropped size

Are the same orignial jobs being used with new job tickets?
If you use an original job that has previously been optimized with a
different job ticket file, the size specified the first time the data was
processed by the Print Optimizer is the size used until those documents
are deleted from the Print Optimizer resource directory.

The Print Optimizer ignores documents it has already processed: the fact
that the job ticket has changed does not cause Infoprint to reRIP the data.
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Chapter 14. Using the LPD gateway with Infoprint Manager for
AIX

You can use the AIX line printer daemon (LPD) to submit jobs through the LPD
Gateway to an Infoprint AIX server. LPD is a subsystem that allows you to submit
print jobs from other operating systems using a Line Printer (LPR) client. The AIX
LPD submits the files it receives directly to an Infoprint destination and supports
the -o options that are available with the AIX LPR clients. (-0 options allow you to
specify advanced Infoprint print options, such as form definitions and page
definitions. For more information about using -o options with AIX print
commands, see Infoprint Manager: Reference.)

Submitting print jobs through the LPD from an AIX system

To submit jobs from the LPD on an AIX system, you can use the AIX lpr
command, which accepts the -o options.

When you submit print jobs using the LPR client, you need to set up a remote
queue on the local system. To accomplish this task, consult your AIX system
documentation. Once you have defined a remote queue, it identifies the Infoprint
Manager remote server and the name of the Infoprint destination (either logical or
actual) on that Infoprint Manager remote server. The LPD submits the job to the
Infoprint print spool. IBM recommends that you specify the LPD subsystem in the
/etc/inittab file to ensure that it starts on a system reboot and is always available.

When you issue the lpr command, you must specify the option that designates
binary or already-formatted data. For example, on AIX you must use the -1 (lower
case L) option on the lpr.

If you are printing from an Infoprint Manager AIX server or an AIX server that has
installed the Infoprint Manager client, you should use the Infoprint pdpr command
to submit jobs directly to the Infoprint print spool.

Submitting print jobs through the LPD from a non-AlIX UNIX system

You can use any LPR client, but if you want to be able to specify advanced
Infoprint options on the -o flag, you must make sure that your LPR client supports
-0 options. Sample code for an Infoprint LPR client called lprafp is provided with
Infoprint Manager for AIX and is available from the /usr/lpp/psf/utils/lpr directory.
This directory contains sample code of the lprafp client for UNIX platforms. This
code must be compiled as described in the README file.

Regardless of what LPD subsystem you decide to use, IBM recommends that you
specify it in the /etc/inittab file to ensure that the client starts on a system reboot
and is always available.

Submitting print jobs from a non-AIX UNIX system with the
Infoprint (Iprafp) LPR client

When you submit print jobs from the Infoprint LPR client on a non-AIX UNIX
system, all you need to specify is the Infoprint Manager server and the name of an
Infoprint destination (either logical or actual). The LPD submits the job to the
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Infoprint print spool. If you enter the LPR shell script with the -A flag, it invokes
the Iprafp command program (lprafp.c), which is documented in the Infoprint
Manager: Reference (S544-5475). If you enter the LPR shell script without the -A
flag, it invokes the AIX system’s LP command, which does not support the
Infoprint -o options.

Submitting print jobs through the LPD from a Windows system

142

Install

You can use any LPR client, but if you want to be able to specify advanced
Infoprint options on the -o flag, you must make sure that your LPR client supports
-0 options. Sample code for an LPR client called lprafp is provided for download
on the Printing Systems web site. To obtain and install this LPR client, see
land configure lprafp for Windows from the Web”}

Note: If you use another LPR client, ensure that you specify the flag for specifying
binary data. For example, on the Microsoft TCP/IP Printing LPD (the
default LPR on Windows operating systems), this flag is the —01 or the —o0 1
(lower case L) option, depending upon your Windows operating system.

and configure Iprafp for Windows from the Web

For Windows operating system clients, the lprafp sample code package is available
for free download from the IBM Printing Systems website at

http:/ /www.ibm.com/printers. Use this procedure to locate and install the
package.

1. Navigate to http://www.ibm.com/printers in your web browser.
2. Under Resources for, click Infoprint Manager.

3. On the Infoprint Manager Family Home Page, click Infoprint Manager for
Windows NT and Windows 2000.

4. On the Infoprint Manager for Windows NT and Windows 2000 Home Page,
select Downloads from the list under Product Resources.

5. On the Downloads page, find lprafp and click to download.
6. Use a zip utility to unzip the package.

7. Open the readme.txt file and follow the instructions for installing the package
on a Windows system.
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Chapter 15. Using the OPI server

The Infoprint Open Prepress Interface (OPI) server allows Infoprint users working
on the Mac operating system to generate low-resolution images (from EPS, TIFFE, or
JPEG source files) for use in any preprocessing activities outside of Infoprint
Manager. By using this support in an Infoprint environment, users can:

* Improve performance on print jobs that contain huge image data

* Save space on their personal computers by submitting the low-resolution images
to Infoprint Manager, which contacts the OPI server at RIP time to print the
high-resolution images.

While configuration of the OPI server must be performed on a Mac personal
computer, you can use the HELIOS PCShare software product to submit OPI server
jobs from Windows personal computers.

Note:

The OPI server can be used with the Print Optimizer support from Infoprint
Manager as part of the Impositioning solution, but the OPI server is not an
essential piece of that solution. For more information about that solution,
refer to |Chapter 13, “Infoprint Manager’s impositioning solution” on|

|}2age 115.
Installing the OPI server on AIX

In order to take advantage of the Open Prepress Interface (OPI) server, you must
install both EtherShare and EtherShare OPI on your Infoprint Manager AIX server.
You can obtain these products from the Helios CD016 CD-ROM (see the Helios
Software_Currently shipping versions web page at
http://www.helios.de/products/current.phtml).

Once you have obtained the latest Helios CD-ROM, as well as both the EtherShare
Version 2.6 User manual and the EtherShare OPI Version 2.1 User manual, you can
prepare to install these software products on your Infoprint AIX server. Both
manuals are available in the /manuals directory of your Helios CD-ROM. Ensure
that you carefully read and review the installation chapters of both manuals before
you attempt to install either product.

The following provides a series of guidelines you should follow while performing
the installation of both products:

Notes:

1. Ensure that you install Ethershare prior to installing EtherShare OPL

2. For most fields, you should take the default settings.

3. All Helios software requires a HELIOS Activation Key or password in order to
function.

Refer to both the EtherShare Version 2.6 User manual and the EtherShare OPI
Version 2.1 User manual for information about where you can obtain this
material. Once you have purchased a Helios Activation Key, you can download
software updates from their web site (http://www.helios.de/download/).
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4. When you upgrade to new releases of Helios products, keep in mind that you
must obtain a new Activation key.

5. If you do not change the default, AFP is the password that Helios sets on your
AIX server.

6. When installing the Helios product, ensure that you have adequate space in the
directories (/usr/local/ by default) where the high-resolution images will be
stored on your Infoprint AIX server.

Note: Ensure that you do not specify the /var/psf/segments directory to contain
these images when prompted for a directory to share.

Configuring the OPI server

Once you have installed the OPI server on your Infoprint AIX server, you must
perform configuration tasks in two locations:

1. [“Configuring OPI server from the Mac system”}

2. [“Configuring OPI server from the Infoprint AIX server” on page 148

The following sections describe how to perform these tasks

Configuring OPI server from the Mac system

Before you can submit jobs to take advantage of the OPI server, you must create a
print queue and define layout settings on your Mac personal computer.

1. From the desktop, highlight the Ether-Share-Admin icon (see below) and select
File->Login from the menu bar.

Note: If the Ether-Share-Admin icon is not available on your desktop, select
the Ether-Share Applications icon (which has been mounted through
AppleTalk from your AIX server as shown in|’Submitting jobs to the]
[OPI server” on page 149) and open the Admin icon.

EtherShare Admin

Figure 33. Ether-Share-Admin icon

2. To connect to the OPI server, you must do the following:

a. From the Select an EtherShare host dialog, select the relevant AppleTalk
zone on your Mac system, highlight it, and specify the host to which you
are connecting (in this case, the Infoprint AIX server where the OPI server
has been installed), and press Ok.

b. From the Connect to EtherShare server ... dialog, type your Infoprint AIX
password and press Ok.

Once you have successfully logged in, the Users, Volumes, Groups, and
Printers file systems will appear cascading on your system.
separates them into distinct emulations for clarity:
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&2 bin
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23 nobody
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Figure 34. Four Infoprint file systems on a MAC system

3. To create a print queue on your Mac system that resides on the Infoprint AIX
server, click on the Printer window to highlight it, and then take the File->New
path on the main menu.

4. From the window (displayed in [Figure 35 on page 146} select a name for the
printer and save the results.
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Printer Name:

Chooser Mame:
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] Hide Printer

[Hevert] [ Save

Figure 35. Print Queue window
5. Once you have created the print queue, use the Lists->OPI/Server Settings
path on the main menu to display the layout and color settings. Usually the
default values are sufficient. From the window displayed in
below, select a name for your print queue and take the defaults before
pressing the Save button.
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Figure 36. OPI Server Settings window

6. Once you have defined the print queue, highlight it (in this case, daltontest)
within the Printer window and then take the Printer->OPI/ICC Settings path
on the main menu.

The International Color Consortium (ICC) format is a cross-platform
specification which allows third party vendors — including Adobe Systems Inc.,
and Agfa-Gevaert — to develop profile tools and applications to support this
standard.

7. From the dialog (displayed in [Figure 37 on page 148), ensure that the OPI
Active checkbox is checked.
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Figure 37. OPI/ICC Settings window

8. Save this setting and exit the dialog by pressing the Save button.

Configuring OPI server from the Infoprint AIX server

Before you can begin to submit jobs to the OPI server on your MAC system, you
must configure the PostScript transform to support the OPI server. Use the
following procedure.

Note: If your installation uses either an Infoprint 60 printer, a Network printer, an
Infoprint 2000 printer, or a Lexmark printer, follow these directions
substituting 3160d.cfg for ps2afpd.cfg. The ps2afpd.cfg file runs the
PostScript RIP for the larger printers, including IBM Infoprint 3000, IBM
Infoprint 4000 (all models), and the IBM Infoprint 4100.

1. From an AIX command line, access both the ps2afpd.cfg and the 3160d.cfg files
that reside in the /ust/lpp/psf/ps2afp directory by default.
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2.

Using your AIX editor of choice, edit the files and remove the comment marks
(#) to the left of the opi_server_resolution_program near the bottom of both
files. When you are finished, the bottom of both files should resemble the
following example, where daltontest is the Helios print queue name. This
sample has been modified so that the final line prints correctly. In the actual
file, the last two lines of the file appear as a single line.

#H#######HF R A FF A A A AR A A AR A AR

# Enabling OPI Server support:

# uncomment the line below, and modify the queue name as appropriate

# use the name of the Helios queue that has the associated color profile

# to use in place of

#<heliosprintqueuename> opi_server_resolution_program = /usr/local/es
/psresolve \-onoincludeheliosdicts daltontest

Note: If you did not install the Helios EtherShare program in the default
directory, you must ensure that the path is listed correctly for this line in
both files.

To run the OPI server, you must either stop and restart the PostScript (ps2afpd)
daemon or shutdown and reboot the Infoprint AIX server.

If you choose to stop and restart the PostScript daemon,

a. From an AIX command line, specify ps —ef | grep ps2afpd to find the
process number of the PostScript daemon running on your server.

b. Specify kill pnumber, where pnumber represents the process number of the
PostScript daemon process.

C. Restart the PostScript daemon by specifying the following command:
/usr/1pp/psf/bin/ps2afpd -C /usr/1pp/psf/ps2afp/ps2afpd.cfg

Submitting jobs to the OPI server

In order to submit jobs to the OPI server, using the following procedure is
recommended.

1.

On your MAC system, create the high resolution images that you will be
incorporating in print jobs.

These high resolution images can come from a scanner, digital camera, or any
other source from which you obtain images.

To connect to the shared directory folder on the Infoprint AIX server, use
Chooser (see |Figure 38 on page 150).
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i Inactive

appleTallk

Figure 38. Chooser selections

a. Highlight the values AppleShare (for the communication protocol between
Mac and AIX), psc_printer (for the relevant AppleTalk zone), and dalton
(for the name of the Infoprint AIX server.

b. Press OK, and then from the next pop-up, press Connect.

c. From the Dalton dialogue(displayed in [Figure 39 on page 151) — where
Dalton is the name of the Infoprint AIX server — press OK.
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% dalton

Select the items you want to use:

cdrom N
EtherShare |
EtherShare Applications |
ICC-Profiles [+

7 Checked items { [+ )will be opened at
system startup time.

3 Save My Name Only

i# Save My Name and Password

|Eance|| | oK I

.84

Figure 39. Sample connection dialog

d. The final dialog will provide a message similar to the following;:
dalton in psc_printer via AppleTalk

where dalton is the name of the Infoprint AIX server and psc_printer is
the zone in which that queue is defined.

Select OK.

3. From your desktop, click on the EtherShare icon to access the shared folder
directory.

4. [Figure 40 on page 152| shows both the shared directory and the associated
layout directory, where the OPI server will put a low resolution image for
each image you place in the main shared folder.
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Figure 40. Sample shared directory and layout directory

5. Place the images that you created in step 1 in a directory under the shared
folder from Ethershare, creating whatever directory structure you want to
organize the files.

The OPI server automatically creates a layout subdirectory that will contain
low resolution images of each high resolution image you put in the main
directory.

6. From the desktop, double-click on the Tagger icon, then complete the
following procedure to tag high resolution images with ICC profiles necessary
for the scanner that was used to create the images:

a. From the main menu, select File->New.
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b. From the RGB Profile dialog, specify other.
. Select the correct ICC profile for your high resolution images.

To determine the correct ICC profiles required by your particular images,
consult the online Helios documentation and help systems.

d. Within the Tagger program, select your images, specify high-res image,
and select Open.

e. Tag each image by selecting the Tag image... button and the Open button
in sequence.

Repeat this step for each image that you plan to use.

7. From your layout application (for example, Quark, Adobe Pagemaker, etc.,),
create a document and place the low resolution image from the layout folder
in the document.

8. From your layout application, select the print option and select the OPI
setting so that you can include images in the document.

Change these settings if you want low resolution images included in the
PostScript output file. Because only the high-resolution images are printed,
these changes will not affect output. Instead, these changes only affect pre-RIP
processing, such as the use of a PostScript file in Preps software if the OPI
server is used as part of the Infoprint impositioning solution.

9. Select the print to file option because it generates a PostScript file as output.

10. Using your method of choice (for example, the EtherShare folder you installed
on your MAC system, Infoprint Submit, or some form of file transfer
protocol), transfer the PostScript file generated in the previous step to your
Infoprint AIX server.

11. On the Infoprint AIX server, you can either print this PostScript file using a
pdpr command, or use the PostScript file as input to the Preps software for
the first step in the Infoprint Impositioning Solution.

For more information, refer to [Chapter 13, “Infoprint Manager’s impositioning]
[solution” on page 115,

Troubleshooting the OPI server

The following describes some common errors that you might experience when
using the OPI server, with possible recommendations for how to resolve the
problems.

A low-resolution image or no image prints
Attempt to resolve this problem by:

* Checking the OPI/ICC Settings on the Helios print queue (see

n page 148). Ensure that the check boxes for OPI Active, Check
Images, Check Fonts, and Check ICC Profile for Pictures have all been
checked. If any are unchecked, check those check boxes, save the
settings, and try running the jobs again.

¢ Check to ensure that the PostScript transform is using the correct
configuration file (either ps2afpd.cfg or 3160d.cfg), depending upon the
type of printer you are using. Also, check this file to ensure that the OPI
server has been enabled (for specific instructions, see|“Configuring OP]]
[server from the Infoprint AIX server” on page 148), and that the OPT
server resolution program has specified the correct path (by default, this
path is /usr/local/es/psresolve, as displayed in .

PostScript RIP fails with an OPI error
Attempt to resolve this problem by:
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* Ensuring that you have downloaded and specified the necessary Helios

updates from the Helios site at http://www.helios.de/download.
Test the Helios resolution program on an OPI file.

Do this task by specifying the following from an AIX command line:
/usr/local/es/psresolve queuename <file.ps > fileout.ps

where gueuename represents the printer queue you created in [Figure 35
bn poge 144
@,

and file.ps is the name of the PostScript output file that
resulted when you specified Print to File from your layout
application.

By examining the results of the fileout.ps file, error codes, and error
messages, you can gather valuable diagnostic information that can be
used to resolve the problem.

Ensure that you have properly tagged the high resolution image as
described in|“Submitting jobs to the OPI server” on page 149}
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Chapter 16. Printing data sets from an MVS system through
MVS Download

This section contains information on setting up and using the MVS Download
daemon supplied with IBM Infoprint Control (Infoprint) to print MVS jobs on
Infoprint-managed printers. The MVS jobs must come from an MVS system that
has the MVS Download feature of IBM Print Services Facility/Multiple Virtual
Storage (PSF/MVS) program product installed.

The Infoprint MVS Download daemon allows MVS users to print data sets from
the MVS JES spool on Infoprint-managed printer devices. The MVS data sets may
contain S/370 line data, MO:DCA data, or S/370 mixed-mode data. You can also
print MVS data sets containing PostScript data or data in any of the other formats
supported by Infoprint.

The PSF/MVS MVS Download feature uses a routing-control data set residing on
the MVS system to map any combination of the CLASS, FORMS, and DEST JCL
parameters to a specific Infoprint server.

See the PSF/MVS MVS Download Guide, for information about the MVS Download
feature and tasks performed on the MVS system.

Preparing to work with MVS Download

Read through the following to become familiar with MVS Download terms and
components.

Why use MVS Download?

When you have data on an MVS system that you want to print on an
Infoprint-managed printer device, you can use the MVS Download feature of
PSE/MVS and the Infoprint MVS Download daemon. The PSF/MVS feature and
the Infoprint daemon:

* Provide a high-speed data transfer utility for high-volume jobs.
* Restart from a checkpoint if something interrupts the data transmission.

* Do not require separate spool management and queueing on MVS because of
seamless integration with System Display and Search Facility (SDSF).

What is the MVS Download daemon?

Infoprint provides a daemon, mvsprsd, which receives data sets from one or more
MVS systems. If you expect a high volume of data, you can configure several
mvsprsd daemons to receive the data sets from MVS.

To configure an mvsprsd daemon, you must perform these tasks:

1. Make the Advanced Function Presentation (AFP) resources on the MVS system
available to Infoprint if they are not already available.

2. Use the default version or a customized version of the shell script
mvsprpsm.sh supplied with Infoprint. See [“Modifying the Infoprint]
[mvsprpsm.sh shell script” on page 157 for more information.

3. Assign a port number to the Infoprint daemon and start the daemon using the
mvsprsd command.
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See ["Using the mvsprsd command to start the daemon” on page 161}

How do you make AFP resources available?

Some jobs may require AFP resources located on the MVS system. You can use the
Network File System (NFS) mount command to make MVS file systems containing
resources accessible to the AIX system on which Infoprint is running. Or you may
have the resources located on the AIX system. You use the shell script mvsprsd.sh,
supplied with Infoprint in the /usr/lpp/pd/bin directory, to specify the location of
the resources.

How are print options passed to Infoprint?

MVS users submitting MVS data sets for printing on Infoprint-managed printer
devices can pass a number of options that further define the requirements of their
jobs. The Infoprint daemon receives the options with the data set and passes the
options to the shell script.

See [“Passing the parameter list from the mvsprsd daemon to the shell script” on|
lpage 159 for information on the options.

What does the mvsprpsm.sh shell script do?

The Infoprint MVS Download shell script translates the print options specified
with a downloaded MVS file into Infoprint attributes and values. The shell script
then builds an Infoprint pdpr command using the -x flag to submit the attributes
and values; it builds the name of the file to print from information received from
the MVS system and the date and time the MVS file was received. The shell script
then creates a log file and submits the pdpr command. A check is made to
determine if Infoprint accepts the command. If Infoprint accepts the command, the
Infoprint MVS Download shell script deletes the log file and the data set received
from the MVS system. Otherwise, the log and file remain in the defined file
system.

What does the log file generated by the mvsprpsm.sh shell
script contain?

The filename of the log file has the following format:

jobname.dataset_name.forms _name.yyddd.log

The log file generated by the Infoprint MVS Download shell script contains the
following information:

* The date Infoprint received the MVS data set and print options

* The print options sent to the shell script by the mvsprsd daemon

* A copy of the pdpr command issued by the shell script to print the file
¢ Any error messages issued in response to the pdpr command

* The return code from the pdpr command

Note: If Infoprint accepts the command, the Infoprint MVS Download shell script
deletes the log file and the data set received from the MVS system. If you
are having problems, you may want to comment out this behavior while
debugging.

If the pdpr command fails, you can use the log file located in the file system you
defined with the -d flag of the mvsprsd utility.

* Ensure the shell script received the correct parameters
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¢ Perform Infoprint troubleshooting procedures, such as using the pdmsg
command to determine the cause of the problem with the pdpr command.

Modifying the Infoprint mvsprpsm.sh shell script

You can use the default version of the mvsprpsm.sh shell script, located in the
fusr/lpp/pd/bin directory, or modify the shell script to meet the needs of your
production printing environment. For example, you might include the path to AFP
resources on the AIX system or change how the shell script generates the file name
for the data set received from the MVS system. Or you might want to specify a
default page definition.

When modifying the mvsprpsm.sh script, note that parameters you comment out
do not get dropped but get sent passthrough to the actual destination. For
example, if you comment out the value for copies defined in the script:

# cop ) outputstr="$outputstr results-profile=::${optparm#=}" ;;

the script passes the original JCL copy-count value to the printer. Instead of
commenting out the line in the shell script, change the name of the parameter to
something that will be read as a value, but not passed onto the Infoprint printer,
such as junk:

cop ) Jjunk="$outputstr results-profile=::${optparm#=}" ;;

Recommendation

Copy the shell script to another directory such as /var/pd and modify the
copy. This eliminates the possibility of service overwriting your modifications.

Specifying AFP resource directories

The mvsprpsm.sh shell script contains the following lines, which are commented
out by default:

# NOTE: Add resource-context-xxx search paths to the pdpr options

# if necessary. For example:

#outputstr="$outputstr resource-context-font=/font/reslib"

#outputstr="$outputstr resource-contect-page-def=/dept123/pagedef:/acme/pagedef"

Use the format shown in the third and fourth lines to specify the paths to the
directories containing AFP resources. Do not include the pound sign, #, when
specifying the directories. You can specify multiple directories by separating them
with colons. You can also specify MVS file systems accessed through the NFS
mount command.

Changing how the shell script generates the file name

The mvsprpsm.sh shell script contains the following lines, which cause the
Infoprint MVS Download shell script to include the MVS job identifier in the name
of the file generated by the shell script:

# Rename the downloaded file to include the MVS job id (comment out
# if this behavior is not desired)

if [ "$paopt" != "" ; then
JID=${paopt##*jobid=}
if [ "$JID" != "$paopt" ] ; then
JID=${JID%%, =}
if [ $sdq.$JID" I= "" &rbrk, ; then

mv $filename $JID.$filename
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Using

filename=$JID.$filename
mv $Togfile $JID.§logfile
logfile=$JID.$1ogfile
fi
i
fi

If you do not want the MVS job identifier included, comment out the lines.

multiple printers with MVS Download

By default, an MVS Download process submits all jobs to the same logical printer.
A parameter that specifies this logical printer starts the mvsprsd daemon. This
printer is fixed for the duration of the process. If you want to send MVS Download
jobs to multiple Infoprint Manager printers, then multiple daemons must be
started for each printer.

If you want a single mvsprsd daemon process to route MVS Download jobs to
different printers, you can uncomment the following lines from the mvsprpsm.sh
shell script:

(e ddssddssaddssaddsadasaddtsdddsaddsssddsaddssddssaddsaddgsaddasddaaddsii
## The following code-segment should be uncommented if dynamic printer

## assignment is desired. Uncomment lines that are singly (#) commented.
## Lines with double comment (##) should remain commented.

##

## The MVS parameter DEST=xxxx is used to assign the Togical printer

## (thereby making the MVS Download daemon's startup queue irrelevant).
##

## The assumption below is that the DEST passed is the actual name

## of an IPM logical destination. Note that both JES2 and JES3 will

## pass the DEST in the NJE header in UPPER CASE but the code below

## will convert it to Tower-case.

## #E###AR AR AR AR AAAAAA AR AAAAAAAA A A A A A

[iggddzaddssdddsaddssadtsaddsddddsdddaaddasaddsadddsdi
## Begin dynamic printer assignment from DEST
s dddasddsdddsaddssaddasddsdddaddgsdddaddaadddad

# MvVSdest=${paopt##+*destination=}

# if [ "$MvSdest" != "$paopt" ] ; then

MVSdest=§{MVSdest%%, *}

MVSdest=§{MVSdest% }

if [ "$MVSdest" 1= "" ] ; then
outputstr="$outputstr mvs-destination=$MvVSdest"
paopt=${paopt##destination=§MVSdest}

e F e H

idgsddssdddsaddssdddsaddssdddsdddsdddtsaddsaddssaddsdadadi
## The following typeset converts to lower-case (-1 flag)
idggddssdddsaddssdddsaddssdddsdddsddddsaddsaddssaddsdadadi

typeset -1 Tpname=$MVSdest
fi

H= H I

fi

st dddsidtgsddssadiasdiddsddaddasdiidddiad
## End dynamic printer assignment from DEST
liiiidzaddgsdddasddssaddsaddsdddtsdddgsddssadasdadsii

Once this code has been uncommented, the MVS operators merely need to specify
the target Infoprint Manager logical destination through the DEST= parameter on
each job that is submitted through MVS Download.
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If you will be sending jobs that do not specify a value for the DEST= parameter in
the JCL, the MVS configuration substitutes a default value, which is typically
LOCAL. If your Infoprint configuration does not have a destination with the same
name, those jobs fail and Infoprint issues the following message:

5010-056 Cannot find object 'local' rc=1

To ensure that these jobs do not fail, define either an Infoprint Manager logical
destination or an actual destination named local (or whatever serves as a
lower-case equivalent for the default value on your MVS configuration) that
addresses the appropriate printer.

Specifying a default page definition

All line-data jobs downloaded from MVS systems require a page definition before
you can print them using Infoprint. If no page definition is specified, an error
occurs. By default, the shell script contains the following line:

pagedef ) outputstr="$outputstr page-definition$optparm" ;;

This causes the shell script to set the value for the page-definition attribute based
on a value passed to the shell script by the mvsprsd daemon. The value passed by
the daemon depends on options downloaded from MVS with the data set. You can
add conditional processing to the shell script to specify a page definition if no page
definition specification is downloaded with the file.

Passing the parameter list from the mvsprsd daemon to the shell

script

The Infoprint mvsprsd daemon passes a parameter list for each data set it receives
to the Infoprint MVS Download shell script. The parameter list contains the
following information:
1. The name of the downloaded data set in the format:

MVS system name.job name.dataset name.forms name.yyddd.hhmmsstABCD.PRD

where:

MVS_system_name
Specifies the name of the MVS system that downloaded the data set.

job_name
Specifies the name of the job containing the data set.

dataset_name
Specifies the name of the data set.

forms_name
Specifies the name of the form identified with the MVS FORMS
parameter.

yyddd  Specifies the year followed by the number of the day of the year.

hhmmsstABCD
Specifies the time the data set was received in hours, minutes, seconds,
tenths of a second, hundreds of a second, thousands of a second, and
hundred thousands of a second.

PRD  Specifies the type of file that contains print data. PRD is the suffix used
by PSF for AIX, Infoprint Manager for AIX, or Infoprint Manager for
Windows NT and Windows 2000 servers to identify the data file
received and other information needed to create the final print job.
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2. The print-options string, which is a series of options and values. See
for the list of options. When you specify the -k flag with the mvsprsd
command, Infoprint also stores the options in a file whose name is in the
following format:

MVS_system_name.job_name.dataset_name.forms name.yyddd.hhmmsstABCD.JCL

where all the qualifiers in the name are the same as those for the name of the
data set, with the exception of JCL. The -k flag specifies that the file contains
print options.

3. The logical printer name, which was specified with the -q flag of the Infoprint
mvsprsd command when the daemon was started.

Translating print options to Infoprint attributes and values
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shows the print options and values passed to the shell script in the
print-options string, the corresponding Infoprint attribute, and the attribute value
used for the pdpr command for that job.

* MVS sends print option values in either uppercase or lowercase characters. MVS

sends all print option values shown in italics in [Table 17} such as pagedef, formdef,
and fontl, in upper case. It sends other values as shown in the table.

* Infoprint sets most attribute values to exactly the same values received from the

print-option values;|Table 17| lists these values in italics within the Infoprint
Attribute and Value column.

Table 17. Print options passed to Infoprint MVS Download shell script

Print Option Passed to Shell Script | Infoprint Attribute and Value

-oac=account "account-text=account"
-oaddress1=address1 "address1-text=address1"
-oaddress2=address2 "address2-text=address2"
-oaddress3=address3 "address3-text=address3"
-oaddress4=address4 "address4-text=address4"
-obu=building "building-text=building"

-occtype=a "carriage-control-type=ansi-ebcdic"
-occtype=m "carriage-control-type=machine"
-occtype=z ""carriage-control-type=ansi-ascii"

Note: The shell script checks if the job uses carriage
control characters. If they are used, then Infoprint
sets this attribute and value based on the input

parameter.
-ochars=font1 font2, font3 font4 "chars=font1,font2 font3,font4"
-ocop=nnn "copy-count=nnn"
-odata=line "document-format=line-data"

Note: If the input value is not line, this value is not
set and Infoprint attempts to identify the correct
format. If Infoprint cannot identify the format,
Infoprint uses a format of ascii.

-odatac=blkchar "data-fidelity-problem-reported=position"
-odatac=blkpos "data-fidelity-problem-reported=character"
-odatac=block "data-fidelity-problem-reported=none"
-odatac=unblock "data-fidelity-problem-reported=all"
-ode=department "department-text=department"
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Table 17. Print options passed to Infoprint MVS Download shell script (continued)

Print Option Passed to Shell Script | Infoprint Attribute and Value

-odu=no "sides=1 plex=simplex"

-odu=normal "sides=2 plex=simplex"

-odu=tumble "sides=2 plex=tumble"

-of=F1formdef "form-definition=F1formdef"

-ofileformat=record "new-line-option=counted-4-octet-aligned"

-ofileformat=stream "new-line-option=I1f"

-oin=nnn "printer-pass-through="-obinnnn"'

-ojobn=job_name "job-name=job_name"

-ona=name "name-text=name"

-ono=nodeid "node-id-text=nodeid"

-ooffxb=nnn".nnn| "x-image-shift-back=nnn.nnn|"

-ooffxf=nnn".nnn| "x-image-shift=nnn".nnn "

-ooffyb=nnn”.nnn | "y-image-shift-back=nnn".nnn|"

-ooffyf=nnn.nnn | "y-image-shift=nnn".nnn "

-opa= "printer-pass-through=
class=output_class '-oclass=output_class'
destination=destination '-odestination=destination’'
forms=form_name "-oforms=form_name'
segmentid=nnn '-osegmentid=nnn""'

-opagedef=Plpagedef "page-definition=PIpagedef"

-opr=programmer_name "programmer-text=programmer_name"

-oprmode=SOSI1 "shift-out-shift-in=one"

-oprmode=SOSI2 "shift-out-shift-in=two"

-ore=P240 "font-resolution=240"

-ore=P300 "font-resolution=300"

-0r0=7001M "room-text=room"

-oti=title "title-text=title"

-otrc=no "table-reference-characters=false"

-otrc=yes "table-reference-characters=true"

-ous=tuserid "user-id-text=userid"

Using the mvsprsd command to start the daemon

To start the mvsprsd daemon whenever the Infoprint system starts, you can
include the mvsprsd command in either the /etc/rc or the /etc/inittab file. Both files
execute when the AIX operating system is initialized. The /etc/inittab file has an
entry for another file called /etc/rc. This shell script (/etc/rc) performs normal
startup initialization for the system; its contents are installation-specific. Because
this file is not usually replaced when a new release of the operating system is
installed (unlike /etc/inittab), you can use it to start the mvsprsd daemon. One can
edit the /etc/rc to call and execute another shell script called /etc/rc.local if it exists.

Use the following procedure to start the mvsprsd daemon through the /etc/rc and
the /etc/rc.local files:

1. Using your AIX editor of choice, edit the /etc/rc file and find the following
lines:
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# Manufacturing post install process
# This must be at the end of this file, /etc/rc.
if [ -x /etc/mfg/rc.preload ]
then
/etc/mfg/rc.preload
fi
2. Insert the following lines just prior to the code example provided in the
preceding step:
[ -s /etc/rc.local ]
then
sh /etc/rc.local
fi

3. Save and close the /etc/rc file.

4. Using your AIX editor of choice, edit the /etc/rc.local file. If this file does not
exist on your AIX system, you must create it as root.

5. Add lines similar to the following to this file:

# This is a comment to document that the following command
# starts the mvsprsd daemon automatically at system startup
/usr/1pp/psf/bin/mvsprsd -p 5400 -d /filesl -d /files2 \
-x /usr/1pp/pd/bin/mvsprpsm.sh -q serv2-1p

Note that this example uses the default shell script (mvsprpsm.sh) and specifies
the serv2-lp Infoprint AIX server.

6. Save and close the /etc/rc.local file.

If the daemon stops for some reason or you want to restart it using different
start-up options, you can use the Infoprint mvsprsd command to start the Infoprint
mvsprsd daemon. With the command, you specify an AIX file system in which to
store downloaded data sets, a shell script name, a logical printer name, and
whether print-option information is stored in a file. You start the daemon on the
AIX processor that has Infoprint installed. Once the mvsprsd daemon is
operational, you can use MVS Download to submit a job to Infoprint where the
Infoprint MVS Download shell script translates the JCL keywords and values to
Infoprint attributes and values and issues a pdpr command.

For the syntax and flags of the mvsprsd command, and for examples of its use,
refer to Infoprint Manager: Reference or the mvsprsd man page.

Using MVS Download support for multi-data set jobs

162

MVS Download sends each JES SYSOUT data set separately to the mvsprsd
daemon on AIX. By default, the mvsprsd daemon spools each data set as a
separate file. On MVS, a job can contain multiple data sets. By using the following
procedure to customize your installation for MVS Download multi—data set job
support, you may be able to cause the data sets in a job sent to Infoprint Manager
through MVS Download to print in sequence, with no intervening files, no NPRO
processing between files, and only one header and trailer page for the set.

Infoprint Manager now enables multiple data sets to be received, individually
transformed by ACIF into MO:DCA-P, and then combined into a single file and
spooled. Infoprint Manager uses the medium maps (copy groups) from the form
definition that is associated with each data set to build a comprehensive inline
form definition that it inserts at the beginning of the combined file.
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The following describes what you must do to install and configure the MVS
Download support for printing multi-data set jobs received from PSF/MVS on
Infoprint Manager for AIX.

Description of multi-data set support on both PSF/MVS and
Infoprint Manager for AIX
To support the printing of multiple data sets in a job as a single unit, you must:
* Install a special MVS Download user exit 15 program (apsux15m )on MVS
* Start the mvsprsd daemon with the -n Toption on AIX

The sample user exit 15 program (apsux15m ) provided with PSF/MVS, adds a
parameter that identifies data sets that belong to multi-data set jobs and indicates
whether the data set is first, next, or last in a job. To use that sample user exit with
PSEF/MVS 2.20, you must install APAR OW41905. To use it with PSF 3.1.0 for
0S/390, you must install APAR OW42117. For higher levels of PSF/MVS, you do
not need to install any maintenance; the sample exit is part of the base product.

The -n 1 option ensures that the mvsprsd daemon receives the data sets in the
correct sequence by creating no more than one child process. If more than one
child process were created, MVS Download might concurrently send more than
one data set from a multi-data set job. If the second data set was shorter than the
first, it might be received before the first, causing it to print out of sequence or
causing the first data set to be left unprinted.

Procedures for installing multi-data set support

Use the following procedure to install the MVS Download multi-data set support:

1. Install the MVS Download user exit 15 program, apsux15m, on MVS. The
program must be assembled and linked into a data set referenced in the
STEPLIB of your MVS Download startup PROC.

2. Run MVS Download on MVS using SEND_REC_LENGTH=YES either by specifying it
explicitly in the MVS Download Routing Control data set on MVS or by
allowing it to default. If you specify SEND_REC_LENGTH=NO, ACIF may be unable
to process some variable length line mode data. In these cases ACIF issues a
message that it cannot read the input file with a return code of 310.

3. Because the mvsprpsm.sh sample shell script has been updated, you must
update any customized versions of this shell script. Specify the name of the
shell script using the "-x" option when you start the mvsprsd daemon:
mvsprsd -n 1 -qlp -p6250 -d/mvsd]l -x/mvsdl/mvsprpsm.sh

4. Ensure that the PATH environment variable when the mvsprsd daemon is
started includes the /usr/lpp/psf/bin directory. You can set default values for
environment variables like PATH using the /etc/environment file:

PATH=/usr/bin:/etc:/usr/sbin:/usr/1pp/pd/bin:/usr/1pp/psf/bin:.

You must delimit each directory using a colon (:), not a semi-colon (;). Do not
include spaces in the assignment. A period designates the current directory.

5. Ensure that ACIF can locate your resources. It looks in both the
lusr/lpp/psf/reslib directory and the directories specified by the PSFPATH
environment variable. If you specify resource directories using the following
attributes, you must specify those same directories in the PSFPATH
environment variable:

* resource-context

* resource-context-font
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* resource-context-overlay

* resource-context-page-segment

* resource-context-page-definition

* resource-context-form-definition

You can set default values for environment variables like PSFPATH using the
/etc/environment file:

PSFPATH=/usr/xyz_corp/reslib:/usr/xyz_corp/fontlib

You must delimit each directory using a colon (:), not a semi-colon (;). Do not
include spaces in the assignment.

6. Do not specify the following attributes either directly or in Initial Value Job or
Initial Value Document objects:
* transform-message-file-name

* resource-context-page-definition

You may use the resource-context attribute instead of the resource-context-
page-definition attribute.

7. Specify the -n 1 option when you start the mvsprsd daemon:
mvsprsd -n 1 -qlp -p6250 -d/mvsdl -x/mvsdl/mvsprpsm.sh

This option directs the daemon to create exactly one child process to receive
data sets from MVS. Most customers use a shell script to run the mvsprsd
daemon and specify its arguments. Using a shell script ensures that the daemon
is always started correctly, with the same arguments. You should add the -n 1
option to the shell script.

Limitations of multi-data set support
This support has the following four limitations:
1. This solution applies only to line mode, mixed mode, or MO:DCA-P data sets
that do not have inline resources.

2. You must specify the -n 1 option when you start the mvsprsd daemon on AIX.
This support restricts the mvsprsd daemon to receiving one data set at a time.
If you did not previously specify the -n 1 argument and received multiple files
concurrently, you may wish to start more than one instance of the mvsprsd
daemon (using different port numbers) and configure new MVS Download
printers on MVS to communicate with them.

3. You must have enough disk space on the AIX system to receive and transform
all of the data sets in a multi-data set job. If you do not use this solution, data
sets may be received and transformed individually, so less space may be
required.

4. This solution does not create three types of form definition (FORMDEF)
statements in the generation of a comprehensive inline form definition:

* MSU (Map Suppression)
¢ PFC (Presentation Fidelity Control)
* MFC (Medium Finishing Control)

Technical description of multi-data set support
The following describes the sequence of the multi-data set support:

1. The mvsprsd daemon receives each data set into a file, then invokes a shell
script (specified using the -x option when the mvsprsd daemon is started) to
spool the file.
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2. The sample mvsprsm.sh shell script does not immediately spool a file which
was identified by the user exit 15 program on MVS as being part of a
multi-data set job. Instead, the mvsprsm.sh shell script invokes a second shell
script, mvsprsmd.sh, which invokes ACIF to transform the file into MO:DCA-P.

3. After the last file in a multi-data set job is transformed into MO:DCA-P, the
mvsprsmd.sh shell script invokes the afpconcat program to create one file with
a comprehensive inline form definition and all the MO:DCA-P documents
concatenated afterward. The comprehensive inline form definition contains
medium maps (copy groups) from all of the form definitions associated with
the individual data sets.

4. If medium map names collide, the afpconcat program assigns unique names
and updates references in the MO:DCA-P documents.

5. The mvsprsmd.sh shell script then invokes the mvsprsm.sh shell script to spool
the combined MO:DCA-P file.

Resubmitting or deleting MVS Download orphaned files

Orphaned files are old files left in the AIX file system because errors prevented
Infoprint from processing them; their file names follow the MVS Download file
name format, such as:

MVS_system name.job_name.dataset_name.forms_name.yyddd.hhmmsstABCD.PRD.

You should either correct the problem that prevented the job from processing and
then resubmit the job or delete the files.

Resubmitting an orphaned file

If you started the mvsprsd daemon with the -k flag, Infoprint saves print options
downloaded with MVS data sets. By default, Infoprint also stores the downloaded
data set. Infoprint saves both the data set and the print-options file in the directory
you specify with the -d flag when you start the daemon. See[“Passing the]
[parameter list from the mvsprsd daemon to the shell script” on page 159 for the
format of the file names for the data set and print-options file. If errors occur that
prevent Infoprint from processing the job, you can correct the errors and then
resubmit the job.

For example, to resubmit the file
bldmvsl.records.records.forml.9701.1147351234.PRD using the print-options file
bldmvsl.records.records.forml.9701.1147351234.JCL and requesting logical
printer srvl-1p, enter the command:

/usr/1pp/pd/bin/mvsprsm.sh bldmvsl.records.recorda.forml.9701.1147351234.PRD
"$(bldmvs1.records.recorda.forml.9701.1147351234.JCL) srvl-Tp

Note: This example shows the command spanning across lines for readability.

When actually entering the command, allow it to wrap on the AIX
command line.
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Chapter 17. Using AFP Upload

AFP Upload consists of an AIX client program (as part of Infoprint Manager) and
an MVS or host server program (available as a priced feature of PSE/MVS). The
AIX client program accepts AFP files (or files it can convert to AFP) and sends
them to the MVS server, which places them on the JES spool. The host server
program ensures that the attributes passed by the AIX client (such as class,
destination, and forms) are also communicated to the MVS system and recorded
with the data sets on the JES spool. For more information on how to pass these
values to an MVS system, see [“Transmitting AFP file attributes to MVS” on|

To communicate between the MVS system and the AIX system, AFP Upload uses
either TCP/IP or SNA LU 6.2 protocols. Depending upon the protocol used at your
site, you should use one of the following publications to customize and use the
AFP Upload feature of Infoprint Manager:

« |AFP Upload Confiquration Guide Using TCP/IP|
« |AFP Upload Confiquration Guide Using SNA|

Both manuals are available from the Infoprint Manager for AIX Version 4.1
Publications CD-ROM and the web site at|[Infoprint Manager for AIX Product]
[Library page (http://www.ibm.com/printers/R5PSC.NSF/Web/ipmrefinfo41)|

In addition to the network configuration tasks described in these publications, you
need to perform the following procedure before you can upload files to an MVS
server from Infoprint Manager.

Creating an actual destination for AFP Upload and print

To create an AFP Upload actual destination on your Infoprint AIX server for using
the AFP Upload feature, you must invoke the System Management Interface Tool
(SMIT) as root user. Note that when you create an actual destination, the logical
destination that will drive the printer is both created (if it does not already exist)
and enabled automatically as servername-1p, where servername is the symbolic name
of your Infoprint AIX server. A queue name — servername-q is also created if it does
not already exist.

If you create more than one actual destination, Infoprint Manager will use the
same default logical destination to drive both actual destinations. If both actual
destinations are enabled and available for a job, the first one created handles the
job.

To create an actual destination for the AFP Upload feature, use the following
procedure:

1. From an AIX window on your Infoprint AIX server, type either smit or smitty
and take the following path:

Infoprint Printing System—>Miscellaneous—>Add a Printer

2. From the Add a Printer panel, select either Upload-SNA or Upload-TCP/IP,
depending upon the communication protocol in use at your installation.
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3. From the Add an Upload-protocol Printer panel, where protocol is either TCP/IP
or SNA, specify the required fields as you would when creating any actual
destination object.

SNA-specific fields

For an SNA AFP Upload printer (SMIT fastpath of psfup_add_prt_uploadSNA),
they should be similar to the following values.

% Frinter : ro

* Data stream type AFPLS

* Printer MNAME( Fath) nome—ad

Command

Figure 41. SMIT SNA Printer panel

Printer NAME (Path)
Specify a printer name from 1-to-8 characters in length. This field must
match the Current profile name field on the LU 6.2 Side Information
Profile. For more information on the LU 6.2 Side Information and other
related profiles, see |AFP Upload Confiquration Guide Using SNA|

ASCII code set
Defines the code set used on the AIX system.

EBCDIC code set
Defines the code set used on the MVS system.

Maximum concurrent jobs (Num.)
Specifies an upper limit for the number of jobs that this actual destination
can process at a time.

TCP/IP specific fields

For a TCP/IP AFP Upload printer (SMIT fastpath of psfup_add_prt_uploadTCP),
they should be similar to the following values.
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4 stream type

* Printer NAME( Path)

* Internet ADDRE

* PORT number{Mum.)

Command

Figure 42. SMIT TCP/IP Printer panel

Printer NAME (Path)
Specify a printer name from 1-to-8 characters in length.

Internet Address
Specify as either dotted decimal notation or hostname.

PORT number
Specifies the location where the MVS server program on the target system
receives access requests. Specify a number from 1-to-65535. 6001 is the
default. IBM recommends you specify a number larger than 5000.

ASCII code set
Defines the code set used on the AIX system.

EBCDIC code set
Defines the code set used on the MVS system.

Maximum concurrent jobs (Num.)
Specifies an upper limit for the number of jobs that this actual destination
can process at a time.

To find more information about AFP Upload printers, see [“Using Infoprint
[Manager commands with AFP Upload” on page 172|
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Transmitting AFP file attributes to MVS

Infoprint Manager allows you to specify values to MVS through two methods:

1. [“Using specific Infoprint Manager attributes”]

2. [“Using the destination-pass-through attribute” on page 171|

Note that the CLASS, FORMS, and DESTINATION values allow you to specify
values through either method. If you want to send these three values through AFP
Upload and Print, as well as the BURST value, you must use the
destination-pass-through attribute. If you specify the CLASS, FORMS, and
DESTINATION attributes as specific attributes (mvs-class, mvs-destination, or
mvs-forms) and then specify a BURST value on the same command or actual
destination, Infoprint Manager ignores the specific document attributes and only
passes the BURST value onto the MVS host program. To pass BURST with the
other three values, vou must use the method described in
[destination-pass-through attribute” on page 171}

Note: To pass the BURST value, you must ensure that you have the correct level of
support on both your Infoprint AIX server and your MVS host system. On
AIX, the BURST enhancement is available on Infoprint Manager Version 4
Release 1. On MVS, this support is available in PTF UW70082, APAR
OW44510.

Using specific Infoprint Manager attributes

You can specify a series of document attributes that map to MVS values by
associating them with a job, specifying them on a pdpr print command, or setting
them on an actual destination.

provides specific attributes that can be used to pass values to an MVS host
system through AFP Upload and Print.

Table 18. Specific Infoprint Manager attributes to pass values to an MVS host system

MVS Values Infoprint Manager Attribute(s)
ADDRESS .

address1-text=
e address2-text=
e address3-text=

e addressd—text=

BUILDING building—text=
CLASS * mvs-class=

* (destination-pass-through=)
COPIES copy—count=
DATACK data—fidelity-problem-report=
DESTINATION

* mvs-destination=

* (destination-pass-through=)

DEPARTMENT department-text=
FORMDEF form-definition=
FORMS

* mvs-forms=
* (destination-pass-through=)

NAME name-text=
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Table 18. Specific Infoprint Manager attributes to pass values to an MVS host
system (continued)

ROOM room-text=
TITLE title-text=

For example, to pass a BUILDING value of 004 and a ROOM value of A5, you
could use the pdpr print command to pass attributes for a single job with a
test1.tif file:

pdpr -p nome-1p -x"building-text=004 room-text=A5" testl.tif

For specific syntax rules, refer to the latest draft of the IBM Infoprint Manager
Reference, which is available on the [Infoprint Manager for AIX Product Library|
fpage (http://www.ibm.com/printers/R5PSC.NSF/Web/ipmrefinfo41)|

Using the destination-pass-through attribute

For a subset of MVS values that do not match specific Infoprint Manager
attributes, Infoprint Manager allows you to specify values to MVS as
destination-pass-through (also called printer-pass-through) attribute values. These
values can be associated with a job, specified on a pdpr print command, or set on
an actual destination. The MVS host server program associates attributes passed by
the AIX client with the SYSOUT data set. These attributes are similar to JCL
OUTPUT statement parameters.

They include

* BURST

+ CLASS

+ DESTINATION
* FORMS

The following procedures describe how you can pass these values to an MVS host
server program using AFP Upload and Print, using the following syntax:

-x "destination-pass-through="'PASSTHRU=MVS_PARM=value""

where MVS_PARM can be BURST, CLASS, DESTINATION, and FORMS, either
individually or in any combination. When more than one attribute is being passed,
each value must be separated by a comma, as shown in the examples below.

The MVS value WRITER must be specified through the destination-pass-through
attribute, but it does not conflict with specifying either mvs-class, mvs-destination,
or mvs-forms. As you can see in the table below and the examples that follow, the
syntax for passing the MVS WRITER value differs from that used for the other
options.

The following table shows how you can use the destination-pass-through attribute
to pass values to an MVS host system through AFP Upload and Print.

Table 19. Using the destination-pass-through attributes to pass values to an MVS host

system

MYVS Values Infoprint Manager Pass Through Syntax

BURST destination-pass-through="PASSTHRU=BURST=xxx’
CLASS destination-pass-through="PASSTHRU=CLASS=xxx"
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Table 19. Using the destination-pass-through attributes to pass values to an MVS host
system (continued)

DESTINATION destination-pass-through="PASSTHRU=DESTINATION=xxx"
FORMS destination-pass-through="PASSTHRU=FORMS=xxx"
WRITER destination-pass-through="WRITER=xxx"

Examples: Using the destination-pass-through attribute

The first two-step example creates an initial value document and associates it with
the default logical destination so that all jobs sent to this destination will pass the
specified attributes.

1. Using the destination objects created in the example for [‘Creating an actuall
[destination for AFP Upload and print” on page 167} specify the following
pdcreate command to create an initial value document named uploadl-dd on
the Infoprint AIX server nome:

pdcreate -c initial-value-document \
-x"destination-pass-through="'WRITER=WTR1 PASSTHRU=BURST=YES,CLASS=A""\
nome:uploadl-dd

2. Specify the following pdset command to associate the initial value document
named uploadl-dd with the nome-lp logical destination:

pdset -c destination\
-x"destination-initial-value-document=uploadl-dd"\
nome:nome-1p

The second example uses the pdpr command to pass attributes for a class of A, a
form of B, a job destination of B205, and a BURST value of YES on a single job with
a test2.tif input file:

pdpr -p nome-1p\

-x"destination-pass-through="PASSTHRU=CLASS=A, FORMS=B,DESTINATION=B205,BURST=YES"'"\
test2.tif

The third example uses the pdset command to specify a class of A, a form of B, a
BURST value of YES, and a WRITER value of WTR1 on all jobs sent to the actual
destination nome-ad.

pdset \

-x"destination-pass-through="WRITER=WTR1 PASSTHRU=CLASS=A,FORMS=B,BURST=YES'"\

nome: nome-ad

Using Infoprint Manager commands with AFP Upload

172

Because the AIX client program for AFP Upload operates as an Infoprint Manager

actual destination, you can control and monitor it through the commands used

with other Infoprint actual destinations:

* To shut down an AFP Upload actual destination, use the pdshutdown command
that is documented in |[nfoprint Manager: Referencel

 To find status about AFP Upload actual destinations, use the psfstat command.

Note that there are limitations to the tasks that you can perform with an AFP
actual destination. You can neither forward space, back space, nor pause a job to
an AFP Upload actual destination.
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When the connection to the MVS host fails

If you experience connection problems with the MVS host after having submitted a
job through AFP Upload and Print, how to ensure that the job prints depends
upon whether or not Infoprint Manager detected the loss of connectivity.

If Infoprint Manager detected the lost connection, the AFP Upload logical
destination becomes red and the job goes into the PENDING state. Once you have
re-established connectivity to the MVS host program, re-enable the AFP Upload
destination. Then Infoprint Manager will restart the job and continue printing.

If Infoprint Manager does not detect the lost connection, the job remains in the
PENDING state, while the printer goes into a needs-key-operator state. To resolve
this condition and print your job, you must regain connectivity to the MVS host
program, cancel the job in the PENDING state, and then resubmit the job to the AFP
Upload actual destination.
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Chapter 18. Installing the Tivoli Plus Module

You can enhance your job management support by adding Infoprint Manager
support to your Tivoli desktop with no additional configuration. You install it like
any other Tivoli Plus Module and it places an icon on the Tivoli Desktop.

The initial software requirement for a Tivoli system on AIX:

TME 10 Framework Version 3.2 (also tested on Version 3.6)

These applications must be installed and configured before their corresponding
Tivoli Plus feature is operational:

TME 10 Software Distribution Version 3.1.1 (also tested on Version 3.6)
TME 10 Distributed Monitoring Version 3.5 (also tested on Version 3.6)
TME 10 Enterprise Console Version 2.6

Once you install the Tivoli Plus Module, all the features described in the
Manager Plus for Tivolil fact sheet are available, and can be enhanced or expanded
as needed. For example, you can add more support to our Tivoli Plus Module by
suing the Tivoli Framework to monitor more conditions at the Infoprint Manager
AIX server. The basic Tivoli feature provides the following

¢ A program group (accessible from the Tivoli Desktop) to perform remote
Infoprint Manager commands, including the ability to pause, resume, hold, and
cancel jobs, or show queue status.

* Monitors for checking Infoprint Manager’s used disk space and showing the
Infoprint Manager processes that are running.

* Notification of certain Infoprint Manager events and errors, including when a
server has been manually shut down and restarted, or when a printer need
attention.

For information about installing and configuring Tivoli Plus Module support,
contact IBM technical experts by calling 1-800-237-5511 in the U.S. and
1-800-426-7378 in Canada. Outside the U.S. and Canada, contact your local IBM
Printing Systems Representative. Ask your Printing Systems representative about
requesting Professional Services from Printing Systems in Boulder.

Note: Remember to save your customer ID and the access key in a safe place. If

you reinstall Infoprint Manager, you will need both your customer ID and
the access key number again.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM® may not offer the products, services, or features discussed in this document
in other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property rights may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) described in this publication at any time without
notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3—chome, Minato-ku
Tokyo 106, Japan
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Printing Systems Division
Department H7FE Building 003G
Information Development

PO Box 1900

Boulder CO 80301-9191 USA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under
terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

For online versions of this book, we authorize you to:

* Copy, modify, and print the documentation contained on the media, for use
within your enterprise, provided you reproduce the copyright notice, all
warning statements, and other required statements on each copy or partial copy.

* Transfer the original unaltered copy of the documentation when you transfer the
related IBM product (which may be either machines you own, or programs, if
the program’s license terms permit a transfer). You must, at the same time,
destroy all other copies of the documentation.

You are responsible for payment of any taxes, including personal property taxes,
resulting from this authorization.

Your failure to comply with the terms above terminates this authorization. Upon
termination, you must destroy your machine readable documentation.
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Trademarks

The following are trademarks or registered trademarks of International Business
Machines Corporation:

Advanced Function Printing

AFP

AIX

AS/400

IBM

IBM Cross Platform Technologies for Windows

Infoprint

Intelligent Printer Data Stream

IPDS

Micro Channel

MVS

0s/2

0S/390

0S/400

Print Services Facility

S/390

System/370

The following are trademarks of other companies:

* Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or
both.

* Microsoft, MS-DOS, Windows, Windows NT, Windows 2000, Windows ME,
Microsoft Visual Basic, Microsoft Visual C++, and the Windows logo are
trademarks of Microsoft Corporation in the United States, other countries, or
both.

* Pentium is a registered trademark of Intel Corporation in the United States,
other countries, or both.

* UNIX is a registered trademark of The Open Group in the United States and
other countries.

Other company, product, and service names may be trademarks or service marks
of others.

EuroReady

Infoprint Manager is capable of processing data containing the euro sign. Font
character sets and code pages that contain and map the euro sign consistently with
the application must be present either in a host library or in the printer. AFP fonts
that support the euro sign are included in the AFP Font Collection (Program
Number 5648-B33).

Notices 179
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